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 1 

Remark Classic OMR Overview 

 

Chapter 1 

Remark Classic OMR is a data collection software package that allows you to utilize 

paper forms and OMR scanners to collect data. The Remark Classic OMR software gives 

users of OMR scanners an easy solution for collecting and tabulating data. 

The Remark Classic OMR software utilizes a form template for each form type. The form 

template contains information about the form. Filled-in forms are scanned using an OMR 

scanner with the corresponding form template. The software is equipped with form 

templates for many common standard forms. Remark Classic OMR also contains a 

Template Editor to allow you to create form templates for forms that are not already 

included in the software.  

1.1 Overview 

The Remark Classic OMR software provides an easy to use interface for people who use 

traditional OMR scanning systems. The Remark Classic OMR User’s Guide contains all of 

the necessary information for using the Remark Classic OMR software on Microsoft 

Windows based systems. 

Using the software can be broken down into the following procedures: 

 Choose an OMR form to use. Forms can be purchased from vendors 

specializing in the creation of OMR forms. There are also software packages 

available to help you create your own OMR forms. 

 Create a form template file. The form template tells Remark Classic OMR how 

to read your form. Form templates are created and/or edited in the Remark 

Classic OMR Template Editor. Each form you wish to process requires a form 

template, but the form template is a one-time setup that tells the software how 

to read your particular form. 

Note: Remark Classic OMR contains pre-defined form templates for many 
form types. The Template Editor is used when form templates need to be 
created for those form types that do not have pre-defined form templates 
(custom forms) or to make changes to existing form templates. 

 Scan filled-in forms. Remark Classic OMR displays the data in a spreadsheet 

style grid based on the form template you created. Each row of this grid 

corresponds to one scanned form in its entirety and each column corresponds to 

one question or variable on the form. 

 Save data and/or use the built-in analysis tool, Remark Quick Stats®. 

Save the data to over 30 output formats, including Access, Excel, SPSS, Oracle, 

SQL Server, ODBC, etc. Or, use the analysis program included with the software, 

Remark Quick Stats, to tabulate your survey or grade your test. If you use 

Remark Quick Stats, you can take advantage of powerful grade results, 

crosstabulations, graphs, charts and more. 
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1.2 Optical Mark Reading Basic Concepts 

Traditional Optical Mark Reading (OMR) involves two major components: OMR scanners 

and OMR forms. OMR scanners are peripheral machines attached to your computer that 

are made to specifically read and interpret the marks on OMR forms. OMR forms are 

bubble sheets that are created to precise specifications so that they can be read by an 

OMR scanner. These forms are used for testing, surveying or anything else that requires 

the collection of information.  

OMR forms are set up in terms of rows and columns. There are two characteristics of an 

OMR form that allow the OMR scanner to recognize data: 

 Timing Marks- small, black marks that signify the vertical position of each row 

of data on the sheet. 

 Columns- the number of columns (channels) that are contained on the form. 

Each bubble on the form lines up with a particular column. OMR scanners can 

typically read either 12 or 48 columns, though there are other variations. See 

your OMR scanner’s documentation for the specifications for your model. 

OMR forms can optionally have other characteristics. Here are some other terms with 

which you should be familiar: 

 Sheets- the number of physical pieces of paper a form contains. For example, a 

double sided form on one piece of paper would contain one sheet with two sides. 

 Page ID Marks- pre-printed sequence of marks on an OMR form that when 

taken together produce a unique ID for the sheet.  

 Respondent Tracker (Lithocode)- a respondent ID that identifies a particular 

respondent’s form as it is being read by the OMR scanner. Respondent trackers 

can be represented by OMR bubbles or barcodes. 

The following example shows you how timing marks and columns work, followed by a 

sample OMR form. 
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This grid sample represents a fairly common 48-column form layout and allows you to 

count timing marks and columns on a form. Each region on a form lines up with a 

particular timing mark and a particular column (e.g., a region might start in row 10, 

represented by timing mark number 10, and column 12, represented by column 12). An 

OMR scanner uses the timing marks and columns on the form to locate regions 

containing OMR bubbles. 

The form on the following page is an example of an OMR form. You can see that the 

timing marks run down the left side of the form. There are 64 timing marks. This form 

also has 48 columns. Each row or column of bubbles lines up with a particular timing 

mark and a particular column number. 

The OMR scanner finds the OMR bubbles on the sheet using these timing marks and 

columns. When creating form templates in Remark Classic OMR, you also identify OMR 

bubbles to be processed using the timing marks and columns.  

 

 

 

Column 1 Column 48 
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1.3 What is Included with your Software 

Each purchase of Remark Classic OMR includes the following: 

 One copy of the software on CD-ROM 

 Four user’s guides, all in PDF format (all files install with the software):  

o Remark Classic OMR 4 user’s guide 

o Remark Quick Stats user’s guide  

o Remark Classic OMR Automation Wizard user’s guide 

o Remark Classic OMR Supported File Formats user’s guide 

1.4 New Features in this Version 

Remark Classic OMR 4 has many new features. The following list provides an overview of 

what is new in this version. Please see the specific sections of this user's guide 

corresponding to the listed feature for complete details. 

All of the new features in this version are too numerous to mention. We have highlighted 

some of the bigger features here. Take some time to review this manual and the 

software to see all of the new enhancements. 

 Support for Image Enabled Scanners. Support for Scantron iNSIGHT 

scanners’ imaging capabilities is available using ScanTools®. An image viewer at 

the bottom of the Data Center shows an image of each scanned form. As forms 

are scanned, images are saved of each form. 

 Email. An email option is available in the Remark Classic OMR Data Center and 

Remark Quick Stats to email data and reports as attachments. You can use 

Remark’s built-in email client in conjunction with your SMTP server or Microsoft 

Outlook®. 

 Send Wizard. A Send wizard was added to move files via FTP or email with 

minimal interaction. You send data and reports from a folder on your computer or 

network to an FTP site or via email using your own SMTP server. You can set up 

profiles to be reused as needed. 

 Windows 7 Support. Windows 7 is fully supported in both 32 and 64-bit 

versions. (Note: If your scanner requires a driver, check with the scanner 

manufacturer for Windows 7 compliant drivers.) 

 Microsoft Office 2010 Support. The Access® and Excel® 2010 file formats are 

now supported anywhere database formats are supported (e.g., database lookup, 

saving data, exporting report data). 

 SQL Server and Oracle Support. You may now save data to the SQL Server 

and Oracle formats without going through an ODBC connection. 

 Save Data Builder. You can now customize the data saving process by including 

a region from your data set in the file name. For example, if you are processing 

exams and wanted the data file to be saved by instructor, you could use the 

instructor region from the database as the base name. 

 Save All Data. You can save multiple data files to a master data file with the 

click of a button. This feature allows you to easily combine related data (data that 

originates from the same template). 

 Database Lookup for Multiple Pieces of Data. You can now use the Database 

Lookup feature to pull more than one piece of data from your external database. 

This feature is great for looking up identifiers and pulling demographic 
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information from external files into your Remark data (e.g., looking up a student 

identification number and pulling in names and other demographics). 

 All Response Option for Multiple Choice Questions. Multiple choice questions 

can output all responses chosen (instead of MULT) even when only one is 

allowed. For test grading, this makes it easy to allow different correct answers 

without rescanning forms. 

 Respondent Detection. You can detect who has and has not completed your 

form by using Respondent Detection in conjunction with Database Lookup. Using 

the information from the external database, you can verify which respondents 

exist in the scanned data file. 

 Review Exceptions. A Review Exceptions utility is included with the software 

that cycles through the open data set and searches for any data exceptions 

(blank responses, multiple responses, etc.). This feature is particularly useful 

when using an image enabled scanner. An image viewer appears at the bottom of 

the screen to assist with data clean up. 

 Review Duplicates. You can review data files for duplicate entries based on a 

piece of data. For example, you can check for duplicate student identification 

numbers and then choose whether to discard duplicates. 

 Logging of Changes. Changes to data sets can be logged in a password 

protected Access database. 

 SPSS File Format Enhancements: 

o The eight character region name limit has been removed. Region names 

up to 64 characters are now supported when saving to the SPSS format. 

o You no longer have to set up questions that allow more than one response 

as Boolean regions. The software breaks apart the multiple responses into 

separate questions when saving to the SPSS format. 

o Numeric regions that contain missing data now use the designated 

missing value (e.g., -1, 99, etc.) instead of 0 when exporting to SPSS.  

o The Advanced window is now available when saving data to the SPSS 

format so that you can chose what regions to include and set region sizes 

for your data set. 

 Automation Wizard. An Automation Wizard is included with the software that 

allows you to set up executable files that perform basic software functions. For 

example, you can choose a template to open, initiate the scanning process, save 

the data and run specific reports by setting up an Automation Wizard file that 

executes these commands. 

 Freezing Columns/Rows. You can now freeze columns and rows in the Data 

Center so that when scrolling, they are always visible. 

 Auto Check for Updates. A method for checking for software updates was 

added to the Help menu and program preferences. 

Remark Quick Stats Improvements:  

New Reports:  

 Question Mean Report. This new survey tabulation report shows each question 

on the form, along with the minimum and maximum responses, mean and a bar 

chart of the mean. 

 Student Response Report. This new test grading report shows a matrix of all 

the students and test questions, the answer chosen, and a color code to indicate 

whether it was the correct response. It provides fast insight into both student and 

question performance. 
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 Demographic Grade Report. This new version of the Comparative Grade report 

allows you to compare up to three regions in your data in a table format (as 

compared to the Demographic Comparison Report that is in hierarchical format). 

 Basic Item Analysis/Condensed Test Report. This new report for both tests 

and surveys provides a condensed view of all questions on the form, response 

frequencies and means. For test grading, it optionally shows test score 

information, such as min, max, and mean scores, standard deviation, prevalent 

non-distractors and class performance by upper and lower percentages. 

Enhanced Reports: 

 Detailed Item Analysis Report. Cumulative and Valid Percent statistics can be 

turned off in the Detailed Item Analysis report for surveys. 

 Student Statistics Report. T-Score, Z-Score, ETS Score, and Dev. IQ have 

been added to the Student Statistics Report (shown optionally). 

 Condensed Item Analysis Report. Colors have been added to the bar charts 

on Condensed Item Analysis report to highlight the correct answer and the 

distracters chosen when performing test grading. 

 Test Item Statistics Report. Several enhancements have been made to the 

Test Item Statistics report to make it more readable, including: renaming 

Benchmark P-Value to Benchmark, changing the P-value to a straight percentage, 

renaming Benchmark % as Percent Correct and changing the value to a straight 

percentage, and adding options for each of the columns to be shown/hidden.  

 Response Reports. Response reports can now be sorted by Respondent ID or 

Response. 

General Features: 

 Report Batch Wizard. The Report Batch Wizard allows you to select, print and 

export multiple reports at one time. In addition, you can apply filters that 

automatically execute as the reports are run (e.g., filter the grades based on 

teacher). Report Batch Wizard configuration files can be set up and reused. 

 NA (Non Applicable) Answer Choices. You may now exclude NA answer 

choices from your analysis reports, providing you with more accurate means and 

statistics. For example, if your answer choices are Strongly Agree, Agree, 

Neutral, Disagree, Strongly Disagree, NA: if someone chooses NA, you can have 

it not count in the statistics, but still be able to see how many respondents chose 

the NA response. 

 Scaled Scores. The Grade Wizard supports “scaling” a score, whereby you look 

up grades in a table and then apply the scaled score from the external file. You 

can define a default scaled score lookup for the overall test and for learning 

objectives. Scaled scores can look up by either total score, percent score or 

percentile. The following grade reports support the scaled score: Student 

Statistics Report, Student Grade Report, Comparative Grade Report, 

Demographic Grade Report and Student Response Report. 

 Support for Multiple Versions of an Answer. You can now enter various 

versions of an answer and have them all treated as the correct response. For 

example, if .25 and ¼ are both correct, using the Grade Wizard you can instruct 

the software to allow either answer to be considered correct. 

 Turning Off Subjective Questions Using Easy Grade. When using Easy 

Grade, if a subjective question is left blank or contains non-numeric data, it is 

excluded from the grade operation (marked as not graded/not subjective). 

Otherwise, if the subjective question contains a numeric value, that value is used 

as the total possible subjective points for the question. 
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 Blackboard Export. The ability to export grades to Blackboard has been added. 

A Blackboard Building Block is available to streamline importing grades into 

Blackboard. 

 Screen Captures. You may now access a screen capture utility in Remark Quick 

Stats to capture portions of reports (e.g., graphs to place in other applications). 

 Data Groups. When analyzing multiple data sets together, you can enter a 

descriptive name for each data set. That name can then be used to filter data in 

Remark Quick Stats, as well as on certain reports, such as the Demographic 

Comparison, Comparative Grade and Comparative Item reports. This feature is 

useful for comparing data sets. 

 Importing and Exporting of Grade Scales: You can now import and export 

grade scales for the purposes of sharing them via the Remark Quick Stats 

Preferences. 

1.5 Technical Support  

Please use the following guidelines for seeking technical support for Remark Classic 

OMR. 

 

Outside the U.S. 

Contact your local sales agent for support. 

 

 

Within the U.S. 

NOTE: Services no longer under warranty or covered under a support 
agreement may be billable. 

When you have questions that are not answered by this manual or by the online Help 

system, call Scantron Software Support using the procedure below: 

 

Procedure 

1 Record the sequence of steps leading to the problem.  

2 Record the text of all error messages encountered. 

3 Have your software Serial Number available; it is displayed in the About Remark 

Classic OMR window in the Help menu. 

4 Be available at the scanning system. 

5 Call Scantron Software Support at 1-800-445-3141. 
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Installing Remark Classic OMR  

 

Chapter 2 

2.1 Overview 

This chapter provides system requirements, software installation instructions and 

starting and exiting procedures. Please consult your scanner’s installation guide for 

specific scanner installation instructions.  

2.2 System Requirements 

The following section provides the system configuration required for running Remark 

Classic OMR.  

 Personal computer with 1 GHz or faster processor  

 Windows 32-bit and 64-bit operating systems: XP SP3, Vista SP2 and Windows 7 

(Note: SP stands for “Service Pack”) 

o Remark Classic OMR runs on Windows Server 2003 SP2 and Windows 

2008 SP2, but please note the software is not a client/server application 

and is not supported in a virtual or server-based environment 

 1 GB RAM  

 1 GB free fixed disk space  

 CD-ROM drive (for installation purposes)  

 Screen/monitor resolution of 1024x768 or higher and at least 32-bit color  

 Mouse or other pointing device  

 Supported scanner 

 Windows-supported printer (optional) 

 PDF viewer required to view installed documentation (optional) 

 Microsoft Outlook 2007 or greater can be used for email functionality; if not 

present an internal Remark Classic OMR email client (using your SMTP server) 

may be used (optional) 

2.3 Installing the Software 

You must run the Remark Classic OMR installation program in order to use the software. 

Install Remark Classic OMR on a fixed drive with at least 1GB of free disk space. To scan 

directly into Remark Classic OMR, you must install the software on the same system to 

which the scanner is attached. Before installing the software, make sure you are an 

administrator on your computer. Each single license of the software can only be installed 

on a single computer. 

If you are upgrading to Remark Classic OMR 4 from an earlier version, do not install the 

software in the same directory as your previous version. Once the installation is 
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complete, you can copy information from your old installation that you want to use in 

the new version (e.g., form templates, data, etc.).   

Note: Modified/custom form template files are not backwards compatible. 
Remark Classic OMR 4 converts form templates from previous versions of 
the software automatically. However, once a form template has been 
converted, it cannot be opened in a previous version of the software. Always 
make copies of form templates before converting them. For standard forms, 
templates are included with the version 4 software. 

 

To install Remark Classic OMR  

The Remark Classic OMR CD-ROM contains an auto play feature so that when it is 

inserted into your CD-ROM drive, the installation begins automatically. This feature is 

only available if your CD-ROM drive’s auto play feature is enabled. If the software 

installation does not automatically start, use the following instructions to install the 

software. 

 

1 Insert the installation CD-ROM into your CD-ROM drive. 

2 Select Start on the taskbar, click Settings and then click Control Panel.  

Note: Accessing the control panel may vary slightly based on the version of 
Windows you are running. 

3 Double click Add or Remove Programs (or Programs, depending on your 

operating system). 

4 Click Install and then follow the on-screen instructions to display the Remark 

Classic OMR Installation window. 

Note: The .NET 3.5 Framework is required to install Remark Classic OMR. If 
you do not have it installed on your system, you are prompted to install it. 
Once the .NET Framework installation completes, the Remark Classic OMR 
installation resumes normally. 

5 Follow the on-screen instructions to complete the installation. You are prompted for a 

serial number and authentication code. You can find this information on a sticker 

on the CD case that came with your software. 

6 Some operating systems may ask whether you wish to install the software for all 

users or only the person currently logged into the computer. In most cases, and 

especially if multiple people use this computer and need to use Remark Classic OMR 

on this computer, you should choose the option for "all users/anyone who uses." 

7 When the installation completes, click the Finish button to close the installation 

program. 

2.4 Uninstalling the Software 

If you need to uninstall the software, use the Windows Control Panel|Add or Remove 

Programs function. 

Note: When uninstalling the software, all program and default files are 
removed. Files that you created remain on the system. However, for best 
practices purposes, if you plan to reinstall the software, we recommend 
backing up any files you wish to save prior to uninstalling the software. 
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To uninstall Remark Classic OMR 

1 Select the Start menu, click Settings and then click Control Panel. 

Note: Accessing the control panel may vary slightly based on the version of 
Windows you are running. 

2 Select the Add or Remove Programs option (or Programs, depending on your 

operating system). 

3 Select Remark Classic OMR 4 from the list and then click Remove or Uninstall. 

4 Follow the on-screen instructions to complete the uninstallation. 

2.5 Running Remark Classic OMR  

Use the following procedures to start and exit Remark Classic OMR: 

 

To start Remark Classic OMR  

1 If you chose to install a shortcut on your desktop during installation, double click this 

shortcut. Otherwise, select Start from the taskbar. 

2 Highlight Programs, highlight Remark Classic OMR 4 and then click Remark 

Classic OMR Data Center. To go directly to the Template Editor, click Remark 

Classic OMR Template Editor. 

Note: Accessing the installed programs may vary slightly based on the 
version of Windows you are running. 

The About Remark Classic OMR window displays. This informational window remains 

for a few seconds while the program loads. When complete, the main Remark Classic 

OMR window displays.  

2.6 Registering the Software 

You can register your Remark Classic OMR software from the Help menu within the 

software. The Register Software link takes you to the Scantron website, where you can 

fill out a short registration form. We encourage you to register your software so that you 

receive important product updates. 

To register your software 

1 In the Remark Classic OMR Data Center, select the Help menu and then click 

Register Software. You must have an active Internet connection. 

2 The registration page of the Scantron website appears in your default web browser. 

3 Fill in the regions requested and then click the Submit button. 

2.7 Updating the Software 

Remark Classic OMR periodically needs to be updated to the latest version when 

maintenance releases are made available. The option to Check for Updates is listed 

under the Help menu. If you are experiencing any problems with Remark Classic OMR, 

we advise checking for software updates prior to contacting Remark support. This step 

avoids contacting support for known issues that are already corrected within the 

software. 
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In addition, you can have the software automatically check for updates each time it 

starts up. To enable this feature, select Tools|Preference|Check for Updates. Then 

turn on the checkbox for Check for updates when starting. 

The Remark Classic OMR Automatic Update collects some system configuration data in 

order to provide you with updates that apply to your installation. This information 

includes: 

 Product Name  System Finger Print 

 Remark Serial Number  Software Version and Build Number 

 Remark Authentication Code  

Gravic, Inc., author of the software, is committed to helping protect your privacy. Using 

the automatic update feature does not collect your name, address, email address, or any 

other form of personally identifiable information. Your Internet Protocol (IP) address is 

logged when you connect to the Gravic website, but this address is only used to 

generate aggregate statistics.  

 

To check for updates manually 

1 Select the Help menu and then click Check for Updates. You must have an active 

Internet connection. 

Remark Classic OMR goes out to the Gravic website and checks for an update for 

your product. If an update is needed, you are prompted to download and install the 

update. If an update is not needed, you are advised that your software is up to date. 
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Navigating Remark Classic OMR 

Chapter 3 

3.1 Overview 

This chapter provides an overview of how to get around in Remark Classic OMR, 

including the menu items and tools available in the software. Wizards and other 

navigation tools are also described. Specific functions are explained in more detail in the 

appropriate sections of this user’s guide. 

3.2 Remark Classic OMR Components 

The Remark Classic OMR software interacts with you through three main components, 

which can display multiple windows. You may display many windows simultaneously, 

allowing you to use multiple Remark Classic OMR documents at one time. 

Remark Classic OMR contains a Template Editor component, a Data Center component 

and a Remark Quick Stats component. The Template Editor is used to create form 

templates for each form you want to process in the software. The Data Center is used to 

process forms, clean data and save/export data. Remark Quick Stats is used to grade or 

tabulate processed data. 

A shaded title bar designates the active or current window. Minimize documents on the 

desktop by clicking the minimize button located in the upper, right-hand corner of the 

window. Double clicking the minimized icon causes the document to become the current 

window. 

The software contains a menu bar, a toolbar and a status bar. The toolbar displays tools 

that, when selected, perform the 

function of an option under a menu 

pull-down item. Shifting between 

different types of windows causes the 

menu bar and the toolbar to change. 

Tools and options that lack functionality 

in a particular window do not display or 

are disabled (grayed out). The status 

bar displays information about the 

active document or the selected 

command. 

3.3 Navigation Tools 

Remark Classic OMR includes many wizards and navigation shortcuts to help you move 

through the software. The left portion of the Data Center contains a Task Pane that acts 

as a guide to help you decide what you would like to do. Once you perform a function, 

this Task Pane automatically updates with new options based on the last function you 

performed. You may use this tool as a way to understand what options are available to 

you at any time. Most options displayed in the Task Pane are also available from the 
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menus or toolbar. If you would prefer not to use the Task 

Pane, you may close the window by selecting the View menu 

and disabling the option titled Task Pane. You may also close 

sections of the task pane by clicking the title bar of the 

section.  

In some windows you will also notice an information button 

. When you see this button, hover the mouse over the 

button to view details about the current window, action, etc.  

3.4 Using the Mouse and Keyboard  

This section details the different mouse and keyboard 

conventions used in the Remark Classic OMR software. You 

can use either the mouse or the keyboard to perform 

functions within Remark Classic OMR. Occasionally, you might 

find it easier to combine the mouse and keyboard functions. 

3.4.1 Using the Mouse 

In this User’s Guide, the phrase “the mouse button” refers to the left mouse button, 

unless otherwise stated. The following table lists the different mouse actions and their 

meanings: 

 

Mouse Action Meaning 

Click Press and release the mouse button 

Double click Press and release the mouse button twice 

Right click Press and release the right mouse button 

Press Press and hold the mouse button 

Drag Move the mouse while holding down the mouse button 

3.4.2 Using the Keyboard 

You can use the keyboard or the mouse and the keyboard to make selections and 

perform functions within Remark Classic OMR. 

To use the keyboard to select objects 

1 Press Tab to activate the next item in a window. 

2 Press Shift+Tab to activate the previous item. 

 

3.4.3 Using Keyboard Shortcuts 

Most menu items and window objects provide “shortcut keys” as an alternative to using 

the mouse. An underlined letter in the label indicates the shortcut letter for the 

particular object or menu item. 

 

To pull down a menu item using keyboard shortcuts 

1 Press Alt + the shortcut letter of the menu item shown on the menu bar. (For 

example, press Alt+F to access the File menu.) 
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2 Press the underlined letter of the desired item from the pull-down menu. 

Many Remark Classic OMR menu pull-down options also employ “hot key” shortcuts 

(e.g., use Ctrl+X for “Cut”). 

3.4.4 Scrolling 

When you select a scrolling list, the Up/Down arrow keys, the Page Up/Page Down keys, 

and the Home/End keys perform the following actions: 

 The arrow keys move the list up or down a line at a time. 

 The Page Up/Page Down keys move up or down a “page” (window) of text at a 

time. 

 The Home/End keys move to the top or bottom of a list. 

Use scroll bars to view additional items in a list or different parts of a window. The 

following table explains how to use the mouse within a vertically oriented scroll bar to 

produce various results: 

 

Mouse Action Result 

Click the arrow at the bottom of the 

scroll bar 

Moves your view in the list down one line 

Click the arrow at the top of the 

scroll bar 

Moves your view in the list up one line 

Drag the elevator on the scroll bar Allows you to see various parts of the window. 

To drag the elevator, point to the elevator with 

your mouse, press the mouse button and drag 

the elevator along the scroll bar 

Click the mouse pointer above the 

elevator in the scroll bar 

Moves the elevator up one section 

Click the mouse pointer below the 

elevator in the scroll bar 

Moves the elevator down one section 

3.5 Menu Items 

Context-sensitive help is available for all menu items by highlighting the item in question 

and pressing F1. The following sections provide menu options for the Remark Classic 

OMR Template Editor and Data Center. Menu options for Remark Quick Stats are 

detailed in the Remark Quick Stats User’s Guide, which you can access under 

Start|Programs|Remark Classic OMR 4|Documentation. Please see the corresponding 

sections in this user’s guide for complete descriptions of the features that can be 

accessed from the menus. 

Most menu items can be represented on the toolbar, which is completely customizable 

within the Data Center (the Template Editor is not customizable). You may choose what 

toolbar buttons to display, whether to display them as images or text, and what text to 

include. You may also drag toolbars using the mouse to the desired location. 

 

To customize the tools displayed on the toolbar in the Data Center 

1 Right click the toolbar and then click Customize. 

2 On the Toolbars tab, choose the toolbars to display. 
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3 On the Commands tab, choose a command you 

wish to display and drag it to the toolbar to 

permanently place it on the toolbar.  

4 On the Keyboard tab, review the keyboard 

shortcuts for various tools. You may also create 

new toolbar shortcuts. 

5 On the Options tab, choose whether to show full 

menus when dropped down, reset the menu usage, 

display large icons, whether to show ScreenTips on 

toolbars, whether to show shortcut keys in the 

ScreenTips, and whether to use menu animation 

(changes how menus drop down). 

Note: When customizing the toolbar, you can 
see all of available toolbar options. If you 
attempt to drag a button to the toolbar and subsequently do not see the 
item on the toolbar, this means that the item you have selected is not valid 
for your setup (e.g., a disabled feature). 

 

To modify toolbar buttons 

1 Right click the toolbar and then click Customize. 

2 Go to the toolbar and right click the button you wish to modify. 

3 Choose the desired option from the menu. 

4 When you are finished modifying the toolbar, click the Close button on the 

Customize window.  

 

To delete toolbar buttons 

1 Right click the toolbar and then click Customize. 

2 Go to the toolbar and right click the button you wish to remove. 

3 Click the Delete option. 

4 When you are finished modifying the toolbar, click the Close button on the 

Customize window.  

3.5.1 File Menu 

Use the items in the File menu to perform operations on files. The operations include 

creating, editing, opening, closing, saving, displaying, and printing the data contained in 

these files.  

 

Template Editor: 

 

Tool Menu Pull-

Down Item 

Function 

 

New 

(Ctrl + N) 

Creates a new form template. 

 

Open… 

Template  

(Ctrl + O) 

Opens an existing form template for editing.  
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Tool Menu Pull-

Down Item 

Function 

 Close           

(Ctrl + F4) 

Closes the current form template. 

 

Save  

(Ctrl + S) 

Saves the open form template to a new or existing file. 

Clicking the Save button creates a new form template file 

or save the form template to the current file if one has 

already been established. 

 Save As  

(Ctrl + A) 

Saves an existing form template file under a new name or 

allows you to change the path to which the file saves. 

 Recent Files Displays the most recently used files. Click a file to open 

it. 

 Properties 

 

Displays the properties for the open form template. 

 Launch 

Remark 

Classic OMR 

Launches the Remark Classic OMR Data Center with the 

current form template file open. 

 Exit  

(Alt + F4) 

Exits the Remark Classic OMR Template Editor. 

 

Data Center:  

 

Tool Menu Pull-

Down Item 

Function 

 

New Form 

Template 

(Ctrl + N) 

Launches the Remark Classic OMR Template Editor in the 

new template state so that you may create a new form 

template. 

 

Open Form 

Template  

(Ctrl + O) 

Opens an existing form template for processing forms, 

opening data and running reports. Multiple form 

templates can be opened simultaneously, and the same 

form template can be opened multiple times. 

 

Edit Form 

Template  

(Ctrl + E) 

Launches the Template Editor with the active template 

automatically open for editing. 

 Convert to 

Web Survey 

Converts the form template file to a Remark Web Survey 

file for use in the Remark Web Survey application. This 

option only appears if you have Remark Web Survey 

installed on the same computer as Remark Classic OMR. 

 
Open Data 

(Ctrl + G)   

Opens an existing data file and displays the data in the 

current template grid window. Remark Classic OMR can 

read and save data in dozens of different file formats. 

 
Open Report 

(Ctrl + R) 

Opens an existing report file that was saved in Remark 

Quick Stats. 
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Tool Menu Pull-

Down Item 

Function 

 

Save Data 

(Ctrl + S) 

Saves data from the grid to a new or existing data file. 

Clicking the Save button creates a new data file or save 

the data to the current file if one has already been 

established. 

 Save Data 

As (F2) 

Saves an existing data file under a new name, allows you 

to select an output format, or allows you to change the 

path to which the file saves. 

 Save All 

Data       

(Ctrl + F2) 

Saves all open data files to one master file, allowing you 

to select a file name, output format and the path to which 

the file saves. 

 Save Data 

Builder    

(Ctrl + F3) 

Launches the Data Builder, which allows you to customize 

the data saving process by dynamically building file 

names and locations using information from the active 

data set. 

 
Email Emails the active data set using Microsoft Outlook or the 

built-in email program. 

 
Batch 

Wizard 

Opens the batch wizard so that you can create batch files. 

Batch files allow you to process a header sheet with 

identifying information for the forms that follow.  

 

Print             

(Ctrl + P) 

Prints the contents of the grid.  

 Recent Files Displays the most recently used files. Click a file to open 

it. 

 Close           

(Ctrl + F4) 

Closes the current data grid. If there are unsaved 

changes, you are prompted. 

 Close All 

Templates 

and Data 

Closes all open data grids. If there are unsaved changes, 

you are prompted. 

 Exit  

(Alt + F4) 

Exits the Remark Classic OMR Data Center. 

3.5.2 Edit Menu 

Use the items in the Edit menu to perform common Windows functions on one of the 

Remark Classic OMR documents. The operations include typical clipboard operations, 

such as copying and pasting information, and several data manipulation operations, such 

as finding & replacing. 

 

Template Editor: 
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Tool Menu Pull-

Down Item 

Function 

 
Undo  

(Ctrl + Z) 

Undoes the most recent change to the form template. 

 
Redo  

(Ctrl + Y) 

Redoes the last action to which Undo was applied. 

 
Cut  

(Ctrl + X) 

Moves a selection of text or region from one place to 

another by cutting it from the original position and 

pasting it in a new position (paste is a separate 

command). 

 
Copy  

(Ctrl + C) 

Allows for easy duplication and movement of information. 

You can copy a selected portion of text from a form 

template, or a region from one part of a form template 

(or a different document altogether), and paste it in a 

different part of the form template. 

 
Paste After 

(Ctrl + V) 

Pastes information from the clipboard after the selected 

node in the tree view. 

 Paste Before 

(Ctrl + B) 

Pastes information from the clipboard before the selected 

node in the tree view. 

 
Delete  

(Delete) 

Removes the highlighted information. This operation does 

not use the clipboard, and Remark Classic OMR retains no 

copy of the deleted information (except by Undo). 

 

Data Center: 

 

Tool Menu Pull-

Down Item 

Function 

 

Cut  

(Ctrl + X) 

Moves a section of text from one place to another (or to 

another document) by cutting it from the original position 

and pasting it in a new position (paste is a separate 

command). 

 

Copy  

(Ctrl + C) 

Allows for easy duplication and movement of information. 

You can copy a selected portion of text from one part of a 

data grid (or a different document altogether), and paste 

it in a different part of the data grid. 

 

Paste  

(Ctrl + V) 

Whenever a section of text is copied or cut, Remark 

Classic OMR places the contents on the clipboard. This 

intermediary holds the information so you can paste it 

(multiple times if desired) until you place something new 

on the clipboard (by cutting or copying something else). 

Data can be copied from a document of one program and 

pasted to a document of another as long as the data are 

compatible. 
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Tool Menu Pull-

Down Item 

Function 

 Paste 

Special 

Allows you to paste information from one cell in the data 

grid to multiple cells. 

 

Delete  

(Delete) 

Removes the highlighted information. This operation does 

not use the clipboard, and Remark Classic OMR retains no 

copy of the deleted information. 

 
Insert Row 

(Shift + 

Insert) 

Inserts a row into the data grid based upon the active 

cell. The row is added above the row containing the active 

cell. 

 
Delete Row 

(Shift + 

Delete) 

Removes a row in the data grid. The row containing the 

active cell(s) is deleted. This operation cannot be undone. 

 

Find  

(Ctrl + F) 

Displays a window asking for the search text. Remark 

Classic OMR searches forward from the cursor position for 

the text requested. 

 

Find Next  

(F3) 

 

Searches for the next instance of the previous search. If 

Find has not yet been chosen, or could not locate the 

previous search, Find Next disables. 

 
Replace  

(Ctrl + H) 

Displays the Replace text window. The search text box 

contains either the highlighted text or the previous search 

text, and the replace text contains either the previous 

replace text or is blank. You can replace all occurrences of 

the search text by clicking Replace All. 

 Select All  

(Ctrl + A) 

Highlights the entire data grid. This is equivalent to 

clicking the top-left corner of the grid and dragging the 

mouse to the bottom-right, selecting all cells in the 

process. 

 
Sort Allows the sorting of data in ascending or descending 

patterns based on particular regions. 

3.5.3 View Menu 

The View menu allows you to choose which toolbars you would like to display and 

allows you to customize the current view. 

 

Template Editor: 

 

Tool Menu Pull-

Down Item 

Function 

 Toolbar Displays the toolbar buttons that are used as shortcuts 

to perform functions (e.g., open, save, etc.) 
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Tool Menu Pull-

Down Item 

Function 

 Status Bar  Displays the status bar, which is the horizontal bar 

located at the bottom of a window that displays pertinent 

information about application processes or the currently 

selected item. 

 Read 

Direction 

Displays the arrows representing the direction in which 

forms are read by an OMR scanner and acts as a guide 

when creating regions on your form template. 

 

Data Center: 

 

 Menu Pull-

Down Item 

Function 

 
Image 

Viewer 

Displays the Image Viewer in the Data Center to show 

images of forms as they are scanned or when clicking in 

a cell. This option is only available when using an image-

enabled scanner. 

 
Graph 

Viewer 

Displays the Graph Viewer in the Data Center to show a 

graph of data as forms are processed or when clicking in 

a cell. 

 
Task Pane Displays the Task Pane in the left side of the Data 

Center, which provides shortcuts to frequently used 

functions (e.g., open, save, etc.). The Task Pane updates 

with appropriate tasks as you perform certain functions 

in the software. 

 Flag Legend Displays the legend explaining each type of exception 

flag and its associated flag color. 

 Freeze Rows   Freezes grid row(s) so that if you scroll in the data grid, 

the frozen rows still appear. 

 Unfreeze 

Rows 

Unfreezes any row(s) to which you applied the Freeze 

Rows property. 

 Freeze 

Columns   

Freezes the grid column(s) so that if you scroll in the 

data grid, the frozen columns still appear. 

 Unfreeze 

Columns 

Unfreezes any column(s) to which you applied the Freeze 

Columns property. 

 Theme Allows you to choose a theme for the software, which 

defines colors, fonts, title bars, etc. You may also choose 

whether to display large or small icons on the toolbar. 
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3.5.4 Tools Menu 

The items available in the Tools menu are the primary Remark Classic OMR operations. 

These items vary slightly from the Template Editor to the Data Center. 

 

Data Center: 

 

Tool Menu Pull-

Down Item 

Function 

 
Read Wizard 

(F5) 

Opens the Read Wizard so that you may read page(s) 

from a scanner and place the data into the data grid. 

 

Easy Scan 

(Ctrl+F12) 

Begins the scanning process based on the last settings 

used in the Read Wizard. Note that you cannot adjust 

the settings. If you are unsure of the last settings 

used, you should use the Read Wizard to scan your 

forms. 

 End Read Stops the process when scanning forms. 

 

Review 

Exceptions 

(F4) 

Searches the open data grid and allows you to correct 

exception cases (e.g., blank or multiple responses) and 

enter input region information. The Task Pane on the 

left shows the available options. 

 

Review 

Duplicates 

Searches the open data grid and allows you to correct 

duplicate entries (e.g., two records in the data set 

belonging to the same respondent based upon the 

respondent ID). The Task Pane on the left shows the 

available options. 

 

 

 

 

 

Analysis Accesses the grade and survey options in the software: 

Easy Grade: grades the current data set using the first 

grid row as the answer key and grading options as 

defined in the form template. (F6) 

Grade Wizard: launches the Grade Wizard for 

customized grading. (Ctrl + W) 

Easy Survey: tabulates the current data set using 

tabulation options as defined in the form template. 

(Ctrl + U) 

Survey Wizard: launches the Survey Wizard for 

customized survey tabulation. (Ctrl + I) 

Analysis Preferences: allows you to modify settings 

that control the way Remark Quick Stats looks, feels 

and performs.  

 View Reject 

Log 

Displays a log file of all forms that were rejected when 

scanning forms using a reject stacker. 

 
Automation 

Wizard 

Launches the Automation Wizard, which allows you to 

set up executable files that automate basic Remark 

Classic OMR functions. 
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Tool Menu Pull-

Down Item 

Function 

 Send Wizard Launches the Send Wizard, which allows you to email a 

data file or send it to an FTP site. 

 Test Import 

Wizard 

(F12) 

Launches the ExamView® Import Wizard, which allows 

you to import legacy data from the ExamView 

software. 

 
Respondent 

Detection 

(F11) 

Allows you to determine which respondents in your 

data have been processed, not been processed or have 

been processed multiple times. This feature is used in 

conjunction with the Database Lookup feature. 

 

Perform Spell 

Check (F7) 

Checks the selected data file for spelling errors. 

 

OMR Scanner  

(Ctrl + F8) 

Accesses the OMR Scanner Properties window so that 

you can set up a scanner or make changes to the 

current scanner setup. Use this option when using an 

OMR only scanner (one without imaging). 

 OMR/Image 

Scanner 

(Ctrl + F9) 

Accesses the OMR/Image Scanner Properties window 

so you can set up a scanner or make changes to the 

current scanner setup. Use this option when using an 

image-enabled scanner. 

 

Preferences 

(F9) 

Allows you to modify settings that control the way the 

Data Center looks, feels and performs. Use the Task 

Pane in the Preferences to perform software 

customization. Remark Classic OMR saves any changes 

you make and applies them to future actions. 

3.5.5 Sheet and Region Menus 

The Sheet and Region menus are available in the Template Editor as you are creating 

or editing a form template. These menus give you options to add, delete, edit and view 

the properties of regions in the form template. The items change depending on whether 

you have selected a Page node or a Region node in the tree view. 

 

Tool Menu (Page 

or Region) 

Menu Pull-

Down Item 

Function 

 Sheet & Region Insert 

Before/After 

Inserts a page or region before or after 

the selected node. Regions can be OMR, 

barcode or Input. 

 
Region Add Linked 

Region 

Adds a region to another region, linking 

them into one question. This feature is 

used for regions that have text or lines 

separating the answer choices and the 

OMR box cannot be drawn around all of 

the marks together.  
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Tool Menu (Page 

or Region) 

Menu Pull-

Down Item 

Function 

 
Region Link Links multiple regions together so that 

they are considered one question. 

 
Region Break 

Region Link 

Separates a linked region into individual 

regions. 

 Sheet & Region Properties Shows the properties for the sheet or 

region. 

3.5.6 Help Menu 

When you have questions about the use of Remark Classic OMR, or about a specific 

menu or command, look in the help file. 

Note: Help is context-sensitive. Press F1 while any Remark Classic OMR 
window is active and help text appropriate to that window displays 
whenever possible. 

Tool Menu Pull-

Down Item 

Function 

 Contents Displays the contents of the Remark Classic OMR help 

file. 

 Documentation Displays a folder containing the Remark Classic OMR 

user’s guides in PDF format. 

 Edit 

Authentication 

Allows you to enter a new serial number or 

authentication code for the software. You should only 

use this option when directed by Scantron personnel. 

(Data Center only) 

 Register 

Software 

Launches your default web browser and loads the 

software registration page on the Scantron website. 

We strongly recommend that you register your 

software so that you receive important product 

notifications. (Data Center only) 

 Check for 

Updates 

Checks the Gravic website for a software update. If an 

update is available, you are given prompts to 

download and install it. If no update is available, you 

are notified that your software is up to date. 

 Copyrights Displays copyright information for Remark Classic 

OMR. (Data Center only) 

 About Remark 

Classic OMR 

Template 

Editor/Data 

Center 

Displays the About Remark Classic OMR window, 

showing information about Gravic, Inc. as well as the 

serial number and current version of the software that 

is running. 
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3.6 Accessing the Software Help File 

Remark Classic OMR includes a help file to provide answers to your questions. Use the 

following procedures to access help when running Remark Classic OMR: 

 

To access online help 

1 To view context-sensitive help on the current window, press F1. 

2 To view the main help contents window for Remark Classic OMR, select the Help 

menu and then click Contents. 
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Setting Up Your Scanner 

 

Chapter 4 

4.1 Overview 

This chapter provides general information about OMR scanners and how to configure 

your scanner in Remark Classic OMR. You should already have your scanner connected 

to your computer and, if necessary, the drivers installed that allow the scanner to work 

before attempting to use your scanner with Remark Classic OMR. Remark Classic OMR 

allows you to set up your scanner in one of two ways: OMR Only or OMR/Image 

Scanners (captures scanned form images). 

4.2 OMR Scanners- General Information  

An OMR scanner is a peripheral device attached to a computer that is used to scan 

paper-based documents, such as standardized tests, evaluations and other form types. 

OMR scanners come in two basic types: hand feed and automatic feed. You feed sheets 

through a hand feed scanner one at a time. An automatic feed scanner can handle 

batches of sheets at one time. Some scanners connect to the computer with a serial 

cable and some connect using a USB cable (a driver is typically required for a USB 

connection). If your scanner uses a serial connection and your computer does not have a 

serial port, you may need to purchase an adapter. Please contact your scanner 

manufacturer for recommended adapters. 

4.3 OMR Forms 

OMR forms are created specifically to be read by OMR scanners. For this reason, these 

forms are created to very precise specifications. It is important to review these concepts 

here before you begin scanning forms. 

Aside from the bubbles on the form, the two major characteristics of an OMR form are 

the Timing Marks and the Columns. 

4.3.1 Timing Marks 

Timing marks are small, black marks that signify the vertical position of each row of data 

on the sheet. These marks are placed along the edge of the form and indicate the 

presence of mark information to the OMR scanner. 

4.3.2 Columns 

Columns refer to the number of columns (sometimes called channels) that are contained 

on the form. OMR scanners can typically read either 12 or 48 columns, although 5, 14 

and 40 are also possibilities. Each mark on the form lines up with a timing mark and a 

column. See your OMR scanner’s documentation for the specifications for your model.  
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The following example shows the typical layout of timing marks and columns on a form. 

The timing marks go down the left side of the form and the columns are numbered from 

left to right. The actual bubbles for each field on the form could correspond with any 

combination of timing marks and columns (e.g., a region on the form may be present 

beginning with timing mark three and column five).  

 

Column 1          Column 48 

         

 

 

 

 

 

 

 

 

 

 

 

 

4.4 
Selecting Your OMR Scanner 

Remark Classic OMR currently supports several OMR scanners. To use an OMR scanner 

with the Remark Classic OMR software, you must first select your OMR scanner from the 

list of supported OMR scanners. Please note that if your scanner requires a separate 

driver to operate, you must install that driver prior to using the scanner in Remark 

Classic OMR. Please see your scanner documentation for assistance with drivers and 

installation. 

4.4.1 Selecting an OMR Only Scanner 

If your scanner is an OMR only scanner, meaning it does not have imaging capabilities, 

you should set it up using the OMR Scanner Properties window. The following scanners 

can work in this mode: 

 

OpScan 2     Scanmark 2000  

OpScan iNSIGHT 2 (OMR only)  Scanmark 2250 

OpScan 3     Scanmark 2500 

OpScan 4/4U    Scanmark 4000 

iNSIGHT 4/4ES (OMR only)  Scanmark 5500 

OpScan 5     Scanmark ES2010 

OpScan 6     Scanmark ES2260 

OpScan 7     Scanmark ES 2800 

OpScan 8     EZData 
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To select your OMR scanner  

1 From the Remark Classic OMR Data Center, select the Tools menu, click OMR 

Scanner and then click OMR Scanner Properties. 

2 Click the Scanner Type down arrow to display a list of available scanner types. 

Choose the scanner you are currently using. 

Based upon your scanner selection, default settings are displayed. You may change the 

settings if it is appropriate to your system’s setup. The following table details the 

scanner options: 

 

Area Options Meaning 

 Scanner Type Shows the available OMR scanner 

models. 

Scanner Settings Recognition Threshold Sets how leniently or strictly the 

software interprets the marks. This 

setting specifies a value at which a 

mark is considered filled. 

 Mark Discrimination Sets the value that determines the 

difference between two marks that 

are filled or partially filled, as in the 

case of erasures. 

 Discrimination Cutoff Sets the value at or above which 

any mark is considered filled 

regardless of how other marks in 

the field are filled.   

 Scanner Timeout Sets the number of seconds for the 

scanner to respond before timing 

out. 

 System Pause Sets the amount of time in 

milliseconds (1/1000th of a second) 

that the system pauses to ensure 

that all internal OMR scanner 

operations are complete. 

 Feeder option installed Mark this checkbox if your scanner 

has an automatic sheet feeder. 

 Duplex option installed Mark this option if your scanner has 

duplex capabilities, meaning it can 

scan both sides of a sheet of paper 

in one pass through the scanner. 

 Select stacker installed Mark this option if your scanner has 

a select stacker installed 

(sometimes referred to a reject 

stacker or reject hopper). The 

select stacker is a separate tray 

where forms containing problems 

reside (e.g., if a form is scanned 

but cannot be recognized). 
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Area Options Meaning 

 Transport printer installed Mark this option if your scanner has 

a printer, which can be used to 

print score information or items 

such as date, time and record 

number as forms are scanned. 

 Barcode option installed Mark this option of your scanner 

has a barcode reader. 

 SelfScore option installed Mark this option if your scanner can 

run in SelfScore mode (where 

grading is handled on the scanner 

using the scanner’s panel). 

COM Port Settings Port Number Use this setting to select the com 

port number on the computer to 

which the scanner is connected. If 

your scanner is connected via a 

USB converter, there is still a com 

port listed. 

 Baud Rate Use this setting to set the default 

data transfer rate. This setting 

controls the speed of the transfer of 

data. 

 Data Bits Use this setting to set the default 

value for data bits, which are the 

smallest unit of information on the 

computer. Information is gathered 

by combining data bits into bytes of 

information. 

 Parity Use this setting to set the parity, 

which is an error detection method 

used to verify the integrity of 

individual characters in the data 

being transferred. 

 Stop Bits Use this setting to set the default 

value for stop bits, which are bits 

that indicate that a byte has just 

been transmitted. Every byte is 

preceded by a start bit and followed 

by a stop bit. 

 Flow Control Use this setting to set the default 

value for flow control, which is the 

process of adjusting the flow of 

data from one device to another to 

ensure that the receiving device 

can handle all of the incoming data. 
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Note: Once you select your scanner model, the default settings are often 
appropriate. You may just need to tell the software which options your 
scanner has installed. 

3 Mark the appropriate options for your scanner. The settings you choose for the COM 

port must match the settings on the scanner exactly. Some scanners require you to 

manually configure or run configuration sheets through the scanner in order to 

establish settings. Please use your 

scanner’s user’s guide for 

configuration steps. Once the 

scanner is configured, use the 

same settings in Remark Classic 

OMR. 

4 Click the OK button to save your 

scanner setup options. 

Note: Once you have selected 
your scanner, clicking the 
Defaults button sets the 
scanner’s properties back to 
original software installation 
state. 

5 Select the Tools menu, click OMR Scanner and then click Set as Default Scanner. 

Remark Classic OMR uses this scanner when any scanning commands are executed. 

You are now ready to scan forms or if necessary, create a template in the Remark 

Classic OMR Template Editor. Go to Chapter 5 if you need to create a form template for 

your form. If you already have a form template for your form, you may go to Chapter 6 

to learn how to scan filled in forms. 

Tip: Many standard forms already have form templates in the software. 
Check the Templates folder of your Remark Classic OMR installation 
directory to see the form templates that ship with the software (the default 
path is C:\Program Files\Gravic\Remark Classic OMR 
4\Templates\Scantron\OMR). 

4.4.2 Selecting an Image Enabled Scanner 

If your scanner has imaging capabilities, meaning that it can capture images of the 

forms as they are scanned, you should set up your scanner in the OMR/Image Scanner 

Properties window. The following scanners have image capabilities: 

 

iNSIGHT 20   iNSIGHT 2 (USB mode) 

iNSIGHT 30   iNSIGHT 4/4ES (USB mode) 

 

Please note that all the scanners listed in section 4.4.1 can be set up in the OMR/Image 

Scanner properties. However, we recommend only using this option for the scanners 

listed above. 

When using an image-enabled scanner, an image of each sheet is captured during 

scanning. You can archive these images and use them to view exceptions on forms that 

may need your attention (e.g., a multiple response where one was not permitted).  
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To select your OMR/Image scanner  

1 From the Remark Classic OMR Data Center, select the Tools menu, click 

OMR/Image Scanner and then click OMR/Image Scanner Properties. 

2 Click the Auto Detect Scanner button to have the software automatically search for 

scanners on the system. Your scanner must be turned on, connected to the 

computer, and the driver must be installed (if necessary). 

Note: You can choose your scanner in the Scanner Configuration area 
however, in most cases we recommend simply clicking the Auto Detect 
Scanner button. 

Based upon your scanner selection, default settings are displayed. Most items are turned 

on and off automatically based on how the scanner is configured. If an option is 

disabled, it means you cannot turn it on or off manually. You have to adjust it on the 

scanner. Under normal scanning conditions, the default settings are appropriate. The 

following table details the scanner options: 

 

Area Options Meaning 

 Auto Detect Scanner  Searches all ports on the system for 

an active scanner. The scanner 

must be plugged in, turned on and 

connected to the computer and if 

necessary, the driver must be 

installed in order for the software to 

find it. 

COM Port Settings Baud Rate This setting determines the default 

data transfer rate. This setting 

controls the speed of the transfer of 

data. 

 Data Bits This setting determines the default 

value for data bits, which are the 

smallest unit of information on the 

computer. Information is gathered 

by combining data bits into bytes of 

information. 

 Parity This setting determines the parity, 

which is an error detection method 

used to verify the integrity of 

individual characters in the data 

being transferred. 

 Stop Bits This setting determines the default 

value for stop bits, which are bits 

that indicate that a byte has just 

been transmitted. Every byte is 

preceded by a start bit and followed 

by a stop bit. 
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Area Options Meaning 

Scanner Options Use select stacker Mark this option if your scanner has 

a select stacker installed 

(sometimes referred to a reject 

stacker or reject hopper). The 

select stacker is a separate tray 

where forms containing problems 

reside (e.g., if a form is scanned 

but cannot be recognized). 

 Use transport printer  Mark this option if your scanner has 

a printer, which can be used to 

print score information or items 

such as date, time and record 

number as forms are scanned. 

 Use SelfScore This option is marked if your 

scanner is running in SelfScore 

mode (where grading is handled on 

the scanner using the scanner’s 

panel). Note that if the scanner is in 

SelfScore mode, this checkbox is 

checked and disabled. To turn off 

SelfScore, reset the scanner and 

then click the Find Scanner button. 

 Use bar code reader Mark this option of your scanner 

has a bar code reader and you want 

to read bar codes. 

 Duplex scanner Mark this option if your scanner has 

duplex capabilities, meaning it can 

scan both sides of a sheet of paper 

in one pass through the scanner. 

 Write operations log Mark this option to create an 

operations log file for the batch. 

The file is located in the ScanTools 

Plus Data directory, in a file named 

OPERATE.LOG, and contains 

statistics on scanning operations. 

Recognition 

Settings 

Threshold Sets how leniently or strictly the 

software interprets the marks. This 

setting specifies a value at which a 

mark is considered filled. 

 Discrimination Sets the value that determines the 

difference between two marks that 

are filled or partially filled, as in the 

case of erasures. 
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Area Options Meaning 

 Mark Cutoff Sets the value at or above which 

any mark is considered filled 

regardless of how other marks in 

the field are filled.   

 Timeout Sets the number of seconds for the 

scanner to respond before timing 

out. 

 

3 Mark the appropriate options for your scanner. Most options are enabled and 

disabled based on how the scanner is configured. If an option is disabled, you may 

not change it in the software (you can typically change it on the scanner if it is a 

supported feature of your particular scanner). You can turn on and off certain 

features such as the printer and select stacker. 

4 Click the OK button to save your scanner setup options. 

Note: Once you have selected your scanner, clicking the Find Scanner 
button sets the scanner’s properties back to the original state. 

5 Select the Tools menu, click OMR/Image Scanner and then click Set as Default 

Scanner. Remark Classic OMR uses this scanner when any scanning commands are 

executed. 

You are now ready to scan forms. Proceed to Chapter 6 to learn how to scan filled in 

forms. 
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Using the Template Editor 

Chapter 5 

5.1 Overview 

The first step in using Remark Classic OMR is to create or locate the form templates for 

the forms you wish to process in the software. A form template file contains the 

information needed to instruct Remark Classic OMR about each form. The form template 

conveys the location of the information on the pages (e.g., the bubbles the respondents 

will darken) and the specifics of the data you require. The form template defines the 

backend database you will use for storage of the processed data. You create a form 

template for each form that you wish to process using the software.  

Remark Classic OMR contains pre-defined form templates for many commonly available 

forms. If your form does not have an associated form template, you need to make a 

form template in order to use the form. Form templates are created in the Remark 

Classic OMR Template Editor. If a form template already exists for your form, you do not 

need to use the Template Editor at all. You can skip to Chapter 6, Scanning Forms, and 

start scanning your forms. 

Tip: Before attempting to use the Template Editor, check to see if your form 
already has a template created. By default, form templates are installed in 
this location: C:\Program Files\Gravic\Remark Classic OMR 
4\Templates\Scantron\OMR. If you see folders that contain form templates 
you do not use, please do not delete the folders; this will force Remark 
Classic OMR to try to reinstall them when you next run the software. 

Form templates are created by looking at the physical form and then recreating the 

bubble areas in the Remark Classic OMR Template Editor. You use the mouse to drag 

boxes (called regions) around the marks (e.g., bubbles) and other areas you want to 

have recognized on your form. These regions tell the software where each piece of 

information you want to capture is located on the page and other pertinent information 

about the form. They also tell the software what type of data you need the software to 

output from each area. You may only edit and create templates that have a .rco 

extension, which work with regular OMR scanners (not OMR/Image scanners). 

Special Note for Image-Enabled Scanners: If you are using an image-
enabled scanner, you are not able to create and edit form templates. You 
must use the templates found in C:\Program Files\Gravic\Remark Classic 
OMR 4\Templates\Scantron\OMR-Image. There are required files that match 
these templates; therefore changing the templates causes them to stop 
working with the software. If you have a need to change an existing form 
template or create a form template for a custom form, please contact 
Scantron for assistance. 

The following topics are covered in this chapter: 

 Creating form templates (Section 5.2) 

 Using the Template Editor (Section 5.2) 

 Region types (Section 5.2) 



Remark Classic OMR User’s Guide 

36 

 Creating regions (Section 5.2) 

 Advanced region options (Section 5.3) 

 Additional features (Section 5.4) 

 Saving Form Templates (Section 5.5) 

 Editing existing form templates (Section 5.6) 

5.2 Creating Form Templates 

5.2.1 Using the Template Editor 

The Remark Classic OMR Template Editor contains two basic components that you use to 

create and edit your form templates. The left portion of the Template Editor window 

contains a tree view with nodes representing each region in your form template. You can 

think of the tree view as an item list. The right side of the window contains a page 

representation of your form, or a graphical replication of your form. You may use the 

tree view and the page representation area to work with your form template. Each node 

in the tree view contains the properties of that node, which can be accessed by double 

clicking the node. You may also double click within a region in the page representation 

area to view the region’s properties. Continue with the following sections for specific 

instructions on using the Template Editor. If you are unfamiliar with OMR terminology, 

you may wish to read Chapter 1: Remark Classic OMR Overview before attempting to 

use the Template Editor. 

5.2.2 Region Types 

Regions are explained in more detail later in this chapter, but it is worth providing an 

overview here. There are three basic region types that Remark Classic OMR can process: 

 

Region Type What is on 

Your Form 

Description 

OMR (Optical 

Mark 

Recognition) 

Bubbles, 

checkboxes or 

any other 

complete 

shape, often 

used for 

answering 

multiple choice 

questions, 

filling in names 

and codes, etc. 

OMR regions are used to capture 

marks, such as bubbles and 

checkboxes, on your form. Marks can 

be used to collect many varying types 

of information, ranging from multiple 

choice questions to ID numbers to 

names.  

Barcode Printed barcode 

or barcode 

sticker 

Barcodes are used to encode just about 

any desired information, ranging from 

names to ID numbers to other 

demographic information.  
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Region Type What is on 

Your Form 

Description 

Input An area for 

handwritten 

text, or other 

information 

that cannot be 

automatically 

converted to 

data 

Input regions allow you to manually 

enter information into your data set. 

For example, you can use Input regions 

to capture handwriting from comment 

areas and other open ended questions. 

The software does not automatically 

interpret handwriting, but it does allow 

you to hand enter the written 

information. 

 

Now that you know how your form translates to a form template, we can begin the 

basics of form template creation. 

5.2.3 Beginning the Form Template 

Form templates are created in the Remark Classic OMR Template Editor. There are two 

main ways to access the Template Editor to create a new form template: 

 From the Remark Classic OMR Data Center, select the File menu and then click 

New Form Template or click . Alternatively, with the Templates tab selected, 

click New form template in the Task Pane. 

 From your Windows Start menu, click Start|Programs|Remark Classic OMR 

4|Remark Classic OMR Template Editor. 

 

To create a new form template 

1 From the Template Editor, select the File menu and then click New, or click , 

to begin a new form template.  

The Form Template Creation Wizard 

window appears. This wizard allows you to 

specify general information about the form 

template, including a name, description, 

number of sheets, columns and timing marks 

and other pertinent information.  

2 Click the Next>> button to start the 

wizard.  

3 In the Form Type section, choose 

Simplex Form or Duplex Form. A 

simplex form contains a single sided sheet 

or sheets and a duplex form contains a 

double sided sheet or sheets. Here are 

some examples of form types: 

 One sheet of paper with OMR marks on one side is a simplex form with one 

sheet. 

 One piece of paper with OMR marks on both sides is a duplex form with one 

sheet. 
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 Two pieces of paper with OMR marks on both sides is a duplex form with two 

sheets (this is often in booklet form). 

4 In the Form Details section, choose the 

Number of Sheets and the Number of 

Columns in the form. The number of 

sheets corresponds with the how many 

pieces of paper the form contains (not 

the number of sides). For example, a 

one page duplex form would have one 

sheet with two sides. 

5 In the Form Description box, enter a 

brief description of the form, if desired. 

6 In the Form Manufacturer box, enter 

the name of the form manufacturer, if 

desired. 

7 If this form template will be used to scan 

in SelfScore mode (specially equipped 

scanners only), mark the checkbox titled 

SelfScore form template. 

8 Click the Next>> button to continue. 

The Step 2 window appears. 

9 If all of the sheets within the form have 

the same number of timing marks, mark 

the checkbox for Pages Contain the 

Same Number of Timing Marks and 

then enter the number of timing marks 

on the form. If each sheet has a 

different number of timing marks, 

deselect the checkbox and type in the 

number of timing marks on each side of 

each sheet. 

10 If your form does not contain page ID 

marks or respondent trackers, click the 

Finish button and proceed to section 5.2.3. Otherwise, click the Next>> button to 

continue. 

The Step 3 window appears. This window allows you to specify page ID marks and/or 

respondent trackers (lithocodes) if either is present on your form. Page ID marks are 

used to identify a sheet within a form. A respondent tracker, often called a lithocode, is 

used to identify a particular respondent. A respondent tracker can be an OMR region or a 

barcode. In order to use respondent trackers, you must have a multi-sheet form. You 

can use respondent trackers and page ID marks independently or together. If you use a 

page ID mark in conjunction with a respondent tracker, Remark Classic OMR can identify 

specific sheets as belonging to a specific respondent when reading forms. This feature is 

useful when scanning multi-page forms, such as booklets. If the pages are scanned out 

of order, the software is able to collate the data together based on the page IDs and 

respondent trackers. 
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11 If identifying a page ID mark, mark the 

checkbox for Page ID Mark Present.  

12 Select whether the page ID mark is 

oriented by Column or Row. The 

specific information about the mark’s 

location changes depending on its 

orientation. 

13 Enter the information about the page ID 

mark’s location (e.g., location row or 

column, start row or column and end row 

or column). You will be able to specify 

specific locations in the next step. Use 

caution when entering the end column. If 

you instruct the software to read all the 

way to the end of the form, any stray marks in that area can be picked up, causing 

the page not to be recognized. It’s advisable to use an End Column that is one after 

your last page ID mark. 

14 If identifying a respondent tracker, mark the checkbox for Respondent tracker 

present. 

15 Mark the checkbox for Display Respondent tracker in grid if you would like the 

data from the respondent tracker to be visible in the data grid during form 

processing. 

16 Select the type of region being used for the respondent tracker in the box titled 

Recognition type. This region can be an OMR region or a barcode region. 

Note: If using an OMR region as a respondent tracker, the OMR region must 
output a single piece of data. 

17 If the form you will be scanning has a read head test row (a sequence of marks that 

tests the read heads on the OMR scanner), mark the checkbox for Read head test 

in row and then enter the row number in the adjacent box. If your form does not 

have a read head test row, you may skip this step (it is not common). 

18 Click the Next>> button to continue. 

The Step 4 window appears. This window 

allows you to select properties pertaining to 

the page ID marks. 

19 Select the column(s) that contain the 

page ID marks. 

20 If scanning a double sided form, mark the 

checkbox for Sheets have the same 

page ID values on both sides if the 

page ID marks are identical on both sides 

of the sheet. If the same page ID marks 

are not present on all sides of all sheets, 

deselect this checkbox and place 

checkmarks in the appropriate columns 

where the page IDs are located on each 

sheet. 

21 If you have chosen to use respondent trackers (lithocodes), click the Next>> button 

and go to step 22. Otherwise, click the Finish button to complete the Form 

Template Creation Wizard. 
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22 If you are using respondent trackers, the 

Step 5 window appears. In the 

Template sheets containing 

respondent tracker regions area, 

select the location of the respondent 

trackers on the various sheets. 

Respondent trackers do not have to be 

present on each sheet. The default 

options for duplex forms are: All the odd 

numbered sheets or All the even 

numbered sheets and. The default 

option for simplex forms is All sheets. 

You may also enter custom locations by 

selecting the Custom option button. If 

using custom locations, enter them in the 

Respondent Tracker Present grid on a 

per sheet basis. 

23 Click the Properties tab to enter 

properties for the respondent trackers. 

This information tells the software where 

to locate the respondent tracker on the 

form. 

24 In the box titled Region Name, enter a 

name for the region. The default name is 

Respondent ID but you may enter a 

different name. 

25 In the Region Options section, choose a 

region type.  

 If the respondent tracker region is an 

OMR region, it must output a single 

piece of data. Therefore, you are 

limited to the Grid, Add and Binary region types.  

 If the respondent tracker is a barcode region, you can choose the Text or 

Numeric data type and enter the Measurement Options for the barcode. 

Barcodes must be vertical in orientation. 

26 If using an OMR region, select the orientation in the Orientation drop-down box. 

Orientation can be by Row or Column. 

27 In the Region Size section, enter the location of the respondent tracker region. 

Enter the following information: Start column, Number of columns, Column gap, 

Start row, Number of rows and Row gap. This information translates to the 

location of the region on the paper form. 

Note: Specific properties of regions are described in greater detail later in 
this chapter. If you require more 
information about region types and 
region sizes, please refer to Section 
5.2.4. 

28 Click the Finish button to complete the 

Form Template Creation Wizard. 

Remark Classic OMR opens a window with a 

tree view on the left and a page 
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representation of your form on the right. The blue arrows indicate the direction in which 

the form is read. In this window you outline the areas to be recognized. You use this 

window to show the software where the various regions of data are on your form and 

what to output during scanning. This task is accomplished by creating regions. 

5.2.4 Creating Regions 

Regions can be created several different ways: by using the tree view, menus, or 

toolbar. The following sections detail these methods. 

You can create regions using the tree view by utilizing the page representation area to 

bring up any of these menus. 

 

Using Menus to Insert Regions Using a Mouse to Insert Regions 

1 Click the node above or below 

where you would like the new 

region to be added so that it is 

highlighted. For the first question, 

click the Sheet 1 node. 

1 Click the node above or below 

where you would like the new 

region to be added so that it is 

highlighted. For the first question, 

click the Sheet 1 node. 

2 Click the Region menu if you have 

selected a region. Click the Sheet 

menu if you have selected a sheet. 

2 Right click the same node, to 

display a drop-down menu. 

3 Click Insert Before or Insert 

After, depending on where you 

would like the new region or sheet 

located in respect to the 

highlighted node. 

3 Click Insert Before or Insert 

After, depending on where you 

would like the new region or sheet 

located in respect to the highlighted 

node. 

 

4 From the Insert menu, choose Region, Input, or Barcode, depending on the type 

of region you want to create. See the next section for detailed descriptions of each of 

these region types. 

The Region or Sheet Properties box appears. Region types and properties are 

explained in Section 5.2.5.a. 

 

Using the toolbar and the page representation area to create regions 

1 Select the toolbar button representing the region type you would like to create:  

   (OMR, Input, Barcode). 

The mouse turns to a crosshair when defining an OMR region. For Input and Barcode 

regions, the Region Properties window appears immediately. 

2 If defining an OMR region, drag a box through the area representing the positioning 

of your region in the page representation area. For example, if you are creating an 

OMR region that starts in column three and at timing mark five, and contains ten 

rows and five columns, you would place the crosshair at column three and row five 

and then drag the box ten rows and five columns. If you make a mistake when 

dragging the box, you can make corrections in the Region Properties window. 
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The Region Properties window appears. The next few sections outline each of the 

possible region types and their properties. 

5.2.5 OMR (Optical Mark Recognition) Regions  

An OMR region is an area on the form containing OMR bubbles, checkboxes, or some 

other complete shape. The respondent darkens the marks that correspond with his or 

her answer choice. Each OMR region contains a specific number of rows and columns. A 

single OMR region can contain one or more questions. When an OMR region is created, 

you must specify certain properties pertaining to the region, including the size of the 

region, the type of region and what output Remark Classic OMR should generate. These 

topics are covered in the following sections. 

5.2.5.a OMR Region Types 

There are six types of OMR regions. The following section describes each type in full 

detail, and includes examples of each style. The examples include the region as it looks 

on the printed form as well as how a selected response might appear in the data grid 

when you are processing forms. 

 

Multiple Region: A Multiple region designation is used for multiple-choice style 

questions. These questions can allow a single response or multiple responses. One 

Multiple region may contain more than one question. 

 

Example 1: 

 

 Form:           Data Output: 

Gender  Gender 

    Female 

    Male 

 Female 

  

Example 2: 

  

       Form:           Data Output: 

     Question1 Question2 Question3 

Question 1     A B C 

Question 2    

Question 3    

 

Grid Region: A Grid region designation is used for questions where the output from the 

rows and columns represents one piece of data. The respondent typically fills in several 

bubbles that make up one response (e.g., student ID numbers, names, social security 

numbers). 

Example: 
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      Form: 

      Identification Number 

0 1 2 3 4 5 6 

 




















Data Output:

Id Number 

0123456 

 

List Region: A List region designation is used for regions that contain multiple choice 

style questions, but the response bubbles are not contained in a single row or column. 

Each bubble has a unique output value. 

 

Example: 

 

Form: 

What is your middle initial? 

 







  

Data Output: 

Middle Initial 

L 

 

Add Region: An Add region designates a region where the values of all of the chosen 

OMR bubbles are added together to produce one value. You can assign individual values 

to each answer choice (or mark on the form). 

 

 

 



Remark Classic OMR User’s Guide 

44 

Example 1: 

For this example, you could add each of the scale values chosen to make up one total 

response: 

 

Form: 

Please answer the following questions honestly using the scale provided: 

      Unhappy     Happy 

      1 2 3 4 5 

 

How do you feel today?  O  O O O 

How did you feel yesterday?  O  O O O 

How did you feel last week?  O O  O O 

Data Output (2+2+3): 

Feelings 

7 

 

Example 2: 

In this example, you could assign a 1 to each positive response and a –1 to each 

negative response and Remark Classic OMR would output a total: 

 

Form: 

Mark the characteristics that you think apply to you: 

(+1) (-1) 

 

       happy most of the time O       unhappy most of the time 

O       laid back        tense 

O       fun        boring 

       intelligent O       unintelligent 

       exceptional O       average 

 

Data Output (1+1+1-1-1):  

Characteristics 

1 

 

Boolean Region: A Boolean region designation is used when you want a user-defined 

value (e.g., Yes) to be output if an answer choice is selected and another user-defined 

value (e.g., No) for answer choices that are not selected. Each response is output to a 

separate cell in the data grid during form processing. In comparison, when you use the 

Multiple or List region types for questions that allow multiple responses, Remark Classic 

OMR places the data in a single cell, delimited by commas. The Boolean region type is 

useful for questions that allow multiple responses but for which you need the data in 

separate cells. For example, the Boolean region type can be used when you are 

exporting data to programs such as the legacy SPSS format that cannot handle multiple 
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responses that are delimited by a comma. (The regular SPSS format does not require 

multiple responses to be output as Boolean regions.) 

 

Example: 

 

Form: 

In which of the following activities do you participate (mark all that apply)? 

 

O Athletics (collegiate)   

 Athletics (intramural)  

O  Chess Team    

 Debate Team    

O Marching Band   

  

Data Output: 

Activity1 Activity2 Activity3 Activity4 Activity5 

No Yes No Yes No 

 

Binary Region: A Binary region designation is used when you want a pre-defined value 

(1) to be output if an answer choice is selected and another pre-defined value (0) for 

answer choices that are not selected. Binary regions output all responses to one cell. 

Using the previous example you would have the following: 

 

Example: 

 

Form: 

In which of the following activities do you participate (mark all that apply)? 

 

O Athletics (collegiate)   

 Athletics (intramural)  

O  Chess Team    

 Debate Team    

O Marching Band   

 

Data Output: 

Activities 

01010 
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5.2.5.b Region Orientation 

The region orientation property determines how the region is laid out: by column or by 

row. 

Column: Regions oriented by column contain questions that are positioned on the form 

in columns when the sheet is viewed in portrait position with the timing marks on the 

left. 

 

Example: 

 









 

Row: Regions oriented by row contain questions that are positioned on the form in rows 

when the sheet is viewed in portrait position. 

 

Example: 







5.2.6 Defining the OMR Region 

Once you have inserted an OMR region, the OMR Region Properties window appears. The 

following table contains a brief summary of the OMR Region properties. Further details 

on Region Types and Region Orientation are contained in the sections that follow. 

 

Property Function 

Region Name A name assigned to an OMR region. Region names are used as grid 

column headers in the data grid window and are exported when 

saving data to common file formats. Region names are limited to 

60 characters. 
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Property Function 

Type The type of OMR region being described. Region types include: 

Multiple- indicates a region containing multiple-choice questions. 

Grid- indicates a grid or matrix of marks (bubble, checkbox) that 

equates to a single piece of data (e.g., student ID number). 

List- indicates a region where each mark is assigned a unique 

output value, but the marks are not contained in a single row or 

column (e.g., a list of answer choices). 

Add- indicates a region where the values for each of the answers 

that are filled by the respondent are added together to produce a 

single value for numeric data, or concatenated together for textual 

data. 

Boolean- indicates a region where a user-defined value (e.g., Yes) 

is output for filled responses and another value (e.g., No) is output 

for non-filled responses. Boolean regions output one piece of data 

for each mark (answer choice) in the region. 

Binary- indicates a region where a value of 1 is output for filled 

responses and a value 0 is output for non-filled responses. Binary 

regions output a string of responses (1s and 0s) to a single cell. 

Orientation Sets the orientation of the region in terms of columns and rows: 

Column- the region contains questions that are oriented by 

columns. 

Row- the region contains questions that are oriented by rows. 

Start Column Sets the first column number in the region. Columns correspond to 

the column number on the paper form (1-48). 

Number of 

Columns 

Sets the number of columns contained in the region. 

Column Gap Sets the distance between columns of bubbles in the region. If 

bubbles are right next to each other, this number is typically 1. If 

there is a one bubble gap between bubbles, the column gap is 

typically 2 (or -2 if working on the backside of the form). 

Start Row Sets the first row number in the region. Rows correspond to the 

timing marks on the left side of the form. For example, if the first 

bubble in the region corresponds with the fifth timing mark, the 

start row is 5. 

Number of 

Rows 

Sets the number of rows contained in the region. 

Row Gap Sets the distance between rows of bubbles in the region. If 

bubbles are right above one another, this number is typically 1. If 

there is a timing mark gap between rows of bubbles, the row gap 

is typically 2 (or -2 if working on the backside of the form). 

Data Type Sets whether the data should be considered text or numeric when 

saved/exported. 
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Property Function 

Possible label 

scales 

Sets a range of pre-determined values as output Labels (e.g., A-E 

or 1-5). Use this setting to quickly enter Labels into the Labels grid 

as opposed to entering each Label individually. Each mark on your 

form is represented by a Label. The Label is the output when the 

form is scanned. Note that only label scales corresponding to the 

number of answer choices you have selected appear in this list.  

Labels Sets the output data that appears in the data grid when reading 

forms. Each mark on your form is represented by a Label. The 

Label is the output when the form is scanned. You cannot use the 

following reserved characters in the list of Labels: commas, 

quotation marks, semicolons or parentheses. Enter labels carefully 

because once you have processed data, you cannot change your 

labels without reprocessing your forms. 

Value Use this setting to associate a numeric value with each textual 

answer choice (Label). Values are used for calculating statistics for 

responses that are set to the textual data type. Values are also 

used when saving to the SPSS file format. Note that values are 

not used as point values when grading tests. You cannot assign 

partial credit to individual answer choices when performing test 

grading. 

Possible value 

scales 

Sets a range of pre-determined numbers as Values. Use this 

setting to quickly enter Values for each of your textual output 

Labels into the Values grid as opposed to entering each Value 

individually. 

Scale Sets a range of user-defined values as Labels that you can save 

and use over again (e.g., Excellent, Good, Fair, Poor). Click Edit to 

edit an existing scale. Or, enter a scale in the Label Range box or 

Labels grid and click Add to add the scale to your list of reusable 

scales. 

Define Format The Define Format feature applies to Grid OMR regions only. 

Mark this checkbox to enter a pattern for the data that is output 

during form processing. The default setting (*) indicates that the 

characters are displayed one after the other with no separators. 

The * is a placeholder for your data. You may change this pattern 

to enter items such as slashes for a date, decimal points, etc. 

Enter the appropriate character in the proper position (e.g., for a 

date: **/**/****). 
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To create an OMR region 

1 From the Sheet or Region menu choose 

Insert After or Insert Before and then click 

Region, or click . 

2 Use the mouse to drag a box around the marks 

in the region in the page representation 

section. If you accidentally select the wrong 

number of marks, you can correct it within the 

properties window that appears next. 

3 In the OMR Region Properties box, enter the 

appropriate properties for the region based on 

the table provide on the previous page. When 

entering labels, remember that this is the 

output in your data file. Ensure the labels are 

entered carefully. 

4 Click the Advanced button if you would like to 

use any advanced region options. See Section 5.3 for detailed 

descriptions of the advanced features. 

5 Click the OK button. 

After creating an OMR region, you see the region in the page 

representation area and a new node is added to the tree view. Each 

OMR region in the page representation area is shaded in gray or 

yellow to differentiate the regions. A selected region is outlined in 

red. 

5.2.7 Linking OMR Regions 

Marks that have a disproportionate number of columns and rows or column/row gaps 

cannot be selected in one region definition. The Add Linked Region function allows you 

to link these types of marks into one OMR region. OMR Region types that can be linked 

include Multiple, Grid, List, Binary and Add. The following is an example of a region that 

falls into this category: 

 

O   A O   D O   F 

O   B O   E O   G 

O   C 

 

Each column contains varying numbers of bubbles. You can link the columns together 

using the Add Linked Region option. Once linked, the software treats the bubbles as one 

question. 

 

To use the add linked region function 

1 Create an OMR region for the first set of marks (OMR bubbles) to be linked as if they 

were their own region (in the previous example, you would select the first column of 

marks for “A-C”). 

2 After defining the first part of the region, select the Region menu and then click Add 

Link, or click . Alternatively, you can right click the item in the tree view and 

choose Add Link. 
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The mouse turns into a crosshair. 

3 Drag a box covering the second set of marks to be defined (in the previous example, 

you would select the second column of marks for “D-E”).  

When you release the mouse button the OMR Region Properties window appears. This 

window contains the same settings that were defined for the first part of the region that 

you selected. You need only define the Labels and Values (if desired) section of the 

window.  

4 Make any necessary changes to the region definition and then click the OK button. 

5 Continue using Add Link until all marks in the region are defined. 

Regions that are defined with the Add Link 

function are automatically linked to the 

previous region. These regions are colored blue 

in the page representation window.  

To view or change the properties of all regions 

included in a linked region, you can select all of 

the nodes representing the linked region, right 

click the mouse and then click Properties. The 

Properties are for the region as a whole (all of 

the linked regions). To make certain changes to 

a region that is already linked, you need to first 

separate the regions, make the changes and 

then relink the regions. 

 

To separate a linked region 

1 Use the tree view or page representation area to select one of the OMR boxes within 

the linked set you want to separate. 

2 Select the Region menu and then click Unlink, or click . 

The regions are separated into individual OMR regions. If you need to make changes to 

the regions, edit the regions and then relink them. 

 

To relink regions 

1 While holding down the Shift key, select each OMR region to be linked by either 

clicking its node or clicking it in the page representation area.  

2 After all regions are highlighted, select the Region menu and then click Link, or 

click . Note that regions must be of the same OMR Type and Data Type to be 

linked. 

5.2.8 Creating an Input Region 

Input regions reserve space in the data grid for the manual insertion of text during or 

after scanning. Use Input regions to capture handwritten information (e.g., a person’s 

name). You can manually type the information contained in the Input region into the 

data grid.  

An input region has the following properties: 
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Property Function 

Region Name A name assigned to an Input region. Region names are used as grid 

column headers in the data grid window and are exported when 

saving data to common file formats. Region names are limited to 60 

characters. 

Default Fill Sets a default entry to be used in the Input region. The information 

typed here is automatically output to the data grid when forms are 

scanned.  You may optionally use the Auto Increment option if 

entering a numeric value. The data is incremented by one as each 

form is scanned. 

Data Type Sets whether the data should be considered text or numeric when 

saved/exported. 

 

To create an input region 

1 From the Sheet or Region menu, click Insert Before or Insert After, then choose 

Input, or click .   

2 In the Input Region Properties box, enter 

the appropriate properties for the region 

based on the information in the previous 

table.  

3 Click the Advanced button if you would like 

to use any advanced region options. See 

Section 5.3 for detailed descriptions of the 

advanced features. 

4 Click the OK button. 

After creating an Input region, a new node is added to the tree view. Input regions are 

not visible in the page representation area. 

5.2.9 Barcode Regions 

Remark Classic OMR can capture data from barcodes on your forms. In order to use 

barcodes, your OMR scanner must include a supported barcode reader. You must set the 

barcode guides on the barcode reader component of the OMR scanner so that they begin 

with the column containing the barcode. Remark Classic OMR then reads the barcodes 

that are in that column. Barcodes must be oriented vertically on the form. Consult your 

OMR scanner’s documentation for specific information about the barcode reader function 

on your OMR scanner and any limitations on how many barcodes you may place on one 

form. 

Note: Most barcode readers allow for a certain number of barcodes per 
column. Check your OMR scanner’s specifications for this information.  

Barcodes are often placed on forms using stickers. Remark Classic OMR cannot 

determine how many barcode stickers are on a form and whether barcodes are missing. 

Therefore, if you are in this situation, it is advisable to create a barcode that reads 

“blank” and use it as a placeholder for the missing barcode. For example, suppose you 

are anticipating having five barcodes on your form. However, on some forms there are 

only four barcodes. Suppose the four barcodes are in positions 1, 2, 3 and 5 (the space 

allocated for the 4th barcode is not used). On the affected forms, put a barcode that 

reads “blank” in the space occupied by the 4th barcode. Otherwise, Remark Classic OMR 
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will read the 5th barcode as the 4th barcode. By having the “blank” barcode, you can 

easily discern which barcode was missing. 

Barcode regions have the following properties: 

 

Property Function 

Region Name A name assigned to a barcode region. Region names are used as 

grid column headers in the data grid window and are exported 

when saving data to common file formats. Region names are 

limited to 60 characters. 

Data Type Sets whether the data should be considered text or numeric when 

saved/exported. 

Barcode 

Orientation 

Barcodes are oriented vertically on OMR forms. This property is not 

changeable by the user.  

Measurement Sets the number of millimeters from the leading edge of the form to 

the leading edge of the barcode (used for Sekonic OMR scanners 

only). 

 

To create a barcode region 

1 From the Sheet or Region menu, click Insert 

Before or Insert After, then choose Barcode, 

or click .   

2 In the Barcode Region Properties box, enter 

the appropriate properties for the region based 

on the information in the previous table. 

3 Click the Advanced button if you would like to 

use any advanced region options. See Section 

5.3 for detailed descriptions of the advanced 

features. 

4 Click the OK button. 

After creating a Barcode region, a new node is 

added to the tree view. Barcode regions are not visible in the page representation area. 

5.3 Advanced Region Properties and Features 

Each region type (OMR, Input and Barcode) has a set of more advanced features 

associated with it that are optional. When creating regions, you see only those options 

appropriate for the type of region you are creating. You can access the advanced 

features by clicking the Advanced button in the Region Properties window. 

Each advanced feature is explained in detail in the following sections. 
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5.3.1 Advanced Properties: General: Include Region in Read 

Operation 

Remark Classic OMR allows you to set whether to read a region that has been defined. 

Most of the time, you want to read each region you define, thus this property is on by 

default. However, there may be an occasion where 

you wish to turn off recognition of a particular 

region for your application. You can deselect the 

Read region checkbox to exclude data from this 

region when processing forms. If this checkbox is 

not marked the region exists in the form template, 

but no data is captured during form processing. 

This checkbox is on by default. 

 

To include a region in the read operation 

1 Create a region as defined in Section 5.2.4. 

2 From the Properties window, click the 

Advanced button. 

3 Mark the checkbox for Include region in read 

operation. 

4 Click the OK button twice to save the changes 

and return to the tree view. 

5.3.2 Advanced Properties: General: Required Region 

Remark Classic OMR allows you to make items required to be filled during scanning. If 

an item is marked as required in the form 

template and you are using the Review Exceptions 

feature, Remark Office OMR flags any items that 

are left blank. If you are using Review Exceptions 

during scanning, the scanning stops so that you 

may review the unrecognized item. If you are 

using Review Exceptions after scanning, Remark 

Office OMR includes the unrecognized item during 

the review operation. 

 

To set an item as required 

1 Create a region as defined in Section 5.2.4. 

2 From the Properties window, click the 

Advanced button. 

3 Mark the checkbox for Required item. 

4 Click the OK button twice to save the changes 

and return to the tree view. 

5.3.3 Advanced Properties: General: Question Text and Region 

Names 

The Question text and names section of the Question Properties window allows you to 

enter custom question text and question names. Question text is displayed on reports 

and exported to certain formats, such as SPSS. Question names are used as column 
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headers in the template grid and are exported along with your data. Question names are 

limited to 60 characters. 

5.3.3.a Question Text 

Question text may optionally be added to make reports more meaningful. When 

question text is present, it is used on the reports to identify the question. If no question 

text is entered, the region names are used on the reports.  

You may manually type question text into the question text grid or paste text from the 

Windows clipboard by using the keyboard shortcut, Ctrl + V, or by double clicking a cell, 

then right clicking and choosing Paste from the menu. In order to paste information, you 

must first copy it from another location (e.g., a Word document). You may select 

multiple rows in the grid to paste multiple lines of question text. 

 

To enter question text for a new region 

1 Create a region as defined in Section 5.2.4.  

2 From the Properties window, click the 

Advanced button. 

3 Click in the first grid cell under Question Text.   

4 Type the desired question text in the first grid 

cell. Alternatively, double click in a cell, then 

right click and select Paste from the menu or 

press Ctrl + V on the keyboard to paste the 

contents of your Windows clipboard into the cell. 

5 Press the Enter key on the keyboard or click in 

the next cell going down to continue adding 

question text (only applies to regions with more 

than one question). 

6 Once you have entered all of the desired 

question text, click the OK button twice to save 

the changes and return to the tree view. 

The question text is stored with the template file and is visible on select reports in 

Remark Quick Stats. 

5.3.2.b Question Names 

When defining an OMR region with multiple questions in the same region, you can 

specify individual question names for each question in the region. By using individual 

question names, it is easier to save data to existing databases and other file types that 

may already be set up with specific fields.  

By default, Remark Classic OMR uses sequential region names for each question in the 

same region. Sequential region names consist of adding numbers sequentially onto the 

region name you provide in the OMR Region Properties window. For example, if you 

enter a region name of Question, Remark Classic OMR calls the individual question 

names within the region Question1, Question2, Question3, etc. 

In contrast, if you use the Question Names section of the Advanced window to enter 

individual question names, you are able to customize the question name for each 

question within the region. Question names are limited to 60 characters each. 

Tip: The following characters are not allowed in region/question names due 
to the problems they could cause when exporting data to certain formats: 
. - Period 
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! - Exclamation 
' - Singe quote 
[ - Left bracket 
] - Right bracket 
, - Comma 
" - Double quote    
( - Left paren 
) - Right paren 

  

To insert individual question names 

1 Create a region as defined in Section 5.2.4. 

2 From the Properties window, click the 

Advanced button. 

3 Deselect the Use default region names 

checkbox at the bottom of the window. 

4 Click in the first grid cell under Question 

Names. 

5 Type the desired question name in the first grid 

cell. Alternatively, double click in a cell, then 

right click and select Paste from the menu or 

press Ctrl + V on the keyboard to paste the 

contents of your Windows clipboard into the cell. 

6 Press the Enter key on the keyboard or click in 

the next cell going down to continue adding 

question names (only applies to regions with 

more than one question). 

7 Once you have entered all of the desired 

question names, click the OK button twice to 

save the changes and return to the tree view. 

The question names are stored with the template file and are visible on select reports in 

Remark Quick Stats. 

5.3.4 Advanced Properties: Analysis: Test Settings 

Remark Classic OMR provides useful test grading features that you can customize. You 

decide which regions to grade and set the test points to be used for grading. 

The following table lists the region types and their default grade settings: 

 

Region 

Type 

Grade Status Test Type 

(Objective or 

Subjective) 

Test Points 

OMR  Multiple, Boolean and 

List: Graded  

 

Grid, Add and Binary: 

Not Graded  

Objective 

 

 

N/A 

Correct: 1 

Incorrect: 0 

No Response: 0 

Input Not Graded  N/A N/A 

Barcode Not Graded  N/A N/A 
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Questions can be designated as Objective or Subjective questions. An objective question 

is one where respondents choose one or more pre-defined answers on a form by 

darkening in a mark (e.g., bubble). These questions are typically multiple choice or 

true/false questions. A subjective question is one that is open ended and must be 

graded by a human, such as an essay or short answer question. Remark Classic OMR 

cannot automatically read this type of question; however, you can include points from a 

subjective question when grading. First, place a region on the form where the instructor 

can enter the appropriate amount of points earned on the subjective portion of the test. 

This is typically an OMR region where the instructor bubbles in the points earned. Then 

designate the region as a subjective item in the form template. This region must be set 

to the numeric data type in order to use the region as a subjective region. When setting 

up your answer key, enter the maximum number of subjective points that can be earned 

(see the Remark Quick Stats User’s Guide PDF file under Start|Programs|Remark Classic 

OMR 4|Documentation for further details about setting up answer keys). When grading, 

Remark Classic OMR displays the overall, objective and subjective scores. 

Extra credit is available in the Region item properties using the All points awarded 

should be treated as extra credit checkbox. This feature allows you to use Easy 

Grade to grade the tests and still designate a question as extra credit. When this 

checkbox is selected, any points awarded for the question are added to the total score 

(therefore it may be possible to score greater than 100%). 

 

To set grade options 

1 Create a region as defined in Section 5.2.4. 

2 From the Properties window, click the Advanced button. 

3 Click the Analysis tab. 

4 In the Test Settings section, mark the radio button for Grade this item.  

Note: If grading tests and using multiple answer keys, there is a third 
option for Designate as key identifier. Use this option when creating a 
region that contains the test answer key version information. For example, if 
you distribute three versions of the test – A, B, C- you can use the 
Designate as key identifier property on the region that contains the 
particular test’s test version (A, B or C). Remark Quick Stats can then use 
the region to sort the tests into their respective groups so that they are 
properly graded. 

5 In the Testing Point System section, select 

the type of question: Objective item or 

Subjective item.  

6 If using an Objective item, enter the values 

for Correct points, Incorrect points and No 

Response points that are appropriate for the 

region. You may use a negative number to 

subtract points for incorrect or unanswered 

questions if desired. You may also use decimal 

places. 

Note: A single question can have multiple 
correct responses, which you can designate 
when scanning the answer key or using the 
Grade Wizard. However, you cannot utilize 
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partial credit on a per response basis (e.g., a=1 point, b=2 points, c=3 
points, etc.). 

7 If desired, mark the All points awarded should be treated as extra credit 

checkbox to mark the question as extra credit. (Note: you can also mark regions as 

extra credit in the Grade Wizard when grading.) 

8 Click the OK button twice to save the changes and return to the tree view. 

When grading tests using Easy Grade, the properties set in this window apply. They can 

be changed on the fly using the Grade Wizard. 

5.3.5 Advanced Properties: Analysis: Survey Settings 

Remark Classic OMR provides useful survey tabulation features that you can customize. 

You decide which regions to tabulate.  

The following table lists the region types and their default survey settings: 

 

Region Type Survey Status 

OMR  Multiple, Boolean and List: Tabulated  

Grid, Add and Binary: Not Tabulated  

Input Not Tabulated  

Barcode Not Tabulated  

 

To set survey options 

1 Create a region as defined in Section 5.2.4. 

2 From the Properties window, click the 

Advanced button.  

3 Click the Analysis tab. 

4 In the Survey Settings section, mark the 

option button for Tabulate this item. 

5 Click the OK button twice to save the changes 

and return to the tree view. 

When tabulating surveys using Easy Survey, the 

properties set in this window apply. They can be 

changed on the fly using the Survey Wizard. 

5.3.6 Advanced Properties: Analysis: 

Analysis Respondent ID 

You may also set a particular region as an Analysis Respondent ID region so that it can 

be used as an identifier on reports. This feature is useful when you are capturing items 

such as ID numbers or names. When set as an Analysis Respondent ID region, the 

resulting reports show the information captured in the region alongside of the results. 

For example, if you administer a test where the students enter their ID number, the 

grade report shows the ID number and then that student’s grade. When exporting data 

to some gradebook packages, you may also be required to set an Analysis Respondent 

ID.  
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Note: Analysis Respondent IDs are included as identifiers in the analysis, 
but they are not tabulated or graded. In 
order to set a region as an Analysis 
Respondent ID, make sure it is set to Do not 
grade this item and Do not tabulate this 
item.  

 

To set an Analysis Respondent ID 

1 Create a region as defined in Section 5.2.5.  

2 From the Properties window, click the 

Advanced button.  

3 Click the Analysis tab. 

4 In the Analysis Respondent ID section, mark 

the checkbox for Designate as a respondent 

ID. 

5 Click the OK button twice to save the changes 

and return to the tree view. 

5.3.7 Advanced Properties: Blank 

Responses 

You can specify how Remark Classic OMR should handle blank responses in OMR regions 

when processing forms and exporting data. The default setting for blank responses is to 

insert the word BLANK for items that are not answered. Yellow color coding is also 

applied to the data grid, making the blank exceptions easier to locate. You can replace 

the blank values on a region-by-region basis. You may choose one of the default options 

listed or type in a custom value. 

 

To set blank response settings 

1 Create a region as defined in Section 5.2.4. 

2 From the Properties window, click the 

Advanced button. 

3 Click the Blank/Multiple Exceptions tab. 

4 In the Blank Exception Handling section, 

choose a value from the Replace with drop-

down list or enter a unique replacement of your 

own. Pre-set choices include BLANK, Asterisk 

(*), Nothing, Space Character, Tilde (~), 

and VOID. 

4 You may optionally use the Flag Blanks setting 

to further refine how blank responses are 

handled for Grid regions. Using this setting 

allows you to further customize how Remark 

Classic OMR interprets blank responses. Grid 

regions are often used to capture data that vary 

in length, which can lead to unintended blank 

responses. For example, you may have respondents fill in bubbles corresponding to 

their name and allow for ten characters. If a name only contains five characters, the 

region may come up as blank simply because the respondent did not utilize all ten 

characters. Or you may have questions that are often left blank due to the nature of 
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the question (e.g., it will not apply to many respondents). In such a case, you can 

replace blank characters with Nothing and use the Flag Blanks parameters to 

further define the output. The options are as follows: 

 

Option Description 

Always If any character in the region is left blank, or the entire 

question is left blank, regardless of the replacement characters 

being used, the region is considered blank. Replacement 

characters, if used, are still utilized, but the region contains the 

yellow BLANK exception color. 

Ignore 

leading/trailing 

If a leading or trailing character in the region is left blank, it is 

ignored. This allows you to capture data smaller than the 

allotted region without it being considered blank. You will see 

whatever data is captured and the region will not contain a 

yellow BLANK exception color. This setting applies to Grid 

regions only. 

Never  If any character within the region is blank, or the entire 

question is left blank, Remark Classic OMR ignores it. The 

region never appears with a yellow BLANK exception color in 

the data grid. 

Ignore Leading If a leading character in the region is left blank, it is ignored. 

This allows you to capture data smaller than the allotted region 

without it being considered blank. You will see whatever data is 

captured and the region will not contain a yellow BLANK 

exception color. This setting applies to Grid regions only. 

Ignore Trailing If a trailing character in the region is left blank, it is ignored. 

This allows you to capture data smaller than the allotted region 

without it being considered blank. You will see whatever data is 

captured and the region will not contain a yellow BLANK 

exception color. This setting applies to Grid regions only. 

 

5 Click the OK button twice to save the changes and return to the tree view. 

5.3.8 Advanced Properties: Multiple Responses 

You can specify how Remark Classic OMR should handle blank and multiple responses in 

OMR regions when processing forms and exporting data. The default setting for multiple 

responses is to show all responses but flag the data grid cells green when more than one 

response is chosen and not permitted. Also by default, only one answer response is 

allowed. You can replace the multiple values on a region-by-region basis. You may 

choose one of the default options listed or type in a custom value. 

Note: In previous versions of Remark Classic OMR, the word MULT was 
output when multiple responses were found and not permitted. If you were 
using a previous version of Remark Classic OMR, any form templates that 
you convert still have the previous default replacement of MULT. If you 
would like to change old form templates to use the new ALL functionality, 
open the form template in the Template Editor and change the Replace 
with setting under Region item properties. Note that any new form 
templates you create use the ALL option by default. 
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To set multiple response settings 

1 Create a region as defined in Section 5.2.4. 

2 From the Properties window, click the Advanced button. 

3 Click the Blank/Multiple Exceptions tab. 

4 In the Multiple Response Handling section, optionally mark the Select most 

filled response checkbox. Selecting this option forces Remark Classic OMR to select 

the mark it thinks is the most filled when more than one mark is detected. We do not 

recommend turning on this setting for most applications. 

Tip: Use extreme caution when using the Select most filled option. Using 
this option means that Remark Classic OMR never returns a multiple 
exception for you to review. The software always chooses what it thinks is 
the most filled mark. 

5 Optionally, decide whether you want to allow 

multiple responses (not allowed by default). 

To allow more than one response, mark the 

checkbox for Limit the number of multiple 

responses permitted to. Then use the box 

next to it to select the number allowed. You 

can type a number or use the up and down 

arrows to choose a number. If a respondent 

chooses more responses than allowed, the 

text entered in the Replace with box is used 

to signify a multiple response. 

6 In the Replace with box, choose a value 

from the drop-down list or enter a unique 

replacement of your own. Pre-set choices 

include ALL, MULT, Asterisk (*), Nothing, 

Space Character, and Tilde (~). If you 

choose the ALL option (this is the default 

setting), all chosen responses are displayed 

in the data grid, but it is still flagged green 

for review. Having all the responses 

expedites the cleanup process and allows you to easily change your mind about 

allowing multiple responses after processing forms. 

Note: If you were using a previous version of Remark Classic OMR, any 
form templates that you convert still have the previous default replacement 
of MULT. If you would like to change old form templates to use the new 
ALL functionality, open the form template in the Template Editor and 
change the Replace with setting under Region item properties. Note 
that any new form templates you create use the ALL option by default. 

7 Click the OK button twice to save the changes and return to the tree view. 

5.3.9 Advanced Properties: Respondent Trackers 

Respondent Trackers, or lithocodes, can be used during scanning to place all of one 

respondent’s data together in a single data record. You designate a unique OMR or 

barcode region in the form template as your respondent tracker. Then, along with page 

ID marks, Remark Classic OMR matches data from the sheets scanned to their 



 Using the Template Editor   

 61 

appropriate data records. Respondent trackers can only be used on multi-sheet forms 

and must be used with page ID marks. 

Setting up a respondent tracker has two parts. The first part is to tell Remark Classic 

OMR that you are using a respondent tracker in the form template properties. This step 

is covered in Section 5.2.3. Once you have told the software you are using a respondent 

tracker, and entered information about the respondent tracker region’s properties, the 

region is created automatically for you. You have successfully set up a respondent 

tracker at this point. If you need to modify the respondent tracker, you may use the 

instructions below. 

 

To modify a respondent tracker 

1 When setting up the form template, ensure you 

have entered the appropriate page IDs and 

respondent tracker information (see Section 

5.2.3). 

2 The respondent tracker region is created 

automatically for you. If you need to make 

changes to the field, continue. Otherwise, you 

have set up the respondent tracker field. 

3 Open the properties for the Respondent tracker 

region. 

4 If you need to make any modifications to the 

region’s set up, do so in this window. 

5 From the Properties window, click the 

Advanced button. 

6 Click the Respondent tracker tab. Use the Set 

as a respondent tracker (lithocode) region 

checkbox to turn on or off respondent tracking 

on this region.  

7 Click the OK button twice to return to the tree view. 

5.3.10 Advanced Properties: Database Lookup 

Remark Classic OMR has a Database Lookup feature that can: 1) verify that recognized 

data from a region appear in an external database, and 2) lookup and replace 

recognized data with additional regions from an external database. To use this feature, 

you link a region in the form template to an external database. As each form is scanned, 

Remark Classic OMR verifies that the recognized data appear in the selected database 

region. If the data are not present, Remark Classic OMR flags the question as a 

Database Lookup error for correction. Database Lookup can be used with OMR, Input 

and Barcode regions. 

This feature is useful for validating names, identification numbers, zip codes, etc. It is 

also useful for pulling information you have already collected out of a database and 

inserting it into your processed form data. When you set up a Database Lookup region, 

you tell the software what region to validate, and whether to replace the output with a 

region from the external database and/or append additional regions from the external 

database. 

For example, suppose you are grading tests and you have the students fill in their ID 

numbers on the forms being processed. You could verify the ID numbers in a database 

to ensure the right forms are being scanned, and then specify another value that 

corresponds to the ID number (e.g., a name). If the ID number is found in the database, 
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Remark Classic OMR automatically displays the corresponding value (student name in 

this case) for that ID number in the data. When you run your grade reports, they are 

produced with each student’s name, yet you did not have to type in that information (or 

have students bubble it in on the form).  

 

To use database lookup 

1 Create a region as defined in Section 5.2.4. 

2 From the Properties window, click the Advanced button. 

3 Click the Database tab.  

4 Mark the checkbox for Use Database Lookup. 

5 In the Database Selection area, use the Type drop-down list to select the type of 

database to which you want to connect this region (e.g., Access, Excel, etc.). 

6 Click the Browse… button to locate and select the database file. 

Note: You should not move the database or change the name once the link 
is established. Otherwise, the link is broken. Make sure the database is in its 
final format and location before linking it to the form template. 

7 Select a file and then click the Open button (or double click the file name). 

If using an ODBC connection, perform the Steps 8-10 (you need to obtain specific 

information from your database administrator to complete these steps). Otherwise, skip 

to Step 11. 

 

8 [OPTIONAL] Select your database type from the DSN drop-down list. 

9 [OPTIONAL] Select the appropriate checkbox to indicate whether your database is 

Directory or DSN based: Directory based or DSN based. 

10 [OPTIONAL] If your database utilizes password protection, use the Username and 

Password boxes to enter your login information. If the database is not password 

protected, you may skip this step. 

 

11 In the Lookup & Return section, click the Connect to Database button to link the 

database to the region. 

12 Use the Table drop-down list to select the table 

in the database containing the fields to which 

you are linking the region. 

13 Use the Lookup drop-down list to select a field 

in the connected database to which you want to 

link this region. When the forms are processed, 

the respondents’ answers are verified against 

the values in this database field. If the answer is 

found in the database field, Remark Classic OMR 

outputs the Replace value. If the answer is not 

found in the database field, Remark Classic OMR 

flags it for review. 

14 Use the Replace drop-down list to select a field 

in the connected database to return when the 

Lookup region is verified. If you only want to 

verify data and not replace it with anything else, 

use the same field in both the Lookup and 
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Replace lists. If you want to look up the value and then replace it with a different 

database field’s information, select the appropriate field in the Replace list. 

15 If desired, select database fields from the Additional Return Regions list to insert 

additional information from the database into the data grid during scanning. You may 

look up a field once but return several database fields’ worth of information. This is a 

quick and easy way to get information out of the existing database and into your 

scanned data. Regions are listed in the data grid in the order in which they appear in 

the Additional Return Fields list. 

16 If desired, use the Return Names column to specify region names for the return 

regions. By default, the name is taken from the external database to which the 

region is connected. You may type a new name in the Return Names cell if desired. 

17 Use the drop-down arrow to select Yes in the Respondent ID box to include the 

return region in the reports as a respondent identifier. If this setting is set to Yes, 

the data collected from this region is used on the appropriate reports to identify the 

respondent. 

18 Click the OK button twice to save the changes and return to the tree view. 

When you scan your filled in forms, Remark Classic OMR looks up the captured data in 

the database and if found, returns your Replace and Additional Return Field data. You 

can then filter report information based on these additional fields. 

5.4 Additional Template Editor Features 

The Remark Classic OMR Template Editor provides several other features and functions 

to help make it user friendly. The following features and/or functions are available: 

 Copy/paste 

 Drag/drop (reordering) 

 Delete 

 Undo/redo 

 Moving regions 

 Zoom  

 File properties 

All of these features can be accessed from the menus. Many also have toolbar buttons or 

can be accessed by right clicking the mouse on a node in the tree view. 

5.4.1 Copy/Paste 

When creating regions with similar attributes, using the Copy and Paste options can 

facilitate the form template creation process. You can copy regions on the same page or 

on different pages within the same form template. 

 

To copy and paste a region 

1 Activate the region(s) you want to copy by clicking within the region boundaries in 

the page representation area or clicking its node in the tree view. 

2 Select the Edit menu and then click Copy, click , right click the mouse and select 

Copy or press Ctrl+C on the keyboard. 

3 Highlight the node before or after where you would like the region copied. 
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4 Select the Edit menu and then click Paste Before (Ctrl+B) or Paste After 

(Ctrl+V) to place the copied node either before or after the selected node. 

Note: You may also use the toolbar button for Paste, , or right click and 
choose Paste to paste the region after the highlighted node. 

After pasting a region, the region appears in the page representation area of the 

Template Editor window over top of the original region. You then need to position the 

region correctly in the page representation area by dragging it with the mouse. 

5.4.2 Drag/Drop 

The drag/drop feature allows you to click a region in the tree view and drag it to another 

position within the tree. The order of the regions in the tree view determines the order 

of the regions in your data set. You may set the order of the regions on a page without 

regard to where the region is located on the page representation. When using drag/drop 

you can either move a node or copy a node. 

 

To move a node using drag/drop 

1 Select the node representing the region you would like to move. 

2 While holding down the left mouse button, drag the region to its new desired 

location. 

3 When you have reached the new location, release the mouse button. A dialog box 

appears, confirming whether you want to move the region to the new location. 

4 Click the OK button to move the node. 

Tip: You can press the Shift key on the keyboard as you drag a node to 
toggle between Move Before and Move After options. By pressing Shift, you 
can move a region before the selected region (otherwise, the region is 
placed after the selected region automatically). 

 

To copy a region using drag/drop 

1 Select the node representing the region you would like to copy. 

2 While holding down the left mouse button, drag the region to its new desired location 

and then press the Ctrl key while still holding down the left mouse button. 

3 When you have reached the new location, release the mouse button. A dialog box 

appears, confirming whether you want to copy the region to the new location. 

4 Click the OK button. 

After copying a region, the region appears in the page representation area of the 

Template Editor window. You then need to position the region correctly by dragging it 

with the mouse. 

5.4.3 Deleting Regions 

Use the Delete option to remove unwanted region definitions.  

 

To delete a region 

1 Activate the region you want to delete by clicking within the region boundaries or 

clicking its node in the tree view. 
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2 Select the Edit menu and then click Delete, click , right click the mouse and 

choose Delete or press Delete on the keyboard. You may also right click the region 

and choose Delete from the menu. 

5.4.4 Undo/Redo 

Remark Classic OMR employs Undo and Redo in the Template Editor. Using Undo 

negates the last action that was performed. Using Redo repeats the last action for which 

undo was used. 

 

To use undo  

1 Select the Edit menu and then click Undo, click , or press Ctrl+Z on the 

keyboard to negate the previous action. 

 

To use redo 

1 Select the Edit menu and then click Redo, click , or press Ctrl+Y on the 

keyboard to repeat the previous action. 

5.4.5 File Properties 

You may view the properties of a form template at any time by selecting the File menu 

and then clicking Properties. From this window you can review the form template 

information such as name, description, sheet information, timing marks, page IDs and 

respondent trackers. 

5.5 Saving a Form Template 

You may save a form template at any time. It is recommended that you save your form 

templates as you go in case you are interrupted. 

 

To save a form template 

1 Select the File menu and then click Save, or click , to save the region 

definitions.  

You may also use the Save As function to save the form template under a new name. 

2 In the Save As dialog box, enter a file name in the box titled File name.  

3 Choose a directory location in the box titled Save in. 

4 Click the Save button. 

Form templates can only be saved with a .rco file extension.  

5.6 Editing an Existing Form Template 

You can edit previously created form templates to add or delete pages or to make 

changes to the region definitions or page layout.  

Note: Changing the structure of a form template after processing a batch of 
forms can cause compatibility conflicts between the form template and 
previously saved data files. Changes to the number of questions, the 
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question order or the output labels will likely invalidate existing data files 
and Grade Wizard/Survey Wizard definition files. 

Form templates from previous versions of the software can be opened in the Remark 

Classic OMR 4 Template Editor. The software automatically converts older form 

templates to the new version. Form template files are not backward compatible. Once a 

form template has been converted to the new version, it cannot be opened in a previous 

version of the software. Always make copies of form templates before converting them. 

 

To edit a form template 

1 If not already running, start the Remark Classic OMR Template Editor program. 

2 Select the File menu and then click Open, or click . You may also use the 

Recent Files option under the File menu to open files. 

3 Select the form template you would like to edit. 

4 Click the Open button. 

The form template is displayed in the tree view, with the page representation area on 

the right. 

5 Double click within the boundaries of any region you want to edit, or double click the 

node representing the region in the tree view to display the Region Properties 

window.  

6 Make the desired changes to the region’s properties and then click the OK button. 

Note: For more information about region types see the Creating Form 
Templates section of this chapter. 

7 Save the form template when finished editing.  
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Scanning Forms 

Chapter 6 

6.1 Overview 

This chapter explains how to scan forms in the Remark Classic OMR Data Center. You 

should refer to your scanner’s documentation for instructions on installing and using the 

scanner. You scan forms directly from a scanner connected to the computer running 

Remark Classic OMR. Before scanning forms, ensure your OMR scanner is connected to 

the computer running Remark Classic OMR and is in working order (See Chapter 4.) 

The procedure for scanning forms varies based on the scanner you are using. The steps 

are separated in this user’s guide based on whether you are using an OMR scanner (no 

imaging) or an OMR/Image scanner (image-enabled). See Chapter 4 for a list of 

supported scanners and set up information. 

The following topics are covered: 

 Scanning forms with an OMR scanner (Section 6.2) 

 Scanning forms with an OMR/Image scanner (Section 6.3) 

 Batch processing (Section 6.4) 

 Overwriting data (Section 6.5) 

 The Image Viewer (Section 6.6) 

 Reviewing exceptions (Section 6.7) 

 Respondent detection (Section 6.8) 

 Reviewing duplicates (Section 6.9) 

 The Graph Viewer (Section 6.10) 

 The Test Import Wizard (Section 6.11) 

6.2 Scanning Forms with an OMR Scanner 

This section outlines how to scan forms using an OMR scanner, which is set up by 

clicking Tools|OMR Scanner|OMR Scanner Properties. OMR scanners do not use 

image capabilities. If you want to scan using imaging, please see Section 6.3.  

6.2.1 Opening a Form Template 

The Remark Classic OMR software requires a form template file for each unique form 

that you want to scan. This file defines all of the information needed for the software to 

read the form. Form templates are created in the Remark Classic OMR Template Editor, 

which is covered in Chapter 5 of this user’s guide. Once you have a form template for 

your form, it can be reused as often as needed (as long as the form does not change). 

Please note that for most standard forms, form templates are already installed with the 

software. These files can typically be located in C:\Program Files\Gravic\Remark Classic 

OMR 4\Templates\Scantron\OMR. You only need to create a form template for your form 

if one does not already exist. OMR form templates have a .rco extension. 
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Note: The OMR-Image folder contains form templates that are used with 
image-enabled scanners. If using an OMR Scanner without imaging, you 
should not use those templates. 

To begin the scanning process, open the form template file corresponding to your form 

in the Data Center. The Remark Classic OMR template grid window uses a spreadsheet 

style interface to display scanned data. Each grid column corresponds to an item or 

question on the form, as it was defined in the form template. If your form template 

contains multiple pages, each page is separated by a blue line. 

Important Note: Form templates from previous versions of the software 
can be opened in the Remark Classic OMR 4 software. Once they are opened 
in the new version, form templates are automatically converted. Form 
template files are upward compatible only. Once a form template has been 
converted to the new version, it cannot be opened in a previous version of 
the software. Always make copies of form templates from previous versions 
before converting them. 

 

To access the Data Center 

1 From the Windows Start menu, click Programs|Remark Classic OMR 4|Remark 

Classic OMR Data Center. 

You can see a Task Pane on the left and an empty grid on the right. This grid is where 

your form template is opened and forms are scanned. 

 

To select a form template 

1 Select the File menu and then click Open Form Template, or click , to display 

the Open form template window. Alternatively, select Open form template from 

the Task Pane. 

Note: Form template file names have a RCO file extension.  

Tip: You can access recently used form templates from the File menu or the 
Task Pane. 

2 Use the Look in drop-down list to locate files on your computer or network. Select 

the correct form template file by clicking its name. The default directory for form 

templates for OMR scanners is C:\Program Files\Gravic\Remark Classic OMR 

4\Templates\Scantron\OMR. 

3 Click the Open button to open the form template and display the corresponding data 

grid window. 

Once the form template is open, you may 

begin scanning forms. By default, when 

you open a form template, you see the 

data grid across the top of the screen and 

the Graph Viewer at the bottom of the data 

grid. The data grid is where you see the 

data as forms are processed. The Graph 

Viewer graphs the tabulation of a single 

question, as selected in a cell of the data 

grid. 
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6.2.2 The Remark Classic OMR Read Wizard for OMR Scanners 

Scanning forms is handled through the Remark Classic OMR Read Wizard. When 

scanning forms in the Remark Classic OMR Data Center, the software reads pages 

directly from an OMR scanner connected to the computer. Before attempting to read any 

pages from the scanner, turn on your scanner, ensure it is set up in Remark Classic OMR 

and open the form template that corresponds to your forms. (See Chapter 4 for 

information about setting up your scanner.)  

Note: The forms you wish to process must correspond to the selected form 
template.  

The Read Wizard uses the scanner you have selected as the default scanner. It’s 

possible to have a scanner set up as both an OMR Scanner and an OMR/Image Scanner. 

If this is the case, make sure you choose the one you want to use by default by clicking 

the Tools menu, selecting the desired scanner (OMR Scanner) and then clicking Set as 

Default Scanner. 

The Data Center places the recognized data in the open data grid. All data obtained from 

reading one form appear in a single grid row. Each column of the data grid corresponds 

to each variable (question) defined in the form template. 

Note: If you have not yet set up a scanner in Remark Classic OMR, select 
the Tools menu, click OMR Scanner and then click OMR Scanner 
Properties. Choose your scanner and any options installed on the scanner 
that you wish to utilize. The OMR Scanner Properties window is covered in 
detail in Chapter 4. 

 

To read pages from the scanner 

1 Open the correct form template. (See Section 6.2.1 Opening a Form Template.) 

2 Place the completed forms in the scanner. 

3 Select the Tools menu and then click Read Wizard, or click . 

Alternatively, you may select the Read Wizard link from the Task Pane. 

4 In the Welcome window, you see your scanner listed. Beneath the scanner are the 

options you have indicated are installed on your scanner in the Scanner Properties 

window. The following options may be available to you depending on your scanner’s 

capabilities: 

 

Option Description 

Duplex scanning 

enabled 

You may use this option if your OMR scanner has duplex 

capabilities, meaning it scans both sides of the sheet in one 

pass through the scanner. If scanning a single sided (simplex) 

form, you do not need to turn off duplex scanning. 

Grading/Scoring 

enabled 

You may use this option if your OMR scanner has grading 

capabilities built into the scanner. Grade-enabled scanners 

often print student scores on the forms as the forms are 

scanned (see your scanner manufacturer’s documentation for 

information about scoring scanners). 

Barcode reader 

enabled 

Mark this option if your OMR scanner has a barcode reader. 
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Option Description 

Printer enabled Mark this option if your OMR scanner has a printer. You can 

print certain items, such as score information and dates, on 

forms as they are scanned. 

Select stacker 

enabled 

Mark this option if your scanner has a select stacker (rejecter). 

When forms cannot be read, they are sent to the select stacker 

to be reviewed, without collecting data from them. 

 

Items with a checkmark in a green circle are available and enabled. Items with a 

dash in a red circle are not enabled. If 

you would like to change any of these 

options, click the Setup button 

(remember to click OK in the Scanner 

Properties window to return to the 

Read Wizard). (Note you may only 

enable items that are installed on your 

OMR scanner.)  

5 If your OMR scanner has a printer 

installed and you have indicated that you 

have a printer in the Scanner 

Properties window, you may optionally 

mark the checkbox for Activate Print 

Options. (Printer options are covered in more detail in Section 6.2.8) 

 Use the drop-down list to choose an item to print or enter free form text. Note 

that some scanners can print a limited amount of text. Therefore, all three drop-

down lists may not be enabled in order to ensure you do not select more text 

than can be printed with your OMR scanner. 

 Certain OMR scanners can print on the last two inches of the form only. In the 

Print position box, specify where to print the information on each sheet by 

entering a value of 0-27 for the start position (the number varies from scanner to 

scanner). 

6 [Optional] If your OMR scanner has a select stacker (rejecter) and you have it 

enabled, you may click the Next>> button to configure the Reject Exceptions. 

When the select stacker is enabled, forms that are not properly read are sent to the 

select stacker without any data being captured. You may review the forms, correct 

any problems and rescan them if desired. 

The reject options are covered in detail in 

Section 6.2.7. 

 In the Reject Exceptions window, 

specify whether to reject exception 

cases during the scanning process by 

marking the Activate Reject 

Exceptions checkbox.  

 In the Reject Exceptions Options 

area, mark the checkboxes for those 

cases that you wish to reject during 

scanning.  
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7 [Optional] If you would like to configure Review Exceptions options, click the 

Next>> button to continue. Otherwise click the Read button to begin scanning 

pages. 

Review Exceptions is a way to correct exception cases found on forms, such as blank 

and multiple responses (see Section 6.7 for further details about using this feature). 

When using Review Exceptions (as opposed to a select stacker), scanning stops but the 

pages are not sent to a select stacker. You are able to review the problems on the spot 

and make corrections, then continue scanning. 

 In the Review Exceptions window, specify whether to review exception cases 

during the scanning process by marking the Activate Review Exceptions 

checkbox.  

 In the Review Exceptions Options 

area, mark the checkboxes for those 

cases that you wish to review during 

scanning. The following options are 

available: Multiple responses, Blank 

responses, Input regions, 

Database lookup regions, Barcode 

regions, or Required items. 

Reviewing Exceptions during scanning 

causes the software to stop scanning 

when it encounters any exception 

cases you select. You can then make the appropriate adjustments and the 

scanning resumes. 

Note: Review Exceptions can also be run after all the forms are scanned if 
you prefer not to stop scanning when problems occur. 

8 Click the Read button to begin scanning pages. 

Note: If desired you can click the drop-down arrow on the Read button and 
choose Save or Save and Read. If you choose one of the save options, 
your Read Wizard settings are saved as an Automation Wizard file (.rcez). 
The Automation Wizard is used to automate form processing. Please see the 
Remark Classic OMR Automation Wizard User’s Guide.pdf file 
(Start|Programs|Remark Classic OMR 4|Documentation) included with your 
software for more information about the Automation Wizard. 

Remark Classic OMR continues scanning pages until the scanner’s sheetfeeder is empty.  

9 After processing all of the pages, you are prompted to continue scanning. Click Yes 

to scan more pages or No to end the scanning process.  

6.2.3 Scanning Using Default Settings with an OMR Scanner (Easy 

Scan) 

Once you have run the Read Wizard, you may optionally scan using default settings 

without running the Read Wizard each time. This method is called Easy Scan and 

scanning occurs using the last settings specified in the Read Wizard. 

Caution: Easy Scan is useful if you are using the same settings each time 
you scan. If you are uncertain about what settings exist, it is recommended 
that you run the Read Wizard to initiate scanning. 
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To use Easy Scan 

1 Open the correct form template. (See Section 6.2.1 Opening a Form Template.) 

2 Select the Tools menu and then click Easy Scan, or click the Easy Scan toolbar 

button . 

All pages in the scanner are scanned based on the last settings used in the Read Wizard. 

You then see a spreadsheet of data. Each row represents one complete form and each 

column represents each item (question) defined in the form template. 

6.2.4 Scanning Multiple Sheet Forms Without Page ID Marks Using 

an OMR Scanner 

Page ID marks are a pre-printed sequence of marks on an OMR form that when taken 

together produce a unique ID for the sheet. If you do not have page ID marks on your 

forms, Remark Classic OMR cannot discern whether the forms are being scanned in 

proper sheet order. You must read the forms in proper sheet order so that Remark 

Classic OMR can process the sheets correctly (e.g., sheet one, sheet two, sheet three, 

etc.). Follow the directions above for scanning forms, ensuring the forms are in the 

correct sequential order. 

6.2.5 Scanning Multiple Sheet Forms with Page ID Marks Using an 

OMR Scanner 

If you have page ID marks on a form, Remark Classic OMR uses the page ID marks to 

know whether the correct sheet of the form is being processed. If the sheets are out of 

order, they are flagged with an error message. The page ID marks act as a sheet 

identifier. When you create a form template with page ID marks, you specify the 

location of the marks on the form so that Remark Classic OMR can identify the various 

sheets of each form that is scanned. In order to recognize different sheets within one 

form, the sheets must have different page ID marks. If the page ID marks are identical 

from sheet to sheet, Remark Classic OMR is able to tell of you are scanning the correct 

form, but it is not able to differentiate sheets within that form. In addition, you must 

keep all of the sheets belonging to one respondent together, unless you are also using 

respondent trackers (see section 6.3.4 for information about respondent trackers). 

To read multiple sheet forms with page ID marks 

1 Open the correct form template. (See Section 6.2.1 Opening a Form Template.) 

2 Place the completed forms in the scanner. 

3 Select the Tools menu and then click Read Wizard, or click . 

Alternatively, you may select the Read Wizard link from the Task Pane. 

4 In the Welcome window, your scanner is listed. Beneath the scanner are the options 

you have indicated are installed on your scanner in the Scanner Properties 

window. If you would like to change any of these options, click the Setup button. 

5 [Optional] If your OMR scanner has a printer installed and you have indicated that 

you have a printer in the Scanner Properties window, you may optionally mark the 

checkbox for Activate Print Options. (See Section 6.2.8 for detailed information 

about printing.) 

6 [Optional] If your OMR scanner has a select stacker (rejecter) and you have it 

enabled, you may click the Next>> button to configure the Reject Exceptions. 

Otherwise click the Read button to begin scanning pages. When the select stacker is 

enabled, forms that are not properly read are sent to the select stacker without any 
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data being captured. You may review the forms, correct any problems and rescan 

them if desired. Please see Section 6.2.7 for detailed information about using a 

select stacker. 

7 [Optional] If you would like to configure Review Exceptions options, click the 

Next>> button to continue. Otherwise click the Read button to begin scanning 

pages. Review Exceptions is a way to correct exception cases found on forms, such 

as blank and multiple responses (see Section 6.7 Review Exceptions for further 

details about using this feature). 

Note: Review Exceptions can also be run after all the forms are scanned if 
you prefer not to stop scanning when problems occur. 

8 Click the Read button to begin scanning pages. 

Remark Classic OMR reads forms until it cannot interpret the page ID mark or until all 

pages in the scanner are scanned. The software alerts you to an incorrect sheet, at 

which time you have several options, depending on how you are set up. If using a select 

stacker and rejecting misordered pages and form 

read errors, any sheets that are scanned out of 

order are simply sent to the select stacker. Upon 

scanning completion, you can view a log of 

showing why sheets were rejected. If you are not 

using a select stacker, you receive a message that 

the sheet cannot be identified and when you click 

the OK button, you can decide whether to 

continue scanning. In either case, you 

can remove the sheet and replace it 

with the correct sheet and then click 

Yes. Or, you can remove the sheet 

and then move onto the next sheet by 

simply clicking Yes. To stop scanning 

all together, select No. To view the 

reject log, click View Log…. (The 

reject log can also be accessed any 

time by clicking Tools|View Reject 

Log). 

6.2.6 Reading Multiple Sheet Forms with Respondent Trackers 

Using an OMR Scanner 

Page ID marks alone act as sheet identifiers, but with the addition of respondent 

trackers (lithocodes), you can also keep respondents’ data together. A respondent 

tracker acts as a respondent ID and must be used in conjunction with page ID marks, 

which act as sheet identifiers, as explained in the previous section. If you have 

respondent trackers and page ID marks on your form, you can scan forms in any order 

and Remark Classic OMR is able to match sheets using the page ID marks and 

respondents to the appropriate record using the respondent trackers. Respondent 

trackers can be OMR or barcode regions. Setting up respondent trackers in your form 

template is covered in Chapter 5.  

 

1 Open the correct form template. (See Section 6.2.1 Opening a Form Template.) 

2 Place the completed forms in the scanner. 
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3 Select the Tools menu and then click Read Wizard, or click . 

Alternatively, you may select the Read Wizard link from the Task Pane. 

4 In the Welcome window, your scanner is listed. Beneath the scanner are the options 

you have indicated are installed on your scanner in the Scanner Properties 

window. If you would like to change any of these options, click the Setup button. 

5 Click the Next>> button to continue. 

6 [Optional] If your OMR scanner has a printer installed and you have indicated that 

you have a printer in the Scanner Properties window, you may optionally mark the 

checkbox for Activate Print Options. (See Section 6.2.8 for detailed information 

about printing.) 

7 [Optional] If your OMR scanner has a select stacker (rejecter) and you have it 

enabled, you may click the Next>> button to configure the Reject Exceptions. 

Otherwise click the Read button to begin scanning pages. When the select stacker is 

enabled, forms that are not properly read are sent to the select stacker without any 

data being captured. You may review the forms, correct any problems and rescan 

them if desired. Please see Section 6.2.7 for detailed information about using a 

select stacker. 

8 [Optional] If you would like to configure Review Exceptions options, click the 

Next>> button to continue. Otherwise click the Read button to begin scanning 

pages. Review Exceptions is a way to correct exception cases found on forms, such 

as blank and multiple responses (see Section 6.7 Review Exceptions for further 

details about using this feature). 

Note: Review Exceptions can also be run after all the forms are scanned if 
you prefer not to stop scanning 
when problems occur. 

9 Click the Read button to begin 

scanning pages. 

Remark Classic OMR scans the forms 

and matches the sheets and records 

together. The software uses the page 

ID mark to know what sheet number 

is being scanned and the respondent 

tracker to determine the record to which the scanned data belongs. If a duplicate page 

is scanned, a message appears letting you know that data for the page already exists. 

You may click Overwrite to overwrite the existing data record, Ignore to ignore the 

new page’s data (discarding it) and leave the original data intact, or End Read to stop 

scanning all together. Note that if you overwrite, you may be prompted for each page 

within a single record. 

6.2.7 Using an OMR Scanner’s Select Stacker 

Some OMR scanners have a select stacker (also called reject stacker or reject hopper) 

that is used to collect forms during scanning that contain errors. If your OMR scanner 

includes a supported select stacker, you must select it in the OMR Scanner Properties 

window in order to use it. The following items can be rejected during scanning:  
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Option Description 

Multiple responses Sends sheets to the select stacker if multiple responses are 

marked but not allowed in the form template. 

Blank responses Sends sheets to the select stacker if items are left blank. 

Barcode errors Sends sheets to the select stacker if the barcode cannot be 

read. 

Read head errors Sends sheets to the select stacker if the read head test fails. A 

read head test is only performed if the read head test checkbox 

is turned on in the form template properties. 

Timing mark 

errors 

Sends sheets to the select stacker if the timing marks on the 

form cannot be read. This type of error could be the result of 

choosing the wrong form template file, entering the wrong 

amount of timing marks for the form in the form template’s 

properties or a skewed form. 

Form read errors Sends sheets to the select stacker if form errors occur. 

Examples of form read errors include when page IDs cannot be 

identified or when the timing marks cannot be properly read 

(and you are not already rejecting on them). 

Database lookup 

regions 

Sends sheets to the select stacker if the database lookup region 

cannot be recognized. 

Required items Sends sheets to the select stacker if an item marked as 

required has an error (e.g., is left blank or has multiple marks). 

Misordered pages Sends sheets to the select stacker if pages are read out of 

order and you are not using respondent trackers (which allow 

scanning of respondents’ pages out of order). This feature is 

useful if using page identifiers and you want to reject any 

pages that are scanned out of order. 

 

To select the reject stacker option 

1 Select the Tools menu and then click OMR Scanner Properties.  

2 After selecting your OMR scanner, mark the checkbox for Select Stacker Installed. 

3 Click the OK button to save the changes.  

Once you have selected the Select Stacker Installed option in the software, you may 

read forms and specify what types of errors you want to apply to the select stacker.   

4 Open the correct form template. (See Section 6.2.1 Opening a Form Template.) 

5 Place the completed forms in the scanner. 

6 Select the Tools menu and then click Read Wizard, or click . 

Alternatively, you may select the Read Wizard link from the Task Pane. 

7 In the Welcome window, your scanner is listed. Beneath the scanner are the options 

you have indicated are installed on your scanner in the Scanner Properties window. 

If you would like to change any of these options, click the Setup button. 

8 [Optional] If your OMR scanner has a printer installed and you have indicated that 

you have a printer in the OMR Scanner Properties window, you may optionally mark 
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the checkbox for Activate Print Options. See Section 6.2.8 for detailed information 

about printing on forms. 

9 Click the Next>> button to continue. 

10 In the Activate Reject Exceptions window, specify whether to reject exceptions by 

selecting or deselecting the Activate 

Reject Exceptions checkbox. Then 

choose the options that will trigger an 

exception: multiple responses, blank 

responses, barcode errors, read 

head exceptions, timing mark 

errors, form read errors, database 

verification errors, required item 

errors or misordered pages 

(applicable if using sheet identifiers 

and/or respondent trackers). 

11 [Optional] If you would like to configure 

Review Exceptions options, click the Next>> button to continue. Otherwise click 

the Read button to begin scanning pages. Review Exceptions is a way to correct 

exception cases found on forms, such as blank and multiple responses (see Section 

6.7 Review Exceptions for further details about using this feature). 

Note: Review Exceptions can also be run after all the forms are processed if 
you prefer not to stop processing when problems occur. 

12 Click the Read button to begin scanning pages. 

During scanning, any forms that contain the specified reject options are sent to the 

reject stacker. A log is kept of each form that is sent to the reject stacker, explaining 

why it was rejected. When you finish scanning forms, you have an option to view the log 

in the dialog that appears at the end of each scanning session. You may also select the 

Tools menu and then click View Reject Log to view the log file. 

6.2.8 Using an OMR Scanner’s Printer 

Some OMR scanners have a printer installed that allows you to print specific information 

on each form as it is scanned. The printer can be used to print items such as a form 

number, date, field on the form (e.g., an ID field), etc.   

The following items can be printed on the forms: 

 

 Time Stamp  Sequence Number 

 Date Stamp  Record and Sheet Number 

 Time and Date Stamp  Any Field in the Template 

 Sheet Number  Customized Text  

 Record Number  

 

If your OMR scanner contains a supported printer, you must select it in the OMR Scanner 

properties window in order to use it. 

 

To select the printer option 

1 Select the Tools menu and then click OMR Scanner Properties.  
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2 After selecting your OMR scanner, mark the checkbox for Printer Option Installed. 

3 Click the OK button to save the changes. 

Once you have selected Printer Option Installed in the software, you may select what 

to print when you begin reading forms.  

  

To select print options 

1 Open the correct form template. (See Section 6.2.1 Opening a Form Template.) 

2 Place the completed forms in the scanner. 

3 Select the Tools menu and then click Read Wizard, or click . 

Alternatively, you may select the Read Wizard link from the Task Pane. 

4 In the Welcome window, your scanner is listed. Beneath the scanner are the options 

you have indicated are installed on your scanner in the Scanner Properties window. 

If you would like to change any of these options, click the Setup button. 

5 If your OMR scanner has a printer installed and you have indicated that you have a 

printer in the OMR Scanner Properties window, you may optionally mark the 

checkbox for Activate Print Options. 

 Use the drop-down list to choose an item to print or enter free form text. Note 

that some scanners can print a limited amount of text. Therefore, all three drop-

down lists may not be enabled in 

order to ensure you do not select 

more items than can be printed with 

your OMR scanner. 

 For Scantron OMR scanners only: 
Scantron OMR scanners can print on 
the last two inches of the form only. 
In the Print position box, specify 
where to print the information on 
each sheet by entering a value of 0-
27 for the start position. 

6 [Optional] If your OMR scanner has a 

select stacker (rejecter) and you have it 

enabled, you may click the Next>> button to configure the Reject Exceptions. 

Otherwise click the Read button to begin scanning pages. When the select stacker is 

enabled, forms that are not properly read are sent to the select stacker without any 

data being captured. You may review the forms, correct any problems and rescan 

them if desired. Please see Section 6.2.8 for detailed information about using a 

select stacker. 

7 [Optional] If you would like to configure Review Exceptions options, click the 

Next>> button to continue. Otherwise click the Read button to begin scanning 

pages. Review Exceptions is a way to correct exception cases found on forms, such 

as blank and multiple responses (see Section 6.7 Review Exceptions for further 

details about using this feature). 

Note: Review Exceptions can also be run after all the forms are scanned if 
you prefer not to stop scanning when problems occur. 

8 Click the Read button to begin scanning pages. 

As the forms are scanned, the item or items you selected to print are printed on the 

forms. 
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6.2.9 Using Grade and Print with an OMR Scanner 

Remark Classic OMR allows you to print grade information on forms as they are 

scanned. Your OMR scanner must have a printer in order to perform this task. As each 

form is scanned, you may print the Grade, Total Score or Percent Score on the forms. 

You must scan the answer key first, then the forms you wish to have graded. Remark 

Classic OMR uses this answer key to produce a grade for the remaining forms as they 

are scanned. 

 

To select the printer option 

1 Select the Tools menu and then click 

OMR Scanner Properties.  

2 After selecting your OMR scanner, mark 

the checkbox for Transport Printer 

Installed. 

3 Click the OK button to save the 

changes. 

Once you have selected Transport Printer 

Installed in the software, you may select what to print when you begin reading forms.  

 

To use Grade and Print 

1 Open the correct form template. (See Section 6.2.1 Opening a Form Template.) 

2 Place the completed forms in the scanner. 

3 Select the Tools menu and then click Read Wizard, or click . 

Alternatively, you may select the Read Wizard link from the Task Pane. 

4 In the Welcome window, your scanner is listed. Beneath the scanner are the options 

you have indicated are installed on your scanner in the Scanner Properties window. 

If you would like to change any of these 

options, click the Setup button. 

5 If your OMR scanner has a printer 

installed and you have indicated that 

you have a printer in the OMR Scanner 

Properties window, you may optionally 

mark the checkbox for Activate Print 

Options. 

 Use the drop-down list to choose 

the grade item to print: Grade, 

Total Score or Percent Score. 

Note that some scanners can print a 

limited amount of text. Therefore, all three drop-down lists may not be enabled in 

order to ensure you do not select more items than can be printed with your OMR 

scanner. 

 For Scantron OMR scanners only: Scantron OMR scanners can print on the 
last two inches of the form only. In the Print position box, specify where 
to print the information on each sheet by entering a value of 0-27 for the 
start position. 

6 [Optional] If your OMR scanner has a select stacker (rejecter) and you have it 

enabled, you may click the Next>> button to configure the Reject Exceptions. 
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Otherwise click the Read button to begin scanning pages. When the select stacker is 

enabled, forms that are not properly read are sent to the select stacker without any 

data being captured. You may review the forms, correct any problems and rescan 

them if desired. Please see Section 6.2.8 for detailed information about using a 

select stacker. 

7 [Optional] If you would like to configure Review Exceptions options, click the 

Next>> button to continue. Otherwise click the Read button to begin scanning 

pages. Review Exceptions is a way to correct exception cases found on forms, such 

as blank and multiple responses (see Section 6.7 Review Exceptions for further 

details about using this feature). 

Note: Review Exceptions can also be run after all the forms are scanned if 
you prefer not to stop scanning when problems occur. 

8 Click the Read button to begin scanning pages. 

As the forms are scanned, the item or items you selected to print are printed on the 

forms. 

6.3 Scanning Forms with an OMR/Image Scanner 

This section outlines how to scan forms using an OMR/Image scanner, which is set up by 

clicking Tools|OMR/Image Scanner|OMR/Image Properties. OMR/Image scanners 

have image capabilities, meaning that they capture an image of each sheet as it is 

scanned. You can archive the images and you can use the images to perform Review 

Exceptions when cleaning the data. This section is written with the assumption that you 

have an image-enabled scanner and want to capture images of each sheet as it is 

scanned. Please see Chapter 4 for scanner installation instructions. 

6.3.1 Opening a Form Template 

The Remark Classic OMR software requires a form template file for each unique form 

that you want to scan. This file defines all of the information needed for the software to 

read the form. Once you have a form template for your form, it can be reused as often 

as needed (as long as the form does not change). Please note that to use image based 

scanning, you must select one of the standard forms templates installed with the 

software. These files are located in C:\Program Files\Gravic\Remark Classic OMR 

4\Templates\Scantron\OMR-Image by default. These templates have a .rst extension. 

Each form template has a corresponding ScanTools (.SDS) file and background .TIF 

image files. You may not rename or alter the .rst form templates. If you need to edit a 

form template or require a custom form template, please contact Scantron for 

assistance. 

Note: Certain scanners can be set up as either an OMR scanner or 
OMR/Image scanner. If you set up your scanner as an OMR/Image scanner 
you may only use RST templates, even if you are not capturing images. We 
strongly recommend setting up your scanner as an OMR scanner (not 
OMR/Image) if you are not capturing form images. Please see Chapter 4 for 
detailed information about the two ways to set up a scanner. 

To begin the scanning process, open the form template file (.rst) corresponding to your 

form in the Data Center. The Remark Classic OMR template grid window uses a 

spreadsheet style interface to display scanned data. Each grid column corresponds to an 

item or question on the form, as it was defined in the form template. If your form 

template contains multiple pages, each page is separated by a blue line. 
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To access the Data Center 

1 From the Windows Start menu, click Programs|Remark Classic OMR 4|Remark 

Classic OMR Data Center. 

You can see a Task Pane on the left and an empty grid on the right. This grid is where 

your form template is opened and forms are scanned. 

 

To select a form template 

1 Select the File menu and then click Open Form Template, or click , to display 

the Open form template window. Alternatively, select Open form template from 

the Task Pane. 

Note: Form template file names must have a RST file extension.  

Tip: You can access recently used form templates from the File menu or the 
Task Pane. 

2 Use the Look in drop-down list to locate files on your computer or network. By 

default the files are stored in C:\Program Files\Gravic\Remark Classic OMR 

4\Templates\Scantron\OMR-Image. (Do not use the templates in C:\Program 

Files\Gravic\Remark Classic OMR 4\Templates\Scantron\OMR if you want to use 

imaging.) Select the correct form template file by clicking its name. 

3 Click the Open button to open the form template and display the corresponding data 

grid window. 

Once the form template is open, you may begin scanning forms. By default, when you 

open a form template, you see the data grid across the top of the screen and the Image 

Viewer and Graph Viewer at the bottom of the data grid. The data grid is where you see 

the data as forms are processed. The Image Viewer displays an image of the form as it 

is processed. If you click within a data grid cell, the Image Viewer moves to that place 

on the corresponding image. (Note: If you have the Zoom to Region on Selection 

toolbar button enabled, , the Image Viewer also zooms in on the selected region.) 

The Graph Viewer graphs the tabulation of a single question, as selected in a cell of the 

data grid. 

6.3.2 The Remark Classic OMR Read Wizard for OMR/Image 

Scanners 

Scanning forms is handled through the Remark Classic OMR Read Wizard. When 

scanning forms in the Remark Classic OMR Data Center, the software reads pages 

directly from an OMR scanner connected to the computer. Before attempting to read any 

pages from the scanner, turn on your scanner, install the driver if necessary, ensure it is 

set up in Remark Classic OMR and open the form template that corresponds to your 

forms. (See Chapter 4 for information about setting up your scanner.)  

Note: The forms you wish to process must correspond to the selected form 
template.  

The Read Wizard uses the scanner you have selected as the default scanner. It is 

possible to have a scanner set up as both an OMR Scanner and an OMR/Image Scanner. 

If this is the case, make sure you choose the one you want to use by default by clicking 

the Tools menu, selecting the desired scanner (OMR or OMR/Image) and then clicking 

Set as Default Scanner. For image-enabled scanners, you want to set the 
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OMR/Image scanner as the default and ensure you turn on Enable imaging in the 

Read Wizard. 

The Data Center places the recognized data in the open data grid. All data obtained from 

reading one form appear in a single grid row. Each column of the data grid corresponds 

to each variable (question) defined in the form template. 

Note: If you have not yet set up a scanner in Remark Classic OMR, select 
the Tools menu, click OMR/Image Scanner and then click OMR/Image 
Scanner Properties. Choose your scanner and any options installed on the 
scanner that you wish to utilize. The OMR/Image Scanner Properties window 
is covered in detail in Chapter 4. 

 

To read pages from the scanner 

1 Open the correct form template. Only 

open forms with a .RST extension. These 

forms are located by default in 

C:\Program Files\Gravic\Remark Classic 

OMR 4\Templates\Scantron\OMR-Image. 

(See Section 6.3.1 Opening a Form 

Template.)  

2 Place the completed forms in the scanner. 

3 Select the Tools menu and then click 

Read Wizard, or click . 

Alternatively, you may select the Read 

Wizard link from the Task Pane. 

4 In the Welcome window, your scanner is listed. Beneath the scanner are the options 

you have indicated are installed on your scanner in the Scanner Properties window. 

The following options may be available to you depending on your scanner’s 

capabilities: 

 

Option Description 

Enable imaging Mark this checkbox if your scanner has imaging capabilities and 

you want to capture images of each sheet as it is scanned. Note 

that when setting up an OMR/Image scanner that has imaging 

capabilities, this checkbox is turned on by default. 

Duplex scanning 

enabled 

You may use this option if your OMR/Image scanner has duplex 

capabilities, meaning it scans both sides of the sheet in one 

pass through the scanner. If scanning a single sided (simplex) 

form, you do not need to turn off duplex scanning. 

Grading/Scoring 

enabled 

You may use this option if your OMR/Image scanner has 

grading capabilities built into the scanner. Grade-enabled 

scanners often print student scores on the forms as the forms 

are scanned (see your scanner manufacturer’s documentation 

for information about scoring scanners). 

Barcode reader 

enabled 

Mark this option if your OMR/Image scanner has a barcode 

reader. 
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Option Description 

Printer enabled Mark this option if your OMR/Image scanner has a printer. You 

can print certain items, such as score information and dates, on 

forms as they are scanned. 

Select stacker 

enabled 

Mark this option if your OMR/Image scanner has a select 

stacker (rejecter). When forms cannot be read, they are sent to 

the select stacker to be reviewed, without collecting data from 

them. 

 

Items with a checkmark in a green circle are available and enabled. Items with a 

dash in a red circle are not enabled. If you would like to change any of these options, 

click the Setup button (remember to click OK in the Scanner Properties window to 

return to the Read Wizard). (Note you 

may only enable items that are installed 

on your OMR/Image scanner.)  

5 To ensure you are capturing images of 

scanned sheets, make sure the Imaging 

enabled checkbox is selected. 

6 If your OMR/Image scanner has a printer 

installed and you have indicated that you 

have a printer in the Scanner 

Properties window, you may optionally 

mark the checkbox for Activate Print 

Options. (Printer options are covered in 

more detail in Section 6.3.8.) 

 Use the drop-down list to choose an item to print or enter free form text. Note 

that some scanners can print a limited amount of text. Therefore, all three drop-

down lists may not be enabled in order to ensure you do not select more text 

than can be printed with your OMR scanner. 

 Certain OMR scanners can print on the last two inches of the form only. In the 

Print position box, specify where to print the information on each sheet by 

entering a value of 0-27 for the start position (the number varies from scanner to 

scanner). 

7 Click the Next>> button to continue.  

8 The Image Naming Conventions window appears, which allows you to specify 

options about the images that are 

automatically stored each time you 

scan forms. In the Begin image 

names with box, enter a file base 

name that the software can use to 

name the images stored for this 

form. The default base name is the 

form template name; however, you 

may use any name you like. We 

suggest using something that 

identifies to you that the images 

belong to a certain form. The 

images that are stored all begin 

with this base name and then have 
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the page number (if scanning a multi-page form), date and time appended to them 

to keep track of the various images. You may optionally choose a region from the 

form template to use as the base name. The value that is collected from the form for 

the specified region is used as the base name for the corresponding stored image. 

For example, if scanning student tests you could use a Student ID region to name 

the resulting image files by student. If you leave the Begin image names with 

option blank, your images only have the page number (if applicable), date and time 

as the name of each image.  

9 In the Image target directory box, click the ellipsis (…) button to select a location 

in which to store the images for this form. You may use the default directory for 

images or select a different directory on your computer, external drive or network. 

Note: Choose the image location carefully. The images should remain in this 
location once the data is saved using the RMK format if you want to retain 
the link between the processed data and each image file. This link allows 
you to view the forms on screen as you click through the data grid, making 
it easy to correct exceptions in your data. Therefore, you should plan ahead 
on how you will store these images when the forms are processed. 

Tip: If you are sharing files with other Remark Office OMR users, you may 
wish to save the image files on a shared network drive that all users have 
access to in the same manner (e.g., through a mapped network drive). 

10 Mark the checkbox for Save images in a subfolder based on the form 

template’s name to have the Data Center automatically create a folder in which to 

store these images. The folder name is the name of the form template and the folder 

is created in the directory you have selected in the Image target directory box. 

Tip: We recommend using the Save images in a subfolder based on the 
form template’s name feature for easier organization of image files. Use 
of this feature keeps all images associated with each form template in one 
folder for easy access. The unique date and time portion of the image names 
prevents images from being overwritten. 

11 [OPTIONAL] If desired, click the Name Builder… button to further customize the 

stored image names and locations.  

 In the Image Base Name area, you may choose to add a region from the 

processed data to the image 

base name. Choose the region 

from the drop-down list and 

then click the Add button. If 

you already added a region in 

Step 8, the Name Builder 

allows you to add additional 

regions. For example, if 

processing tests, you could add 

a Student ID that is being 

collected from the form so that 

your processed images all have 

the Student ID number in them. 

 In the Image Target Directory area, you may choose to add a region from the 

processed data to the folder structure that holds the processed images. Choose 

the region from the drop-down list and then click the Add button. For example, if 

processing tests, you could add a Test ID that is being collected from the form so 

that each student’s form images are stored in a folder containing the Test ID. 
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 In the Name Builder box, click the OK button to return to the Read Wizard. 

12 In the Saved image type box, select an image type to use for storing images. The 

choices are: PCX/DCX, PDF, TIF or JPG.  

13 When saving to the PDF or TIF formats, you can choose the compression level under 

Image compression level: Uncompressed, Group 3, Group 3 2d, Group 4 and 

LZW. Group 4 creates the most compressed image (smallest file size that take up 

less space on your computer). 

14 Mark the checkbox for Save multiple page form templates as multiple page 

image files if you are scanning a multi-page form and would like all of the images 

for one complete form to be saved as one image file. Using this option creates fewer 

image files and is recommended. 

14 [Optional] If your OMR/Image scanner has a select stacker (rejecter) and you have it 

enabled, you may click the Next>> button to configure the Reject Exceptions. 

When the select stacker is enabled, forms that are not properly read are sent to the 

select stacker without any data being captured. You may review the forms, correct 

any problems and rescan them if desired. The reject options are covered in detail in 

Section 6.3.7. 

 In the Reject Exceptions window, specify whether to reject exception cases 

during the scanning process by marking the Activate Reject Exceptions 

checkbox.  

 In the Reject Exceptions Options 

area, mark the checkboxes for those 

cases that you wish to reject during 

scanning, as indicated in the table 

above.  

15 [Optional] If you would like to configure 

Review Exceptions options, click the 

Next>> button to continue. Otherwise 

click the Read button to begin scanning 

pages. 

Review Exceptions is a way to correct 

exception cases found on forms, such as blank and multiple responses (see Section 6.7 

for further details about using this feature). When using Review Exceptions (as opposed 

to a select stacker), scanning stops but the pages are not sent to a select stacker. You 

are able to review the problems on the spot and make corrections, then continue 

scanning. 

 In the Review Exceptions window, specify whether to review exception cases 

during the scanning process by marking the Activate Review Exceptions 

checkbox.  

 In the Review Exceptions Options 

area, mark the checkboxes for those 

cases that you wish to review during 

scanning. The following options are 

available: Multiple responses, 

Blank responses, Input regions, 

Database lookup regions, 

Barcode regions, or Required 

items. Reviewing Exceptions during 

scanning causes the software to stop 

scanning when it encounters any 
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exception cases you select. You can then make the appropriate adjustments and 

the scanning resumes. 

Note: Review Exceptions can also be run after all the forms are scanned if 
you prefer not to stop scanning when problems occur. 

16 Click the Read button to begin scanning pages. 

Note: If desired you can click the drop-down arrow on the Read button and 
choose Save or Save and Read. If you choose one of the save options, 
your Read Wizard settings are saved as an Automation Wizard file (.rcez). 
The Automation Wizard is used to automate form processing. Please see the 
Remark Classic OMR Automation Wizard User’s Guide.pdf file 
(Start|Programs|Remark Classic OMR 4|Documentation) included with your 
software for more information about the Automation Wizard. 

Remark Classic OMR continues scanning pages until the scanner’s sheetfeeder is empty.  

17 After processing all of the pages, you are prompted to continue scanning. Click 

Resume Scan to scan more pages or End Scan to end the scanning process.  

6.3.3 Scanning Using Default Settings with an OMR/Image 

Scanner (Easy Scan) 

Once you have run the Read Wizard, you may optionally scan using default settings 

without running the Read Wizard each time. This method is called Easy Scan and 

scanning occurs using the last settings specified in the Read Wizard. 

Caution: Easy Scan is useful if you are using the same settings each time 
you scan. If you are uncertain about what settings exist, it is recommended 
that you run the Read Wizard to initiate scanning. 

 

To use Easy Scan 

1 Open the correct form template. Only open forms with a .RST extension. These 

forms are located by default in C:\Program Files\Gravic\Remark Classic OMR 

4\Templates\Scantron\OMR-Image. (See Section 6.3.1 Opening a Form Template.)  

2 Select the Tools menu and then click Easy Scan, or click the Easy Scan toolbar 

button . 

All pages in the scanner are scanned based on the last settings used in the Read Wizard. 

You then see a spreadsheet of data. Each row represents one complete form and each 

column represents each item (question) defined in the form template. 

6.3.4 Scanning Multiple Sheet Forms Without Page ID Marks Using 

an OMR/Image Scanner 

Page ID marks are a pre-printed sequence of marks on an OMR form that when taken 

together produce a unique ID for the sheet. If you do not have page ID marks on your 

forms, Remark Classic OMR cannot discern whether the forms are being scanned in 

proper sheet order. You must read the forms in proper sheet order so that Remark 

Classic OMR can process the sheets correctly (e.g., sheet one, sheet two, sheet three, 

etc.). Follow the directions above for scanning forms, ensuring the forms are in the 

correct sequential order. 
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6.3.5 Scanning Multiple Sheet Forms with Page ID Marks Using an 

OMR/Image Scanner 

If you have page ID marks on a form, Remark Classic OMR uses the page ID marks to 

know whether the correct sheet of the form is being processed. If the sheets are out of 

order, they are flagged with an error message. The page ID marks act as a sheet 

identifier. When you create a form template with page ID marks, you specify the 

location of the marks on the form so that Remark Classic OMR can identify the various 

sheets of each form that is scanned. In order to recognize different sheets within one 

form, the sheets must have different page ID marks. If the page ID marks are identical 

from sheet to sheet, Remark Classic OMR is able to tell of you are scanning the correct 

form, but it is not able to differentiate sheets within that form. In addition, you must 

keep all of the sheets belonging to one respondent together, unless you are also using 

respondent trackers (see section 6.3.6 for information about respondent trackers). 

 

To read multiple sheet forms with page ID marks 

1 Open the correct form template. Only open forms with a .RST extension. These 

forms are located by default in C:\Program Files\Gravic\Remark Classic OMR 

4\Templates\Scantron\OMR-Image. (See Section 6.3.1 Opening a Form Template.)  

2 Place the completed forms in the scanner. 

3 Select the Tools menu and then click Read Wizard, or click . 

Alternatively, you may select the Read Wizard link from the Task Pane. 

4 In the Welcome window, your scanner is listed. Beneath the scanner are the options 

you have indicated are installed on your scanner in the Scanner Properties 

window. If you would like to change any of these options, click the Setup button. 

5 To ensure you are capturing images of scanned sheets, make sure the Imaging 

enabled checkbox is selected. 

6 [Optional] If your OMR scanner has a printer installed and you have indicated that 

you have a printer in the Scanner Properties window, you may optionally mark the 

checkbox for Activate Print Options. (See Section 6.3.7 for detailed information 

about printing.) 

7 Click the Next>> button to continue.  

8 The Image Naming Conventions window appears, which allows you to specify 

options about the images that are 

automatically stored each time you 

scan forms. In the Begin image 

names with box, enter a file base 

name that the software can use to 

name the images stored for this 

form. The default base name is the 

form template name; however, you 

may use any name you like. We 

suggest using something that 

identifies to you that the images 

belong to a certain form. The 

images that are stored all begin 

with this base name and then have 

the page number (if scanning a multi-page form), date and time appended to them 

to keep track of the various images. You may optionally choose a region from the 

form template to use as the base name. The value that is collected from the form for 
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the specified region is used as the base name for the corresponding stored image. 

For example, if scanning student tests you could use a Student ID region to name 

the resulting image files by student. If you leave the Begin image names with 

option blank, your images only have the page number (if applicable), date and time 

as the name of each image.  

9 In the Image target directory box, click the ellipsis (…) button to select a location 

in which to store the images for this form. You may use the default directory for 

images or select a different directory on your computer, external drive or network. 

Note: Choose the image location carefully. The images should remain in this 
location once the data is saved using the RMK format if you want to retain 
the link between the processed data and each image file. This link allows 
you to view the forms on screen as you click through the data grid, making 
it easy to correct exceptions in your data. Therefore, you should plan ahead 
on how you will store these images when the forms are processed. 

Tip: If you are sharing files with other Remark Office OMR users, you may 
wish to save the image files on a shared network drive that all users have 
access to in the same manner (e.g., through a mapped network drive). 

10 Mark the checkbox for Save images in a subfolder based on the form 

template’s name to have the Data Center automatically create a folder in which to 

store these images. The folder name is the name of the form template and the folder 

is created in the directory you have selected in the Image target directory box. 

Tip: We recommend using the Save images in a subfolder based on the 
form template’s name feature for easier organization of image files. Use 
of this feature keeps all images associated with each form template in one 
folder for easy access. The unique date and time portion of the image names 
prevents images from being overwritten. 

11 [OPTIONAL] If desired, click the Name Builder… button to further customize the 

stored image names and locations.  

 In the Image Base Name area, you may choose to add a region from the 

processed data to the image 

base name. Choose the region 

from the drop-down list and 

then click the Add button. If 

you already added a region in 

Step 8, the Name Builder 

allows you to add additional 

regions. For example, if 

processing tests, you could add 

a Student ID that is being 

collected from the form so that 

your processed images all have 

the Student ID number in them. 

 In the Image Target Directory area, you may choose to add a region from the 

processed data to the folder structure that holds the processed images. Choose 

the region from the drop-down list and then click the Add button. For example, if 

processing tests, you could add a Test ID that is being collected from the form so 

that each student’s form images are stored in a folder containing the Test ID. 

 In the Name Builder box, click the OK button to return to the Read Wizard. 

12 In the Saved image type box, select an image type to use for storing images. The 

choices are: PCX/DCX, PDF, TIF or JPG.  
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13 When saving to the PDF or TIF formats, you can choose the compression level under 

Image compression level: Uncompressed, Group 3, Group 3 2d, Group 4 and 

LZW. Group 4 creates the most compressed image (smallest file size that take up 

less space on your computer). 

14 Mark the checkbox for Save multiple page form templates as multiple page 

image files if you are scanning a multi-page form and would like all of the images 

for one complete form to be saved as one image file. Using this option creates fewer 

image files and is recommended. 

14 [Optional] If your OMR scanner has a select stacker (rejecter) and you have it 

enabled, you may click the Next>> button to configure the Reject Exceptions. 

Otherwise click the Read button to begin scanning pages. When the select stacker is 

enabled, forms that are not properly read are sent to the select stacker without any 

data being captured. You may review the forms, correct any problems and rescan 

them if desired. Please see Section 6.3.8 for detailed information about using a 

select stacker. 

15 [Optional] If you would like to configure Review Exceptions options, click the 

Next>> button to continue. Otherwise click the Read button to begin scanning 

pages. Review Exceptions is a way to correct exception cases found on forms, such 

as blank and multiple responses (see Section 6.7 Review Exceptions for further 

details about using this feature). 

Note: Review Exceptions can also be run after all the forms are scanned if 
you prefer not to stop scanning when problems occur. 

16 Click the Read button to begin scanning 

pages. 

Remark Classic OMR reads forms until it cannot 

interpret the page ID mark or until all pages in the 

scanner are scanned. The software alerts you to 

an incorrect sheet, at which time you have several 

options, depending on how you are set up. If using 

a select stacker and rejecting misordered pages 

and form read errors, any sheets that are scanned 

out of order are simply sent to the select stacker. Upon scanning completion, you can 

view a log of showing why sheets were rejected. If you are not using a select stacker, 

you receive a message that the sheet 

cannot be identified and when you click 

the OK button, you can decide whether 

to continue scanning. In either case, 

you can remove the sheet and replace 

it with the correct sheet and then click 

Yes. Or, you can remove the sheet and 

then move onto the next sheet by 

simply clicking Yes. To stop scanning 

all together, select No. To view the 

reject log, click View Log…. (The reject log can also be accessed any time by clicking 

Tools|View Reject Log). 

6.3.6 Scanning Multiple Sheet Forms with Respondent Trackers 
Using an OMR/Image Scanner 

Page ID marks alone act as sheet identifiers, but with the addition of respondent 

trackers (lithocodes), you can also keep respondents’ data together. A respondent 



 Scanning Forms   

 89 

tracker acts as a respondent ID and must be used in conjunction with page ID marks, 

which act as sheet identifiers, as explained in the previous section. If you have 

respondent trackers and page ID marks on your form, you can scan forms in any order 

and Remark Classic OMR is able to match sheets using the page ID marks and 

respondents to the appropriate record using the respondent trackers. Respondent 

trackers can be OMR or barcode regions. Setting up respondent trackers in your form 

template is covered in Chapter 5.  

 

1 Open the correct form template. Only open forms with a .RST extension. These 

forms are located by default in C:\Program Files\Gravic\Remark Classic OMR 

4\Templates\Scantron\OMR-Image. (See Section 6.3.1 Opening a Form Template.)  

2 Place the completed forms in the scanner. 

3 Select the Tools menu and then click Read Wizard, or click . 

Alternatively, you may select the Read Wizard link from the Task Pane. 

4 In the Welcome window, your scanner is listed. Beneath the scanner are the options 

you have indicated are installed on your scanner in the Scanner Properties 

window. If you would like to change any of these options, click the Setup button. 

5 To ensure you are capturing images of scanned sheets, make sure the Imaging 

enabled checkbox is selected. 

6 Click the Next>> button to continue. 

7 [Optional] If your OMR scanner has a printer installed and you have indicated that 

you have a printer in the Scanner Properties window, you may optionally mark the 

checkbox for Activate Print Options. (See Section 6.3.8 for detailed information 

about printing.) 

7 Click the Next>> button to continue.  

8 The Image Naming Conventions window appears, which allows you to specify 

options about the images that are 

automatically stored each time you 

scan forms. In the Begin image 

names with box, enter a file base 

name that the software can use to 

name the images stored for this 

form. The default base name is the 

form template name; however, you 

may use any name you like. We 

suggest using something that 

identifies to you that the images 

belong to a certain form. The 

images that are stored all begin 

with this base name and then have 

the page number (if scanning a multi-page form), date and time appended to them 

to keep track of the various images. You may optionally choose a region from the 

form template to use as the base name. The value that is collected from the form for 

the specified region is used as the base name for the corresponding stored image. 

For example, if scanning student tests you could use a Student ID region to name 

the resulting image files by student. If you leave the Begin image names with 

option blank, your images only have the page number (if applicable), date and time 

as the name of each image.  
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9 In the Image target directory box, click the ellipsis (…) button to select a location 

in which to store the images for this form. You may use the default directory for 

images or select a different directory on your computer, external drive or network. 

Note: Choose the image location carefully. The images should remain in this 
location once the data is saved using the RMK format if you want to retain 
the link between the processed data and each image file. This link allows 
you to view the forms on screen as you click through the data grid, making 
it easy to correct exceptions in your data. Therefore, you should plan ahead 
on how you will store these images when the forms are processed. 

Tip: If you are sharing files with other Remark Office OMR users, you may 
wish to save the image files on a shared network drive that all users have 
access to in the same manner (e.g., through a mapped network drive). 

10 Mark the checkbox for Save images in a subfolder based on the form 

template’s name to have the Data Center automatically create a folder in which to 

store these images. The folder name is the name of the form template and the folder 

is created in the directory you have selected in the Image target directory box. 

Tip: We recommend using the Save images in a subfolder based on the 
form template’s name feature for easier organization of image files. Use 
of this feature keeps all images associated with each form template in one 
folder for easy access. The unique date and time portion of the image names 
prevents images from being overwritten. 

11 [OPTIONAL] If desired, click the Name Builder… button to further customize the 

stored image names and locations.  

 In the Image Base Name area, you may choose to add a region from the 

processed data to the image 

base name. Choose the region 

from the drop-down list and 

then click the Add button. If 

you already added a region in 

Step 8, the Name Builder 

allows you to add additional 

regions. For example, if 

processing tests, you could add 

a Student ID that is being 

collected from the form so that 

your processed images all have 

the Student ID number in them. 

 In the Image Target Directory area, you may choose to add a region from the 

processed data to the folder structure that holds the processed images. Choose 

the region from the drop-down list and then click the Add button. For example, if 

processing tests, you could add a Test ID that is being collected from the form so 

that each student’s form images are stored in a folder containing the Test ID. 

 In the Name Builder box, click the OK button to return to the Read Wizard. 

12 In the Saved image type box, select an image type to use for storing images. The 

choices are: PCX/DCX, PDF, TIF or JPG.  

13 When saving to the PDF or TIF formats, you can choose the compression level under 

Image compression level: Uncompressed, Group 3, Group 3 2d, Group 4 and 

LZW. Group 4 creates the most compressed image (smallest file size that take up 

less space on your computer). 
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14 Mark the checkbox for Save multiple page form templates as multiple page 

image files if you are scanning a multi-page form and would like all of the images 

for one complete form to be saved as one image file. Using this option creates fewer 

image files and is recommended. 

14 [Optional] If your OMR scanner has a select stacker (rejecter) and you have it 

enabled, you may click the Next>> button to configure the Reject Exceptions. 

Otherwise click the Read button to begin scanning pages. When the select stacker is 

enabled, forms that are not properly read are sent to the select stacker without any 

data being captured. You may review the forms, correct any problems and rescan 

them if desired. Please see Section 6.3.7 for detailed information about using a 

select stacker. 

15 [Optional] If you would like to configure Review Exceptions options, click the 

Next>> button to continue. Otherwise click the Read button to begin scanning 

pages. Review Exceptions is a way to correct exception cases found on forms, such 

as blank and multiple responses (see Section 6.7 Review Exceptions for further 

details about using this feature). 

Note: Review Exceptions can also be run after all the forms are scanned if 
you prefer not to stop scanning 
when problems occur. 

16 Click the Read button to begin 

scanning pages. 

Remark Classic OMR scans the forms 

and matches the sheets and records 

together. The software uses the page 

ID mark to know what sheet number 

is being scanned and the respondent 

tracker to determine the record to which the scanned data belongs. If a duplicate page 

is scanned, a message appears letting you know that data for the page already exists. 

You may click Overwrite to overwrite the existing data record, Ignore to ignore the 

new page’s data (discarding it) and leave the original data intact, or End Read to stop 

scanning all together. Note that if you overwrite, you may be prompted for each page 

within a single record. 

6.3.7 Using an OMR/Image Scanner’s Select Stacker 

Some OMR/Image scanners have a select stacker (also called reject stacker or reject 

hopper) that is used to collect forms during scanning that contain errors. If your OMR 

scanner includes a supported select stacker, you must select it in the OMR/Image 

Scanner Properties window in order to use it. The following items can be rejected during 

scanning:  

 

Option Description 

Multiple responses Sends sheets to the select stacker if multiple responses are 

marked but not allowed in the form template. 

Blank responses Sends sheets to the select stacker if items are left blank. 

Barcode errors Sends sheets to the select stacker if the barcode cannot be 

read. 



Remark Classic OMR User’s Guide 

92 

Option Description 

Read head errors Sends sheets to the select stacker if the read head test fails. A 

read head test is only performed if the read head test checkbox 

is turned on in the form template properties. 

Timing mark 

errors 

Sends sheets to the select stacker if the timing marks on the 

form cannot be read. This type of error could be the result of 

choosing the wrong form template file, entering the wrong 

amount of timing marks for the form in the form template’s 

properties or a skewed form. 

Form read errors Sends sheets to the select stacker if form errors occur. 

Examples of form read errors include when page IDs cannot be 

identified or when the timing marks cannot be properly read 

(and you are not already rejecting on them). 

Database lookup 

regions 

Sends sheets to the select stacker if the database lookup region 

cannot be recognized. 

Required items Sends sheets to the select stacker if an item marked as 

required has an error (e.g., is left blank or has multiple marks). 

Misordered pages Sends sheets to the select stacker if pages are read out of 

order and you are not using respondent trackers (which allow 

scanning of respondents’ pages out of order). This feature is 

useful if using page identifiers and you want to reject any 

pages that are scanned out of order. 

 

To select the reject stacker option 

1 Select the Tools menu and then click 

OMR/Image Scanner Properties.  

2 After selecting your OMR scanner, 

mark the checkbox for Use Select 

Stacker. 

3 Click the OK button to save the 

changes.  

Once you have selected the Use Select 

Stacker option in the software, you may 

read forms and specify what types of 

errors you want to apply to the select stacker.   

4 Open the correct form template. Only open forms with a .RST extension. These 

forms are located by default in C:\Program Files\Gravic\Remark Classic OMR 

4\Templates\Scantron\OMR-Image. (See Section 6.3.1 Opening a Form Template.)  

5 Place the completed forms in the scanner. 

6 Select the Tools menu and then click Read Wizard, or click . 

Alternatively, you may select the Read Wizard link from the Task Pane. 

7 In the Welcome window, your scanner is listed. Beneath the scanner are the options 

you have indicated are installed on your scanner in the Scanner Properties window. 

If you would like to change any of these options, click the Setup button. 
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8 To ensure you are capturing images of scanned sheets, make sure the Imaging 

enabled checkbox is selected. 

9 [Optional] If your OMR scanner has a printer installed and you have indicated that 

you have a printer in the OMR Scanner Properties window, you may optionally mark 

the checkbox for Activate Print Options. See Section 6.3.8 for detailed information 

about printing on forms. 

9 Click the Next>> button to continue.  

10 The Image Naming Conventions window appears, which allows you to specify 

options about the images that are 

automatically stored each time you 

scan forms. In the Begin image 

names with box, enter a file base 

name that the software can use to 

name the images stored for this 

form. The default base name is the 

form template name; however, you 

may use any name you like. We 

suggest using something that 

identifies to you that the images 

belong to a certain form. The images 

that are stored all begin with this 

base name and then have the page 

number (if scanning a multi-page form), date and time appended to them to keep 

track of the various images. You may optionally choose a region from the form 

template to use as the base name. The value that is collected from the form for the 

specified region is used as the base name for the corresponding stored image. For 

example, if scanning student tests you could use a Student ID region to name the 

resulting image files by student. If you leave the Begin image names with option 

blank, your images only have the page number (if applicable), date and time as the 

name of each image.  

11 In the Image target directory box, click the ellipsis (…) button to select a location 

in which to store the images for this form. You may use the default directory for 

images or select a different directory on your computer, external drive or network. 

Note: Choose the image location carefully. The images should remain in this 
location once the data is saved using the RMK format if you want to retain 
the link between the processed data and each image file. This link allows 
you to view the forms on screen as you click through the data grid, making 
it easy to correct exceptions in your data. Therefore, you should plan ahead 
on how you will store these images when the forms are processed. 

Tip: If you are sharing files with other Remark Office OMR users, you may 
wish to save the image files on a shared network drive that all users have 
access to in the same manner (e.g., through a mapped network drive). 

12 Mark the checkbox for Save images in a subfolder based on the form 

template’s name to have the Data Center automatically create a folder in which to 

store these images. The folder name is the name of the form template and the folder 

is created in the directory you have selected in the Image target directory box. 

Tip: We recommend using the Save images in a subfolder based on the 
form template’s name feature for easier organization of image files. Use 
of this feature keeps all images associated with each form template in one 
folder for easy access. The unique date and time portion of the image names 
prevents images from being overwritten. 
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13 [OPTIONAL] If desired, click the Name Builder… button to further customize the 

stored image names and locations.  

 In the Image Base Name area, you may choose to add a region from the 

processed data to the image base 

name. Choose the region from 

the drop-down list and then click 

the Add button. If you already 

added a region in Step 10, the 

Name Builder allows you to add 

additional regions. For example, 

if processing tests, you could add 

a Student ID that is being 

collected from the form so that 

your processed images all have 

the Student ID number in them. 

 In the Image Target Directory 

area, you may choose to add a region from the processed data to the folder 

structure that holds the processed images. Choose the region from the drop-

down list and then click the Add button. For example, if processing tests, you 

could add a Test ID that is being collected from the form so that each student’s 

form images are stored in a folder containing the Test ID. 

 In the Name Builder box, click the OK button to return to the Read Wizard. 

14 In the Saved image type box, select an image type to use for storing images. The 

choices are: PCX/DCX, PDF, TIF or JPG.  

15 When saving to the PDF or TIF formats, you can choose the compression level under 

Image compression level: Uncompressed, Group 3, Group 3 2d, Group 4 and 

LZW. Group 4 creates the most compressed image (smallest file size that take up 

less space on your computer). 

16 Mark the checkbox for Save multiple page form templates as multiple page 

image files if you are scanning a multi-page form and would like all of the images 

for one complete form to be saved as one image file. Using this option creates fewer 

image files and is recommended. 

17 Click the Next>> button to continue. 

18 In the Activate Reject Exceptions 

window, specify whether to reject 

exceptions by selecting or deselecting the 

Activate Reject Exceptions checkbox. 

Then choose the options that will trigger 

an exception: multiple responses, 

blank responses, barcode errors, read 

head exceptions, timing mark errors, 

form read errors, database 

verification errors, required item 

errors or misordered pages (applicable 

if using sheet identifiers and/or 

respondent trackers). 

19 [Optional] If you would like to configure Review Exceptions options, click the 

Next>> button to continue. Otherwise click the Read button to begin scanning 

pages. Review Exceptions is a way to correct exception cases found on forms, such 

as blank and multiple responses (see Section 6.7 Review Exceptions for further 

details about using this feature). 



 Scanning Forms   

 95 

Note: Review Exceptions can also be run after all the forms are processed if 
you prefer not to stop processing when problems occur. 

20 Click the Read button to begin scanning pages. 

During scanning, any forms that contain the specified reject options are sent to the 

reject stacker. A log is kept of each form that is sent to the reject stacker, explaining 

why it was rejected. When you finish scanning forms, you have an option to view the log 

in the dialog that appears at the end of each scanning session. You may also select the 

Tools menu and then click View Reject Log to view the log file. 

6.3.8 Using an OMR/Image Scanner’s Printer 

Some OMR/Image scanners have a printer installed that allows you to print specific 

information on each form as it is scanned. The printer can be used to print items such as 

a form number, date, field on the form (e.g., an ID field), etc.   

The following items can be printed on the forms: 

 Time Stamp  Sequence Number 

 Date Stamp  Record and Sheet Number 

 Time and Date Stamp  Any Field in the Template 

 Sheet Number  Customized Text  

 Record Number  

If your OMR/Image scanner contains a supported printer, you must select it in the 

OMR/Image Scanner properties window in order to use it. 

 

To select the printer option 

1 Select the Tools menu and then click 

OMR/Image Scanner Properties.  

2 After selecting your OMR scanner, 

mark the checkbox for Use Transport 

Printer. 

3 Click the OK button to save the 

changes. 

Once you have selected Use Transport 

Printer in the software, you may select 

what to print when you begin reading forms.  

  

To select print options 

1 Open the correct form template. Only open forms with a .RST extension. These 

forms are located by default in C:\Program Files\Gravic\Remark Classic OMR 

4\Templates\Scantron\OMR-Image. (See Section 6.3.1 Opening a Form Template.)  

2 Place the completed forms in the scanner. 

3 Select the Tools menu and then click Read Wizard, or click . 

Alternatively, you may select the Read Wizard link from the Task Pane. 

4 In the Welcome window, your scanner is listed. Beneath the scanner are the options 

you have indicated are installed on your scanner in the Scanner Properties window. 

If you would like to change any of these options, click the Setup button. 
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5 To ensure you are capturing images of scanned sheets, make sure the Imaging 

enabled checkbox is selected. 

6 If your OMR/Image scanner has a 

printer installed and you have 

indicated that you have a printer in the 

OMR/Image Scanner Properties 

window, you may optionally mark the 

checkbox for Activate Print Options. 

 Use the drop-down list to choose 

an item to print or enter free form 

text. Note that some scanners can 

print a limited amount of text. 

Therefore, all three drop-down lists 

may not be enabled in order to 

ensure you do not select more 

items than can be printed with your OMR scanner. 

 For Scantron OMR scanners only: Scantron OMR scanners can print on the 
last two inches of the form only. In the Print position box, specify where 
to print the information on each sheet by entering a value of 0-27 for the 
start position. 

6 Click the Next>> button to continue.  

7 The Image Naming Conventions window appears, which allows you to specify 

options about the images that are automatically stored each time you scan forms. In 

the Begin image names with box, 

enter a file base name that the 

software can use to name the 

images stored for this form. The 

default base name is the form 

template name; however, you may 

use any name you like. We suggest 

using something that identifies to 

you that the images belong to a 

certain form. The images that are 

stored all begin with this base name 

and then have the page number (if 

scanning a multi-page form), date 

and time appended to them to keep 

track of the various images. You may optionally choose a region from the form 

template to use as the base name. The value that is collected from the form for the 

specified region is used as the base name for the corresponding stored image. For 

example, if scanning student tests you could use a Student ID region to name the 

resulting image files by student. If you leave the Begin image names with option 

blank, your images only have the page number (if applicable), date and time as the 

name of each image.  

8 In the Image target directory box, click the ellipsis (…) button to select a location 

in which to store the images for this form. You may use the default directory for 

images or select a different directory on your computer, external drive or network. 

Note: Choose the image location carefully. The images should remain in this 
location once the data is saved using the RMK format if you want to retain 
the link between the processed data and each image file. This link allows 
you to view the forms on screen as you click through the data grid, making 
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it easy to correct exceptions in your data. Therefore, you should plan ahead 
on how you will store these images when the forms are processed. 

Tip: If you are sharing files with other Remark Office OMR users, you may 
wish to save the image files on a shared network drive that all users have 
access to in the same manner (e.g., through a mapped network drive). 

9 Mark the checkbox for Save images in a subfolder based on the form 

template’s name to have the Data Center automatically create a folder in which to 

store these images. The folder name is the name of the form template and the folder 

is created in the directory you have selected in the Image target directory box. 

Tip: We recommend using the Save images in a subfolder based on the 
form template’s name feature for easier organization of image files. Use 
of this feature keeps all images associated with each form template in one 
folder for easy access. The unique date and time portion of the image names 
prevents images from being overwritten. 

10 [OPTIONAL] If desired, click the Name Builder… button to further customize the 

stored image names and locations.  

 In the Image Base Name area, you may choose to add a region from the 

processed data to the image 

base name. Choose the region 

from the drop-down list and 

then click the Add button. If 

you already added a region in 

Step 7, the Name Builder 

allows you to add additional 

regions. For example, if 

processing tests, you could add 

a Student ID that is being 

collected from the form so that 

your processed images all have 

the Student ID number in them. 

 In the Image Target Directory area, you may choose to add a region from the 

processed data to the folder structure that holds the processed images. Choose 

the region from the drop-down list and then click the Add button. For example, if 

processing tests, you could add a Test ID that is being collected from the form so 

that each student’s form images are stored in a folder containing the Test ID. 

 In the Name Builder box, click the OK button to return to the Read Wizard. 

11 In the Saved image type box, select an image type to use for storing images. The 

choices are: PCX/DCX, PDF, TIF or JPG.  

12 When saving to the PDF or TIF formats, you can choose the compression level under 

Image compression level: Uncompressed, Group 3, Group 3 2d, Group 4 and 

LZW. Group 4 creates the most compressed image (smallest file size that take up 

less space on your computer). 

13 Mark the checkbox for Save multiple page form templates as multiple page 

image files if you are scanning a multi-page form and would like all of the images 

for one complete form to be saved as one image file. Using this option creates fewer 

image files and is recommended. 

13 [Optional] If your OMR scanner has a select stacker (rejecter) and you have it 

enabled, you may click the Next>> button to configure the Reject Exceptions. 

Otherwise click the Read button to begin scanning pages. When the select stacker is 

enabled, forms that are not properly read are sent to the select stacker without any 
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data being captured. You may review the forms, correct any problems and rescan 

them if desired. Please see Section 6.3.7 for detailed information about using a 

select stacker. 

14 [Optional] If you would like to configure Review Exceptions options, click the Next>> 

button to continue. Otherwise click the Read button to begin scanning pages. Review 

Exceptions is a way to correct exception cases found on forms, such as blank and 

multiple responses (see Section 6.7 Review Exceptions for further details about using 

this feature). 

Note: Review Exceptions can also be run after all the forms are scanned if 
you prefer not to stop scanning when problems occur. 

15 Click the Read button to begin scanning pages. 

As the forms are scanned, the item or items you selected to print are printed on the 

forms. 

6.3.9 Using Grade and Print with an OMR/Image Scanner 

Remark Classic OMR allows you to print grade information on forms as they are 

scanned. Your OMR/Image scanner must have a printer in order to perform this task. As 

each form is scanned, you may print the Grade, Total Score or Percent Score on the 

forms. You must scan the answer key first, then the forms you wish to have graded. 

Remark Classic OMR uses this answer key to produce a grade for the remaining forms as 

they are scanned. 

 

To select the printer option 

1 Select the Tools menu and then click 

OMR/Image Scanner Properties.  

2 After selecting your OMR scanner, 

mark the checkbox for Use transport 

printer. 

3 Click the OK button to save the 

changes. 

Once you have selected Use Transport 

Printer in the software, you may select 

what to print when you begin reading forms.  

 

To use Grade and Print 

1 Open the correct form template. Only open forms with a .RST extension. These 

forms are located by default in C:\Program Files\Gravic\Remark Classic OMR 

4\Templates\Scantron\OMR-Image. (See Section 6.3.1 Opening a Form Template.)  

2 Place the completed forms in the scanner. 

3 Select the Tools menu and then click Read Wizard, or click . 

Alternatively, you may select the Read Wizard link from the Task Pane. 

4 In the Welcome window, your scanner is listed. Beneath the scanner are the options 

you have indicated are installed on your scanner in the Scanner Properties window. 

If you would like to change any of these options, click the Setup button. 
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5 To ensure you are capturing images of scanned sheets, make sure the Imaging 

enabled checkbox is selected. 

6 If your OMR scanner has a printer 

installed and you have indicated that 

you have a printer in the OMR Scanner 

Properties window, you may optionally 

mark the checkbox for Activate Print 

Options. 

 Use the drop-down list to choose 

the grade item to print: Grade, 

Total Score or Percent Score. 

Note that some scanners can print a 

limited amount of text. Therefore, 

all three drop-down lists may not be enabled in order to ensure you do not select 

more items than can be printed with your OMR scanner. 

 For Scantron OMR scanners only: Scantron OMR scanners can print on the 
last two inches of the form only. In the Print position box, specify where 
to print the information on each sheet by entering a value of 0-27 for the 
start position. 

6 Click the Next>> button to continue.  

7 The Image Naming Conventions window appears, which allows you to specify 

options about the images that are 

automatically stored each time you 

scan forms. In the Begin image 

names with box, enter a file base 

name that the software can use to 

name the images stored for this 

form. The default base name is the 

form template name; however, you 

may use any name you like. We 

suggest using something that 

identifies to you that the images 

belong to a certain form. The 

images that are stored all begin with 

this base name and then have the 

page number (if scanning a multi-page form), date and time appended to them to 

keep track of the various images. You may optionally choose a region from the form 

template to use as the base name. The value that is collected from the form for the 

specified region is used as the base name for the corresponding stored image. For 

example, if scanning student tests you could use a Student ID region to name the 

resulting image files by student. If you leave the Begin image names with option 

blank, your images only have the page number (if applicable), date and time as the 

name of each image.  

8 In the Image target directory box, click the ellipsis (…) button to select a location 

in which to store the images for this form. You may use the default directory for 

images or select a different directory on your computer, external drive or network. 

Note: Choose the image location carefully. The images should remain in this 
location once the data is saved using the RMK format if you want to retain 
the link between the processed data and each image file. This link allows 
you to view the forms on screen as you click through the data grid, making 
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it easy to correct exceptions in your data. Therefore, you should plan ahead 
on how you will store these images when the forms are processed. 

Tip: If you are sharing files with other Remark Office OMR users, you may 
wish to save the image files on a shared network drive that all users have 
access to in the same manner (e.g., through a mapped network drive). 

9 Mark the checkbox for Save images in a subfolder based on the form 

template’s name to have the Data Center automatically create a folder in which to 

store these images. The folder name is the name of the form template and the folder 

is created in the directory you have selected in the Image target directory box. 

Tip: We recommend using the Save images in a subfolder based on the 
form template’s name feature for easier organization of image files. Use 
of this feature keeps all images associated with each form template in one 
folder for easy access. The unique date and time portion of the image names 
prevents images from being overwritten. 

10 [OPTIONAL] If desired, click the Name Builder… button to further customize the 

stored image names and locations.  

 In the Image Base Name area, you may choose to add a region from the 

processed data to the image 

base name. Choose the region 

from the drop-down list and 

then click the Add button. If 

you already added a region in 

Step 7, the Name Builder 

allows you to add additional 

regions. For example, if 

processing tests, you could add 

a Student ID that is being 

collected from the form so that 

your processed images all have 

the Student ID number in them. 

 In the Image Target Directory area, you may choose to add a region from the 

processed data to the folder structure that holds the processed images. Choose 

the region from the drop-down list and then click the Add button. For example, if 

processing tests, you could add a Test ID that is being collected from the form so 

that each student’s form images are stored in a folder containing the Test ID. 

 In the Name Builder box, click the OK button to return to the Read Wizard. 

11 In the Saved image type box, select an image type to use for storing images. The 

choices are: PCX/DCX, PDF, TIF or JPG.  

12 When saving to the PDF or TIF formats, you can choose the compression level under 

Image compression level: Uncompressed, Group 3, Group 3 2d, Group 4 and 

LZW. Group 4 creates the most compressed image (smallest file size that take up 

less space on your computer). 

13 Mark the checkbox for Save multiple page form templates as multiple page 

image files if you are scanning a multi-page form and would like all of the images 

for one complete form to be saved as one image file. Using this option creates fewer 

image files and is recommended. 

14 [Optional] If your OMR scanner has a select stacker (rejecter) and you have it 

enabled, you may click the Next>> button to configure the Reject Exceptions. 

Otherwise click the Read button to begin scanning pages. When the select stacker is 

enabled, forms that are not properly read are sent to the select stacker without any 
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data being captured. You may review the forms, correct any problems and rescan 

them if desired. Please see Section 6.3.7 for detailed information about using a 

select stacker. 

15 [Optional] If you would like to configure Review Exceptions options, click the Next>> 

button to continue. Otherwise click the Read button to begin scanning pages. Review 

Exceptions is a way to correct exception cases found on forms, such as blank and 

multiple responses (see Section 6.7 Review Exceptions for further details about using 

this feature). 

Note: Review Exceptions can also be run after all the forms are scanned if 
you prefer not to stop scanning when problems occur. 

16 Click the Read button to begin scanning pages. 

As the forms are scanned, the item or items you selected to print are printed on the 

forms. 

6.4 Batch Processing 

The Remark Classic OMR Data Center includes a batch processing feature that allows 

you to process batch header forms along with your forms. Batch header forms can 

provide further information about the group of forms being processed that make your 

data more meaningful.  

Note: Batch processing can only be used with an OMR scanner (not an 
OMR/Image scanner). Your scanner must be in OMR mode only (set up and 
set as the default under Tools|OMR Scanner|OMR Scanner Properties) 
and you will not be able to capture the scanned form images. 

For example, if you are processing student tests or course evaluations, you can process 

a batch header form containing information such as instructor name, class name, class 

section, and so forth. The batch header form is processed once, at the beginning of each 

batch. Then the forms that correspond to that batch header form are processed 

subsequently. The data from the header form is pre-pended to (added to the beginning 

of) each data record. You can start processing a new batch and its corresponding forms 

at any time. The header data is also available when it comes time to report on the data 

in Remark Quick Stats. 

To create a batch, you create form templates for the batch header form(s) and the form 

you wish to process with that batch header form (called a primary form template). You 

can use multiple batch header forms but only a single primary form template. You then 

combine these form templates into a batch file. Both forms must have unique Page IDs 

on them. Remark Classic OMR uses the page IDs to understand when a batch header 

form is being read versus a regular form. All form templates used in a batch must be of 

the same type: all simplex or all duplex. If your header sheet only has information on 

one side, create a duplex form template and put an Input region on the backside that is 

not set to read in the data grid (you will find this option in the Advanced section of the 

Input region’s properties). 

 

To use batch header forms 

1 Create or locate a form template for the form you wish to process as a batch header 

form. Ensure the form has a unique Page ID. (See Chapter 5 for further information 

about creating form templates.) 
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2 Create or locate a form template for the form you wish to process along with the 

batch header form. Ensure the form has a unique Page ID. (See Chapter 5 for further 

information about creating form templates.) 

3 In the Remark Classic OMR Data Center, ensure you have an OMR scanner (not 

OMR/Image scanner) as your default scanner. You can find this setting under 

Tools|OMR Scanner|Set as Default Scanner. OMR/Image scanners cannot be 

used for batch processing. 

4 Select the File menu and then click Batch Wizard. Alternatively, select the Batch 

Wizard link from the Task Pane. 

5 In the Batch Wizard (Step 1) 

window, select the form template that 

is being used as the primary form 

template (not the header form). This is 

the form template that corresponds to 

the form you wish to process after each 

batch header form. Click the Add 

File(s) button to add the form 

template to the Primary Form 

Template box.  

6 Click the Next>> button to continue. 

7 In the Batch Wizard (Step 2) 

window, select the form template 

corresponding to your batch header 

form. Click the Add File(s) button to 

add it to the Batch Header Form 

Templates box. You may select 

multiple batch header form templates if 

desired. 

8 Click the Next>> button to continue. 

9 In the Batch Wizard (Step 3) 

window, enter a file name for the new 

combined batch file. The Data Center 

combines the form template and batch 

header form template(s) into one batch 

file. The new combined file has a .rbf 

file extension. 

10 Click the Create Batch button to 

combine the templates and exit the 

Batch Wizard. 

When the batch file opens in the data grid, 

an orange line separates the end of the 

batch header form template regions from 

the beginning of the primary form regions.  

11 Process the first batch header form (or 

forms) by starting the Read Wizard 

and scanning forms. (See Section 6.2.2 

for detailed information about using the 

Read Wizard.) 
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12 Follow the batch header form with the forms that correspond with the group 

identified on the batch header form. 

13 When the first group of forms has been processed, insert a new batch header form 

and follow it with the corresponding forms. 

14 Continue processing forms in this fashion until you have processed all of your 

batches. In the end, you see an entire data set with all of the batch header 

information pre-pended to the records. 

Tip: If you have already created a batch file and want to open it without 
using the Batch Wizard, select the File menu and then select Open Form 
Template. Change the Files of type drop-down list to Remark Classic 
Batch Files to view available batch files.  

6.5 Overwriting Data Records 

The Remark Classic OMR Data Center allows you to overwrite scanned data. To use this 

feature, you must first select a grid row. You can then use the Read Wizard or Easy Scan 

to process new forms. 

 

To overwrite data 

1 Highlight the data grid row(s) containing the data you wish to overwrite by clicking in 

the row header(s). 

2 Select the Tools menu and then click Read Wizard, or click . 

Alternatively, you may select the Read Wizard link from the Task Pane or Easy 

Scan from the toolbar. 

3 Configure the Read Wizard options by clicking the Next>> button (see Sections 

6.2 and 6.3 for detailed information about using the Read Wizard).  

4 Place all pages to be read in the scanner and then click the Read button.  

Note: If you place more than one page in the scanner, the Data Center 
continues reading pages and placing data across the selected grid row 
sequentially. However, the Data Center does not read past the last 
highlighted grid row(s). 

5 When prompted to overwrite the data, click the Overwrite button. If you do not 

wish to overwrite the data for any reason, click the Cancel button. 

The Data Center continues processing forms until all selected pages in the data grid 

row(s) have been replaced.  

6.6 Image Viewer 

Remark Classic OMR includes an Image Viewer at the bottom of the screen that displays 

an image of each processed form. It is only visible when your default scanner is an 

OMR/Image scanner 

(Tools|OMR/Image Scanner|Use as 

Default Scanner). This window is used 

to view handwritten comments for data 

entry, as well as for reviewing 

exceptions and making corrections. The 

Image Viewer eliminates the need to 

refer back to the original paper form. To 



Remark Classic OMR User’s Guide 

104 

show and hide the Image Viewer, select the View menu and choose Image Viewer. 

The following options are available on the Image Viewer: 

 

Icon Option Description 

 

Print Click the Print button to print the current image. A 

printer window appears where you can choose and 

configure a printer. 

 
Rotate 

Image  

Click the Rotate Image icon to rotate the active image 

0, 270, 180 or 90 degrees. 

 
Zoom to 

Region on 

Selection 

Click the Zoom to Region on Selection button to have 

the colored area on the Image Viewer zoom to the 

selected region in the grid. This feature is useful when 

correcting exceptions so that you can see the exact cell 

contents where the error occurred. 

 

Zoom 

In/Zoom 

Out 

Click the Zoom In button to zoom in on the image (make 

it larger) and click the Zoom Out button to zoom out on 

the image (make it smaller). Note that Remark Office 

OMR only holds your zoom settings as you click cells in 

the data grid if you do not have Zoom to Region on 

Selection selected. 

 Close 

Image 

Viewer 

Click the X to close the Image Viewer. You can always 

reopen it using the Tools menu. 

6.7 Reviewing Exceptions 

As forms are scanned, exception cases can occur. 

Exception cases are anything that cannot be properly read. 

You should edit cells containing exception cases to validate 

your data before performing any analysis operations or 

exporting the data to another application. Each exception 

case is assigned a specific color so that you can easily 

distinguish different types of exceptions. There is a legend 

depicting the types of exceptions and their accompanying 

color in the Task Pane of the Data Center (if you cannot 

see the Exceptions Legend, click View|Exceptions 

Legend). The following table summarizes the types of exception cases and their 

possible causes. 

 

Error Type Text Color Possible Causes 

Multiple 

Responses 

(Too Many 

Responses) 

All multiple 

responses 

or MULT  

Green More than one answer selected when 

multiple responses are not permitted. 

Partially erased forms. 

Carelessly marked forms. 



 Scanning Forms   

 105 

Error Type Text Color Possible Causes 

Blank 

Responses  

(No 

Response) 

BLANK Yellow Unanswered questions. 

Response not completely filled. 

Input Regions None Light Blue Signifies an input region where you may 

type information. 

Database 

Lookup Errors 

Selected 

Responses 

Purple Response not found within the selected 

database to which the region is linked. 

Barcode 

Errors 

??? Dark 

Orange 

The OMR scanner cannot read the 

barcode. It could be misplaced on the 

form or a barcode type that the scanner is 

not capable of reading. Check your OMR 

scanner manufacturer’s user’s guide for 

information about supported barcodes. 

Required 

item 

None Exception 

Color 

Signifies that a required region was not 

properly answered. Typically, this means 

that another exception occurred, such as 

a blank or multiple response. The data 

grid cell takes on the color of this 

exception (e.g., yellow for a blank 

response), but there is no text, indicating 

that the question was required. Flagging 

required questions is particularly useful 

when you use the Review Exceptions 

function during form processing (meaning 

the processing stops so that you can 

review the problem). Note that you 

should use caution when making 

questions required and using the “Flag 

Blanks” setting. If Flag Blanks is set to 

Never, anything left blank does not 

display as a required item exception. 

Multiple 

exceptions 

None Gray Signifies that multiple exceptions were 

found in the region. For example, an OMR 

region that is also being used as a 

Database Lookup region might not be 

recognized properly. In this case, it is 

both an OMR recognition exception (e.g., 

a blank) and a Database Lookup 

exception. The gray color lets you know 

that more than one issue was found. 

 

You can resolve exception cases in one of two ways: editing individual cells or using the 

Review Exceptions feature during or after form processing. 

Note: The exception colors in the grid and links to the scanned forms (if 
using and OMR/Image scanner) are only retained if you save data to the 
Remark data format. Once you export your data to another format, if you 
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reopen that format, the grid colors are not present. Please see Section 7.6 
for detailed information about saving data. 

6.7.1 Reviewing Exceptions by Modifying Individual Cells 

One way of correcting exceptions is by individually clicking the cell you wish to change. 

You can use the drop-down arrow to select correct responses or type the desired text 

into the cell. 

Note: Editing a cell removes any exception colors. 

To reconcile cells individually 

1 Click the cell that you wish to change. 

2 If the cell contains a drop-down arrow, click the arrow and choose the correct 

response from the list. 

3 If the cell does not contain a drop-down arrow, type the appropriate response in the 

cell and press Enter or click another cell. 

Note: Each cell contains either a text box or a drop-down list box depending 
on its region type. Grid, Binary and Add OMR regions, Barcode regions, and 
Input regions that are not using the Database Lookup feature are considered 
text regions. You do not have a drop-down list box for these region types. 
All other types of OMR regions and Input regions using Database Lookup are 
considered list regions and have a drop-down list from which you can choose 
responses. 

6.7.2 Using Review Exceptions 

Remark Classic OMR provides the Review Exceptions feature as a method to validate 

data. You may use the Review Exceptions feature to review the following exception 

cases: blank responses, multiple responses, barcode errors, database lookup errors, 

required items, multiple exceptions or data entry Input regions.  

The Review Exceptions feature can be used in one of two ways: 

During Scanning: If used during the reading process, Review Exceptions provides an 

option to have the Data Center pause after encountering selected exception types. You 

can then select or enter the correct response.  

After Scanning: Review Exceptions can also be used after the forms have been 

scanned; therefore, you are not required to have the software stop processing forms 

when exceptions are encountered. When reviewing after processing, the software cycles 

through the data file to find exception cases and then allows you to make the 

appropriate changes. 

Regardless of how you use Review Exceptions, the Data Center displays a Review 

Exceptions window in the Task Pane. The following table details the available Review 

Exceptions options: 

 

Review Option Function 

Blank Responses Review when a respondent fails to answer a question. 

Multiple Responses Review when a respondent chooses more responses than were 

permitted. 

Input Regions Review when an Input region is encountered. Allows the hand 

entry of information into the data grid. 
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Review Option Function 

Database Lookup 

Errors 

Review when a database lookup error is encountered, meaning 

that the response is not located in the database that was 

specified during the form template creation process. Once you 

correct the Database Lookup exception, if you are returning 

other regions from the database, they are updated 

automatically. 

Barcode Errors Review when the scanner cannot read the barcode properly. 

Required Items Review when a required item has not been answered. 

 

To use Review Exceptions during scanning 

1 Open the correct form template. 

2 Place the completed forms in the scanner. 

3 Begin scanning forms by either selecting the Tools menu and then clicking Read 

Wizard, clicking  or clicking the Read Wizard link in the Task Pane. 

4 Make the necessary selections in the Read Wizard as it pertains to scanner 

features, printing and rejecting exceptions (see Sections 6.2 and 6.3 for detailed 

information about these screens).  

5 Click the Next>> button to go to the Review Exceptions screen (this is the final 

screen in the Read Wizard). 

6 Mark the checkbox for Activate 

Review Exceptions to turn on the 

Review Exceptions feature.  

7 In the Review Exceptions Options 

area, select the exception cases you 

would like to review during form 

processing: Multiple responses, 

Blank responses, Input regions, 

Database lookup regions, 

Barcode regions, or Required 

items. 

8 Click the Read button to begin the 

reading process. 

The Data Center begins scanning forms. When the software encounters one of the 

specified exception cases, processing stops and the Review Exceptions window appears 

in the left Task Pane. You use this window to make changes. If you are using an 

OMR/Image scanner and capturing scanned images, you can use the Image Viewer to 

assist you with the review. Please proceed to Section 6.7.2.a for detailed information 

about the Review Exceptions window. 

 

To use Review Exceptions after scanning 

1 After scanning forms, select the Tools menu and then click Review Exceptions, or 

click . Alternatively, you may select the Review exceptions link from the Data 

tab of the Task Pane. 
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2 In the Review Exceptions Options area, select the exception cases you would like to 

review: Blank responses, Multiple responses, Input regions, Database lookup 

regions, Barcode regions, or Required items. 

3 Click the Begin Review button to begin reviewing the data.  

Tip: You may process forms and clean sections of the data as you go. 
Simply begin Review Exceptions normally. Then, if you wish to process more 
forms, leave the Review Exceptions window open and process additional 
forms. When you are ready to review the newly processed forms, in the 
Review Exceptions window, click the down arrow on the Begin Review 
button and choose Begin from Last Read Operation. The Data Center 
begins reviewing data grid rows from the point where you most recently 
began processing forms. 

The Data Center searches the data for the specified exception cases. When a selected 

exception case is found, it appears in the Review Exceptions window in the left Task 

Pane. You use this window to make changes. If you are using an OMR/Image scanner 

and capturing form images, you see the image in the Image Viewer to assist you with 

cleaning the data. Please proceed to the next section for detailed information about the 

Review Exceptions window. 

Tip: When using Review Exceptions after form processing, you can review 
the entire data set or sections of the data set. To review sections of the data 
set, select the column or row header(s) of the area you wish to review, or 
highlight a group of cells. For example, if you only want to review a specific 
comment region (Input region) so that you can hand enter data, select the 
column header of the comment region so that the entire column is 
highlighted. Then click Review Exceptions; only the selected column is 
reviewed. 

There may be times when you are reviewing exceptions and the exceptions are 

legitimate, e.g., a question is left blank. By default, if you leave the exception as is, it 

always retains the color coding and exception text. If you prefer to remove the color 

coding once an item has been reviewed, go to Tools|Preferences and mark the 

checkbox for Clear exceptions after they have been reviewed in the section called 

Review Exceptions. After a cell is reviewed using Review Exceptions, the color 

disappears even if you did not make a change to the cell. If Review Exceptions is run 

again, the cell is not flagged as an exception. 

6.7.2.a Using the Review Exceptions Window 

Whether you use Review Exceptions during or after form processing, any exceptions 

found while reading display in the Review Exceptions window. The Review Exceptions 

window displays the following information: 

 

Property Function 

Search by: Row/Respondent: Use this option to search across the 

data grid in rows (by respondent). 

Column/Item: Use this option to search across the data 

grid in columns (by form template item/question). 

Response Displays the current response. Use this box to enter the 

correct response by typing the response or clicking the 

drop-down arrow and choosing a response.  



 Scanning Forms   

 109 

Property Function 

Search Forward Moves to the next exception case.  

Search Backward Moves backwards until it encounters an exception case. 

Next Row/Column Moves to the next exception case on the next form or 

column (it searches by row or column, depending on your 

selection in the Search by box). 

Previous Row/Column Moves backward one row or column until it encounters an 

exception case (it searches by row or column depending 

on your selection in the Search by box). 

Finished Ends Review Exceptions. 

Cancel  Cancels reviewing of the current page. Upon canceling 

you have three options: 

1. Restore Original Data: Cancels any changes made to 

this page during Review Exceptions and restores the 

original data. 

2. Discard Page Data: Discards the current page’s data all 

together. You may rescan the form after discarding the 

data. 

3. Cancel: Returns to Review Exceptions. 

 

To replace an exception 

1 Click the Response box down arrow (if available) to view a list of possible responses 

and then click the correct answer(s), or type the desired text into the Response 

box. The down arrow is available for Multiple, Boolean and List OMR regions, as well 

as Input regions that use Database Lookup. You may type the first few letters of a 

response and Remark Classic OMR tries to auto-fill the response for you. For Grid, 

Add and Binary OMR regions, as well as Barcode and Input regions without Database 

Lookup, you may type the appropriate response. 

Note: The displayed exception text (e.g., BLANK) and color remain in the 
output data unless you replace it. If you prefer to remove the color coding 
once an item has been reviewed but left unchanged, go to 
Tools|Preferences and mark the checkbox for Clear exceptions after 
they have been reviewed in the section called Review Exceptions. Then 
run Review Exceptions. 

2 To move to the next exception case on the 

current form, click the Search Forward button 

at the bottom of the window. You may also press 

the Enter key on your keyboard to advance to 

the next exception. 

3 To skip any remaining exception cases on the current form and move to the next 

form containing exception cases, click the Next Row/Next Column button at the 

bottom of the window. 

4 When you have completed reviewing exceptions, click the Finished button. 

Tip: If you need to return to the processed data at a later point to complete 
reviewing exceptions, save the data to the Remark (RMK) format. This 
formats save the exception case colors and links to scanned images (if you 
are using an OMR/Image scanner) so that you may continue reviewing the 
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data. If the data is exported to other formats, these colors and images are 
not included in the exported data file. See Section 7.6 Saving Data for 
complete details on saving data. 

6.8 Respondent Detection 

Remark Classic OMR includes the ability to determine which respondents’ forms have 

been processed, as well as locate duplicate respondents. This feature, called Respondent 

Detection, is used in conjunction with Database Lookup. If a region is linked to an 

external database using Database Lookup, the software provides a report of which 

respondents listed in the external database have been processed, not been processed or 

have been processed more than one time. For example, suppose you have a region on 

your form where the respondent fills in an ID number. You can link this ID number 

region to an external database that has all of the ID numbers of your expected group of 

respondents. You can then use Respondent Detection to compare IDs collected in the 

data set to IDs in the external database. Any time you use the Respondent Detection 

feature, you also have the option to return additional data from the external database if 

desired (this is not required to use Respondent Detection). When you process your 

forms, Remark Classic OMR confirms which ID numbers from the external database exist 

in the processed data. The software then provides a report showing found ID numbers, 

missing ID numbers and duplicate ID numbers. If you are returning additional regions, 

this information is also available in the report. You can save this report as a database or 

text file to use outside of Remark Classic OMR. 

 

To use Respondent Detection 

1 Setup a form template that uses the Database Lookup feature. See Section 5.3.9 for 

complete details on using Database Lookup. 

2 Process forms using the scanner. See Sections 

6.2 and 6.3 for information about using the 

Read Wizard to process forms. 

3 Once the forms have been processed and the 

data cleaned, select the Tools menu and then 

click Respondent Detection, or click 

. The Respondent Detection 

wizard appears. 

4 From the Regions available for detection 

drop-down list, select the form template region 

you wish to use for detection. 

5 If the region is linked to a database containing 

additional regions, you may optionally select 

those regions from the Database Region List. 

Use the green arrow to move the desired 

regions into the Additional Regions box. Any 

regions moved to the Additional Regions box 

are also used for detecting respondents. 

6 Click the Next>> button to continue. The 

Detection Results window appears.  

7 Use the Detection Results window to view 

your results. The main region on which you are 

basing the detection is listed first. You then see 
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a Detected column that marks the values that were detected. The Duplicates 

column is next, which marks any duplicate values that are found. After the 

Duplicates column, you see any additional return regions from the external 

database that you selected in Step 5 (if you selected any). 

8 If desired, use the Export button to save the results to an external file. You may 

click the Export button to export the entire set of results, or use the arrow on the 

Export button to select which portions of the results to export. The export options 

are as follows: 

 

Option Function 

Export Exports all results (region, detected, missing, duplicates 

and additional regions). 

Export 

Missing 

Exports only the missing respondents, those that exist in 

the external database but were not processed as part of 

the data file. 

Export 

Detected 

Exports only the detected respondents, those that both 

exist in the external database and were processed as part 

of the data file. 

Export 

Duplicates 

Exports only the duplicate respondents, those that appear 

more than once in the data file. The software only detects 

duplicate entries that have also been verified as existing in 

the linked database. 

Print Results Prints all results to the default printer on your computer. 

 

9 Click the Close button to return to the Remark Classic OMR Data Center. 

6.9 Reviewing Duplicate Responses 

Remark Classic OMR includes a feature to detect duplicate responses even when not 

using the Database Lookup feature with Respondent Detection, as described in the 

previous section. The Review Duplicates feature allows you to choose any region in the 

data grid in which to search for duplicates. When a duplicate entry is found, you are 

prompted to take one of four possible actions: review the duplicates, keep only the first 

duplicate record, keep only the last duplicate record or delete all duplicate records. 

During the review process, the data grid is automatically sorted on your duplicate 

identifier region so that you can easily review the data. This feature is useful if you 

accidentally process a form multiple times, or someone fills out a form multiple times 

when this is not permitted. 

If you are using an OMR/Image scanner and capturing form images during scanning, 

when reviewing duplicates you see the scanned form images in the Image Viewer to 

assist you with making a determination in how to handle the duplicate entries. 

 

To use Review Duplicates 

1 Open a form template and scan forms. 
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2 Once the data is collected and cleaned, select the Tools menu and then click 

Review Duplicates, or click , to launch the Review Duplicates Task 

Pane. Alternatively, select Review duplicates from the Task Pane. 

3 In the Review Duplicates Task Pane on the left side of the window, use the 

Unique respondent identifier drop-down list to choose a region to check for 

duplicate entries. 

4 Click the Search button to begin the search for duplicate entries. The gold bar 

underneath The Unique respondent identifier box tells you whether duplicates 

were found. The data is sorted based on the duplicates that are found.  

5 Determine the action you wish to take. If you want to review the duplicates before 

taking action, choose Review duplicate records in the Action drop-down list and 

then click the Execute button. Remark Classic OMR highlights any sets of duplicate 

records it finds. You may use the green arrows in the Navigate area to move 

between records. The Next Record arrow takes you to the next duplicate record 

within the same group. The Next Group arrow takes you to the next group of 

duplicates (you may have more than one set of duplicates within the same region). 

Similarly, the Previous Record arrow takes you back to the previous duplicate 

record within the same group, and the Previous Group record takes you back to the 

previous group of duplicate records. 

6 If you have chosen to review the duplicate records, you have two options. You can 

choose a specific record and delete it manually by clicking the Delete button. Or, 

you may click the Finish button and then review the region again. Then to perform a 

mass function, in the Action drop-down list, choose the appropriate action: Keep 

only first duplicate records, Keep only last duplicate record or Delete all 

duplicate records. Any one of these three choices applies to all sets of duplicate 

records within the region. 

7 If you choose any action that causes records to be deleted, you receive a warning 

message to ensure that you want to delete the records. Note that once the records 

are deleted, they cannot be recovered (unless you process the forms again). If you 

are sure you want to proceed, click the Yes button. The requested action is taken. 

8 If you wish to search for more duplicates in other regions, repeat steps 3 through 7. 

9 When you are finished reviewing duplicates, click the Finish button. 

Click the Back arrow underneath Review Duplicates to return to the full Task 

Pane. 

6.10 Graph Viewer 

Remark Classic OMR includes a Graph Viewer at 

the bottom of the screen to view quick results of 

processed data. The graph viewer displays a graph 

of the data being processed, indicating the 

frequency of each response chosen (an item 

analysis). Click in any cell containing data to view 

a graph of the responses. Please note that the 

graph viewer is not grading data and that it may 

slow down the processing speed. To show and hide 

the Graph Viewer, select the View menu and 

choose Graph Viewer. The Graph Viewer has 

many options, which are summarized in the following table:  
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Icon Option Description 

 Copy Click the Copy button to copy the graph to the Windows 

clipboard. The graph can then be pasted into another 

application. 

 

Print Click the Print button to print the current graph. If you 

drop down the arrow on the Print icon, you can choose 

whether to print in monochrome or color (if your printer 

supports it). 

 

Graph 

Title 

Toggle the Graph Title icon to turn the title over the 

graph on and off. Click the down arrow on the Graph Title 

icon to choose what to display: None (no title), Question 

Name, or Question Text. Please note that the font size 

used for the Graph Title updates automatically based on 

the amount of text being displayed. 

 

Graph 

Type 

Click the Graph Type icon to cycle through the various 

graph types. Alternatively, use the drop-down arrow on 

the Graph Type icon to choose a graph type: 3D Bar, 2D 

Bar, 3D Pie, 2D Pie, 3D Area, 2D Area and Line. 

 

Graph 

Data 

Click the Graph Data icon to cycle through the various 

graph options. Alternatively, use the drop-down arrow on 

the Graph Data icon to choose what to graph: Frequency 

(base the Y axis on the data set using frequencies), 

Percent Auto Scale (allow Remark Classic OMR to choose 

the best Y axis percentage scale for your data) or Percent 

Standard Scale (use a standard percentage scale for the 

Y axis, such as 0-100%). 

 Close 

Graph 

Pane 

Click the X to close the Graph Viewer. You can always 

reopen it using the Tools menu. 

6.11 Test Import Wizard 

Remark Classic OMR has the ability to import test information from the ExamView 

software from eInstruction. ExamView is used to generate tests. The test information 

can be imported into Remark Classic OMR to streamline the grading process. The test 

questions, answer items and answer key are all imported with the test. When correlating 

test information to state standards or text book objectives, Remark Classic OMR can also 

report on how well students are mastering those standards and objectives. These items 

are reported as learning objectives in the Remark Classic OMR analysis. Remark Classic 

OMR also has the ability to import multiple versions of tests (to minimize student 

cheating). 

Note: The Test Import Wizard can only be used with an OMR scanner (not 
an OMR/Image scanner). Your scanner must be in OMR mode only (set up 
and set as the default under Tools|OMR Scanner|OMR Scanner 
Properties) and you will not be able to capture the scanned form images. 

Utilizing ExamView files can be broken down into the following steps: 
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       •   Create the test in ExamView 

       •   Export the test to the XML format 

       •   Import the test in Remark Classic OMR via the ExamView Wizard 

       •   Scan the tests 

       •   Grade the tests 

Note: The ExamView Import Wizard relies on XML files from ExamView. 
Only legacy versions of ExamView support the XML export. This feature 
remains in Remark Classic OMR for any ExamView legacy users who still 
want to use this feature. 

6.11.1 Creating Tests in ExamView 

The first step in this process is to create a test in ExamView (version 3.5 or later is 

supported). Please see the ExamView user’s documentation for detailed instructions on 

creating tests. Please note that you may also generate multiple versions of a test, if 

desired. Multiple versions of a test minimize the risk of student cheating by scrambling 

the order of the questions on the page(s). Once a version of the test has been created, 

ExamView offers a scramble option to rearrange the order of the questions. When test 

order is scrambled, each test should be saved separately with a test ID to differentiate 

versions. 

Note: Remark Classic OMR can import tests with randomized questions.  
However, it cannot import tests with randomized answer choices. 

6.11.2 Exporting Tests from ExamView 

Once a test is created, it must be exported in XML format for Remark Classic OMR to 

import. 

Note: If your version of ExamView does not support exporting to XML, you 
will not be able to use the ExamView Import Wizard. 

 

To export tests 

1 Open the test in ExamView. 

2 Select the File menu and then click Export. 

3 In the File name box, type the desired file name. 

4 In the Save as type box, select the ExamView XML (.xml) format. 

5 Click the Save button to save the file. 

Note: If you are using multiple versions of a test, you must export each 
version to a separate XML file. 

The test files are now ready to be imported into Remark Classic OMR. Remark Classic 

OMR creates a new form template and a grade template that apply to your test. 

6.11.3 Importing ExamView Files in Remark Classic OMR 

After exporting tests from ExamView, you may open them in Remark Classic OMR using 

the Test Import Wizard. These tests include the answer key and can optionally include 

learning objectives so that tests can easily be graded and student mastery of specific 

objectives can be measured. Remark Classic OMR can read multiple choice, true/false 

and yes/no questions only. All other question types are ignored during the import 

process. 
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To import ExamView test files 

1 If not already running, start the Remark Classic OMR software. 

2 Select the Tools menu, click Test Import and then click ExamView Import 

Wizard. 

3 Click the Next>> button to begin the wizard. 

4 In the Step 1 window, select the Remark Classic OMR form template that represents 

the form you will be scanning. 

5 Click the Next>> button to continue. 

6 In the Step 2 window, select the ExamView file that you exported. If using multiple 

test versions, select the first version. Mark the checkboxes for Include Learning 

Objectives, National Objectives, State Objectives and/or Local Objectives to 

have Remark Classic OMR include this information in the reports. By including the 

objectives, you are able to see how students are performing against these measures. 

Each objective is reported in the analysis as a separate learning objective of the 

main test. 

Note: The Include Objectives options are enabled based upon the test 
information you exported from ExamView. 

7 Click the Next>> button to continue. 

8 In the Step 3 window, select other versions of this test that you have generated in 

ExamView. Use the Add button to add test versions; use the Remove button to 

remove unwanted tests. If you are only using one version of the test, skip this step. 

9 Click the Next>> button to continue. 

10 If importing multiple versions of a test, the Step 3A window appears. In this 

window, select a question from the Question drop-down list that is used to identify 

the version of the test. You must have a question in your form template that 

identifies various versions of a form template. 

11 In the Step 4 window, enter a name for the new form template and grade template 

for this import process. You may either use the default name that Remark Classic 

OMR provides, or click the ellipsis (…) next to each template name to enter new file 

names.  

12 Click the Build button to continue. 

13 Click the Finish button to open your new template and begin collecting data. 

Upon completion of the Test Import wizard, Remark Classic OMR generates a new form 

template and answer key to be used to scan and grade completed tests. 

6.11.4 Scanning Completed Tests 

 Once you have imported your ExamView files, you may scan the completed tests. 

 

To scan tests 

1 Upon finishing the ExamView Import wizard, your template opens automatically. If 

the template is not open, select the File menu, click Open Template and then 

select the template you previously created with the ExamView wizard. 

2 Click the Tools menu and then click Read Wizard. 

3 Place the completed tests in your scanner and configure the Read Wizard with the 

desired options. Click the Read button when you are ready to start scanning forms. 

Tip: Please see earlier sections of this chapter for detailed information about 
scanning options. 
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Once all of the forms are scanned you are ready to grade the test. We recommend 

saving the data to use at a later point in time. 

 

To save the data 

1 Select the File menu and then click Save Data. 

2 In the File name box, enter a name for the data file. 

3 Choose a file type in the Save as type list. 

4 Click the Save button to save the data. 

Tip: Please see Chapter 7 for more detailed information about saving data. 

6.11.5 Grading Tests 

Once all of the forms have been scanned, you may grade the test using Remark Classic 

OMR’s Easy Grade or Grade Wizard functions. Note that because you imported the test 

from ExamView, all of the necessary test information has already been saved, including 

the answer key and learning objectives. Therefore using Easy Grade will typically provide 

the needed test results. You may use the Grade Wizard to reconfigure any of your 

grading options. 

Tip: Please see the Remark Quick Stats User’s Guide PDF under 
Start|Programs|Remark Classic OMR 4|Documentation for more information 
about test grading in Remark Quick Stats. 

 

To grade tests 

1 Select the Tools menu, click Analysis and then click Easy Grade or Grade Wizard. 

2 If using Easy Grade, the Remark Quick Stats window opens to show your grade 

results. If using the Grade Wizard, Remark Quick Stats launches the Grade Wizard 

based on the definitions from the ExamView file. You may modify any of the 

information by clicking the Next>> button in the Grade Wizard window and making 

your changes. 
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Working with Your Data  

Chapter 7 

7.1 Overview 

This chapter explains the basics of data manipulation and using the data grid in the 

Remark Classic OMR Data Center, and includes the following: 

 Understanding the data grid (Section 7.2) 

 Editing the data grid (Section 7.3) 

 Sorting data (Section 7.4) 

 Spell checking data (Section 7.5) 

 Saving data (Section 7.6) 

 Printing data (Section 7.7) 

 Emailing data (Section 7.8) 

 Send wizard (Section 7.9) 

 Opening grid data (Section 7.10) 

 Logging changes (Section 7.11) 

The Remark Classic OMR software requires a form template file for each type of form 

that you want to process. For each form template created, there is a corresponding data 

grid. The Remark Classic OMR Data Center uses a data grid to store data recognized 

from forms. The data read from one form are considered a single record and display in 

one grid row. Each column in the grid represents one variable or question on the form, 

as defined in the form template. 

7.2 Understanding the Data Grid 

The Remark Classic OMR data grid window employs a spreadsheet style view of the form 

template to display recognized data. When 

a form template is open, each grid column 

corresponds to an item or question on the 

form, as it was defined in the form 

template. Hover your mouse over any 

column header to see information 

pertaining to the specific item (question). 

The grid employs two cell types to store 

data: text and list. The cell type depends 

on the kind of region being used. Barcode 

regions, Input regions that do not contain 

Database Lookup information and OMR 

regions set to the Grid, Add or Binary Data Type use text cells. Text cells are used to 

type information manually. All other OMR regions and Input regions that utilize Database 

Lookup information use list cells. List cells contain a drop-down list of possible answer 
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items (labels) as they are defined in the form template. See Section 7.3.2 Changing Cell 

Contents later in this chapter for information on how to edit individual cells.  

If an individual region contains more than one question, by default the corresponding 

column headers also contain question numbers. For example, Eval2 would correspond to 

the second item of a region titled Eval. If you entered individual Question Names in the 

OMR region properties of the form template, these Question Names appear instead (see 

Section 5.3.2.b Question Names for more detailed information about Question Names). 

7.3 Editing the Data Grid 

The data grid window behaves like a spreadsheet. You can cut, copy and paste 

selections to and from the grid. Additionally, you can change the contents of individual 

grid cells by clicking in a cell. This section explains the basics of manipulating data within 

the grid and includes the following: 

 Making selections 

 Changing cell contents 

 Cutting, copying, pasting and deleting 

 Resizing, inserting and deleting rows 

 Using find and replace 

7.3.1 Making Grid Selections 

The following table lists the different methods for making selections in the grid: 

 

Selection Area Method 

Single Cell Click in it. Use the mouse, tab or arrow keys to move from cell 

to cell. Double clicking within a cell puts you in edit mode. 

Multiple Cells Click the upper, left-hand corner of the desired selection, drag 

the mouse to the lower, right-hand corner and release. 

Single Column Click the column header. 

Multiple Columns Click and drag a range of column headers or click a beginning 

column header, press and hold the Shift key, and then click an 

ending column header. 

Single Row Click the row header. 

Multiple Rows Click and drag a range of row headers or click a beginning row 

header, press and hold the Shift key, and then click an ending 

row header. 

Entire Grid Select the Edit menu and then click Select All, or click the 

upper, left-most grid header cell. 

7.3.2 Changing Cell Contents 

The data grid allows in-cell editing by clicking within a particular cell. The grid employs 

two cell types to store data: text and list. The cell type depends on the kind of region 

being used. Each cell changes to either a text box or list box depending on its region 

type. Grid, Add and Binary OMR regions, barcode regions and Input regions without the 

use of Database Lookup are considered text regions. You do not have a drop-down box 

for these region types. All other types of OMR regions and Input regions using Database 
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Lookup are considered list regions and do have a drop-down box from which you can 

choose responses, as they were defined in the form template (labels). 

 

To change the contents of a text cell 

1 Select the cell by clicking within its borders. 

2 Type the desired cell contents into the cell and press Enter. 

 

To change the contents of a list cell 

1 Select the cell by clicking within its borders. 

2 Click the down arrow on the cell’s list box.  

3 Click the correct response. 

Note: An asterisk appears next to selected responses. 

4 If more than one response is permitted, repeat steps 2 and 3 to select more than 

one response. 

Editing a cell removes any exception case colors that may have been present (e.g., 

yellow for a BLANK response).  

7.3.3 Cutting, Copying, Pasting and Deleting 

The Remark Classic OMR template grid supports normal Windows clipboard functions: 

cut, copy and paste. In addition, it supports the Paste Special command, which allows 

you to copy the contents of one cell and then paste it into multiple cells. 

Tip: This section assumes an understanding of how to make grid selections 
in order to select grid cells. See Section 7.3.1 Making Grid Selections for 
detailed information about this topic. 

 

To cut data from the grid 

1 Select an area to cut. Select the Edit menu and then click Cut, click or press 

Ctrl+X. 

The selected data are cut from the grid and placed on the Windows clipboard. 

 

To copy grid data 

1 Select an area to copy.  

2 Select the Edit menu and then click Copy, click or press Ctrl+C. 

The selected data are copied to the Windows clipboard. 

 

To paste data from the clipboard to the grid 

1 Select the area to which you want to paste.  

2 Select the Edit menu and then click Paste, click or press Ctrl+V. 

The data on the Windows clipboard are pasted into the selected grid cell(s). 
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Note: You do not need to select the same amount of space in the grid as 
the amount of space you copied to the clipboard. 

 

To use Paste Special 

1 Select a single cell containing the data you wish to copy.  

2 Select the Edit menu and then click Copy, or click . 

3 Select the cells in which you want to paste the data. 

4 Select the Edit menu and then click Paste Special. 

The data on the Windows clipboard are pasted into the selected grid cells. 

 

To delete grid data 

1 Select the area that you want to delete.  

2 Select the Edit menu and then click Delete, right click in a cell and select Delete, 

click the toolbar button for Delete , or press the Delete key. You may also 

delete an entire grid row by clicking the row header or clicking in a cell in the row 

and then right clicking and selecting Delete Row or by selecting the Edit menu and 

then clicking Delete Row. 

7.3.4 Resizing, Inserting and Deleting Rows 

You can change the number of rows contained in each data grid by adding rows to the 

end of the grid, inserting rows into the grid or deleting rows from the grid. Note that 

during scanning, the grid expands as needed to hold your data; you do not need to 

manually add rows to the grid. 

Tip: This section assumes an understanding of how to make grid selections 
in order to select grid cells. See Section 7.3.1 Making Grid Selections for 
detailed information about this topic. 

 

To insert row(s) into the grid 

1 Select the desired insertion point by clicking a grid cell.  

2 Select the Edit menu and then click Insert Row to insert a row, or click . 

Alternatively, select Shift+Insert on the keyboard, or right click within the cell and 

choose Insert Row. The row is inserted above your current selection point. 

Note: You may also select multiple rows to insert the same number of rows 
above the selection (e.g., select two complete rows to insert two rows above 
the highlighted rows). 

 

To delete rows from the grid 

1 Select the rows to delete.  

2 Select the Edit menu and then click Delete Row, or click . Alternatively, 

select Shift+Delete on the keyboard, or right click the mouse and then select 

Delete Row. 
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Tip: You may delete multiple rows by selecting more than one grid row. Use 
the row headers to select the rows. 

7.3.5 Freezing Columns and Rows 

You can freeze specific columns and rows in the data grid so that as you scroll, the 

frozen columns and rows are still visible. For example, if grading exams, you might want 

to freeze the Student Name column so you can see the students as you scroll. You can 

freeze a maximum of 10 columns and rows. 

 

To freeze columns and rows 

1 With your data set open, select the View 

menu. 

2 To freeze rows, select Freeze Rows. Then 

choose the number of rows to freeze. 

3 To freeze columns, select the Freeze 

Columns. Then choose the number of 

columns to freeze. 

Your selected rows/columns are frozen and 

delineated with an orange line. If you wish to 

return to normal viewing, select the View 

menu and choose Unfreeze Rows or Unfreeze Columns. 

7.3.6 Using Find and Replace 

The Remark Classic OMR Data Center provides find and replace commands for locating 

and replacing text. You can search for each occurrence of characters, including 

uppercase and lowercase letters, whole words and parts of words. 

By default the Data Center searches the entire data grid when performing a find and 

replace operation. However, you can search a specific region by highlighting the area 

you would like to search prior to using Find and Replace. (See Section 6.3.1 See Making 

Grid Selections.) 

 

To find text  

1 Select the Edit menu and then click 

Find, or click . 

2 If searching for text, enter the search 

text in the box titled Find what.   

3 Select the other options you want to use 

to control the search. 

 

Search Option Result 

Case sensitive Mark this checkbox to make the search case sensitive. 

Include partial 

matches 

Mark this checkbox to search for part of the text (does not 

require the entire contents of the cell to match what you have 

entered in the Find what box). 

Search for values If searching for numeric data, mark this checkbox to search for 
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Search Option Result 

greater than or 

equal to specified 

value 

numeric values that are greater than or equal to the value you 

have typed in the Find what box. 

Search selected 

block only 

Mark this checkbox to search in the selected cell(s) only. 

 

4 Click the Find Next button. 

If Remark Classic OMR locates a match, the grid scrolls to display the cell where the 

match is found. 

5 Make any necessary changes to the grid. 

6 Click Find Next to continue searching. 

7 When you have completed searching the data, click the Close button. 

 

To find and replace text  

1 Select the Edit menu and then click 

Replace, or click . 

2 Enter the search text in the box titled 

Find what.  

3 Select the other options you want to use 

to control the search. 

 

Search Option Result 

Case sensitive Mark this checkbox to make the search case sensitive. 

Include partial 

matches 

Mark this checkbox to search for part of the text (does not 

require the entire contents of the cell to match what you have 

entered in the Find what box). 

Search for values 

greater than or 

equal to specified 

value 

If searching for numeric data, mark this checkbox to search for 

numeric values that are greater than or equal to the value you 

have typed in the Find what box. 

Search selected 

block only 

Mark this checkbox to search in the selected cell(s) only. 

 

4 To replace items located in the search, enter the replacement text in the box titled 

Replace with. 

5 Choose one of the following search commands by clicking the appropriate button: 

 

Search Command Result 

Find Next Locate the next item meeting search criteria. 

Replace Locate and automatically replace the next item meeting 
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Search Command Result 

search criteria. 

Replace All Locate and automatically replace all items meeting search 

criteria. 

 

6 When you have completed searching the data, click the Close button. 

7.4 Sorting Grid Columns 

Columns in the data grid can be sorted according to the values in a specific region. Data 

can be sorted in ascending or descending order. For example, you can sort your data by 

ID number or respondent name. There are two ways to sort data: right clicking a column 

header or using the menus. 

 

To sort data by right clicking the mouse 

1 Select the header of the column by which you want to sort the data (the entire 

column is highlighted). (See Section 7.3.1 Making Grid Selections.)  

2 Right click the column header, click Sort and then click Ascending or Descending.  

The entire data set is sorted according to your selection. 

 

To sort data using the menus 

1 Select the Edit menu and then click Sort, or click .  

2 In the Primary sort key box, use the drop-down list to choose a region on which to 

base the sort operation. 

3 Mark the checkbox for Descending if you 

want the data to be sorted in descending 

order. Leave this checkbox blank to sort the 

data in ascending order. 

4 If you want to sort the data by more than 

one criterion, select the appropriate regions 

on which to sort in the Secondary sort 

key and Third sort key boxes.    

5 When finished selecting regions, click the 

Sort button. 

The entire data set is sorted according to your selection(s). 

7.5 Spell Checker 

Remark Classic OMR includes a Spell Checker that checks Data Entry Input regions, 

Barcode regions and OMR regions for misspellings. The spell checker works from the 

dictionary in the Remark Classic OMR Preferences. To choose a dictionary, select 

Tools|Preferences|File Storage Locations, or click . 
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To use the Spell Checker 

1 Select the Tools menu and then click Perform spell check, or click . 

2 In the Spell Checker window, choose the desired options: 

 

Option Description 

Search Input 

regions 

Mark this checkbox to perform spell checking on Input regions 

where manual data entry is expected. 

Search barcode 

regions 

Mark this checkbox to perform spell checking on Barcode 

regions. 

Search OMR 

regions 

Mark this checkbox to perform spell checking on OMR regions. 

Ignore words with 

numbers 

Mark this checkbox to skip spell checking any numeric text. 

Ignore words in  

upper case 

Mark this checkbox to skip spell checking on words that begin in 

upper case. 

Ignore words in 

mixed case 

Mark this checkbox to skip spell checking on any words that use 

mixed case capitalization. 

 

3 Click the Start button to begin the search. When an item matches your specified 

criteria, the Spell Checker shows you the flagged word and offers suggestions if 

possible. You may choose a suggestion or 

modify the flagged word and then choose 

Change or Change All to make the 

modification. You may also choose Add to add 

the word to your dictionary so that it is not 

flagged again. Alternatively, you may choose 

Ignore or Ignore All to keep the word as is, 

and if choosing Ignore All, not have it flagged 

again during this search. Choose Cancel to 

stop the Spell Checker. 

4 When the Spell Checker is finished searching 

the grid, it alerts you that it is complete. Click 

the OK button to return to the main Spell Checker window. 

5 Click the Finished button to complete the Spell Checker process. 

7.6 Saving Data 

You can save the data in the data grid to dozens of different file formats. The Remark 

file format was specifically designed to optimize the data storage process in the Remark 

Classic OMR software.  

Tip: When working with data in Remark Classic OMR, use the Remark file 
format (RMK). This is the only format that preserves the link between the 
data and the exception colors and stored images* (*if using an OMR/Image 
scanner). Export data to other formats after you have collected and cleaned 
all of your data. 
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When saving data, you have the option of using Save Data or Save Data As. The Save 

Data option can be used to save a data set for the first time or to overwrite the current 

data set. The Save Data As option allows you to save the current data set with new 

parameters (e.g., new file name, different directory, different file type, etc.)  

The following table lists the different save file formats, their extensions and a brief 

description: 

 

File Format Extension Description 

Remark RMK Remark Classic OMR format; saves grid exception 

colors and image links* (*OMR/Image scanners 

only) 

SQL Server 2000-

2005 

MDF Microsoft SQL Server format 

Oracle 7.4 and 

later 

*.* Oracle format 

Access 2007-2010 ACCDB Microsoft Access 2007 and 2010 format (only 

available if the Access 2007 or 2010 database 

engine is installed) 

Access 2000-2003 MDB Microsoft Access 2000-2003 format 

Access 95-97 MDB Microsoft Access 95-97 format  

Access 2.0 MDB Microsoft Access 2.0 format 

Access 1.0 MDB Microsoft Access 1.0 format  

Excel 2007-2010 XLSX Microsoft Excel 2007 and 2010 format (only 

available if the Access 2007 or 2010 database 

engine is installed); existing files can only be 

appended, not overwritten 

Excel 97-2003 XLS Microsoft Excel 97-2003 format 

Excel 95 XLS Microsoft Excel 95 format  

Excel 4.0 XLS Microsoft Excel 4.0 format 

Excel 3.0 XLS Microsoft Excel 3.0 format  

Questionmark QSF Perception Questionmark format (save only) 

SPSS SAV SPSS 16 format 

SPSS Legacy SAV SPSS 6 format 

Survey Pro SRV Survey Pro standard format (Apian Software) 

Survey Pro STL STL Survey Pro STL format (Apian Software) 

ASCII [commas] ASC Comma delimited ASCII 

ASCII [tabs] ASC Tab delimited ASCII 

Spreadsheet 

[commas] 

TXT Comma delimited ASCII with quotes around non-

numeric data 
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File Format Extension Description 

Spreadsheet 

[tabs] 

TXT Tab delimited ASCII with quotes around non-

numeric data 

Survey System DAT The Survey System format (Creative Research 

Systems) 

dBase V DBF dBase V format 

dBase IV DBF dBase IV format 

dBase III DBF dBase III format 

Paradox 5.X DB Paradox 5.X format; existing files may only be 

overwritten (there are no append options) 

Paradox 4.X DB Paradox 4.X format; existing files may only be 

overwritten (there are no append options) 

Paradox 3.X DB Paradox 3.X format; existing files may only be 

overwritten (there are no append options) 

Lotus WK3 WK3 Lotus Works 3 format; existing files may only be 

overwritten (there are no append options) 

Lotus WK1 WK1 Lotus Works 1 format 

Lotus 1-2-3 WKS Lotus 1-2-3 format 

LXR Test MRG LXR Test format 

Report RPT Fixed format ASCII, cell text padded or truncated 

to specified record length 

Data Interchange 

Format 

DIF Standard format using file header and data section 

CCI Assessment DAT CCI Assessment format; existing files may only be 

overwritten (there are no append options) 

XML XML Extensible Markup Language format 

HTML HTM Hypertext Markup Language  

ODBC *.* Open Database Connectivity  

Custom  ASC, TXT Custom Text format 

Database Update XLS, XLSX, 

MDB, 

ACCDB 

Updates an existing database with new data (e.g., 

adds missing information, overwrites existing 

information). 

ODBC Database 

Update 

*.* Updates an existing ODBC database with new data 

(e.g., adds missing information, overwrites 

existing information). 

 

To save grid data 

Before saving data to another data format, we suggest saving a copy of the data to the 

Remark (RMK) format to preserve exception colors. Once your project is complete, you 

may delete or archive the RMK file. 
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When exporting to a specific format (e.g., Access, Excel, etc.) make certain your data 

meets the format's specific requirements (see Start|Programs|Remark Classic OMR 

4|Documentation|Remark Classic OMR 4 Supported File Formats for more information). 

1 After processing forms, select the File menu and then click Save Data, or click 

, if saving the data set for the first time or to overwrite the data. Click Save 

Data As to save the data with new parameters. 

Note: Clicking the toolbar button for Save Data overwrites the current data 
set. 

If saving for the first time or using Save Data As, 

the Save Data window opens, allowing you to 

choose a file name, a file type, the directory in which 

you would like the file saved and Advanced saving 

options. 

2 Select the desired directory location using the 

Look in drop down box. 

3 Enter a name in the box titled File name. 

4 Select the desired output format in the box titled 

Save as type. 

5 If saving to a database type that supports 

internal table names, enter a table name in the 

box titled Table name. 

Note: Each database format has different table name limitations. Refer to 
your database documentation for information on table name limitations. 
When saving to a database where one or more regions are too small to hold 
the data being saved, Remark Classic OMR attempts to resize the database 
column so that it can hold the data being saved. 

6 When exporting, you can save the column headers for certain formats by selecting 

the Save headers checkbox. The Save headers checkbox only displays when 

appropriate. 

7 Click the OK button to save the file. 

7.6.1 Advanced Saving Options 

When saving data to certain formats, you have the option of setting advanced 

parameters. The Advanced Save window shows you each question and pertinent 

information about the question (region). You can then choose options about the region 

that you want included in your database. This feature can be useful if you are saving to 

a database format that has specific requirements. You can temporarily override the form 

template settings by using the advanced parameters.  

Note: Setting parameters in the Advanced Save window does not make any 
changes to the form template. 

The following advanced features are available (note that what is available depends on 

the file format selected): 
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Option Description 

Include Mark this checkbox to include the region (question) in the data file.  

Name Use this column to enter a new region name to be used in the 

exported data file, if desired. Changing the region name in this 

window does not affect the region’s name in the form template. 

Data Type Use this column to change the data type for this question. 

Size Use this column to specify a region size for the data for this question. 

Do not specify a size that is smaller than what is in your data. 

 

To use advanced saving options 

1 Select the File menu and then click Save Data As.  

The Save Data window opens, allowing you to choose a file name, a file type, the 

directory in which you would like the file saved and advanced saving options. 

2 Select the desired directory location using the Look in drop down box.  

3 Enter a name in the box titled File name. 

4 Select the desired output format in the box titled Save as type. 

5 If saving to a database type that supports internal table names, enter a table name 

in the box titled Table name. 

6 Click the Advanced button. 

7 [Optional] If you have previously saved a 

definition file for this data set, click the Load… 

button to locate the appropriate INI file 

containing your settings. Otherwise, continue to 

Step 8 to build a new data file. 

8 Make any desired changes in the Include, 

Name, Data Type or Size columns. 

Note: If using an OMR/Image scanner and 
capturing form images, you can save the 
path of the form images or the actual form 
images to the file by using the Advanced 
options. Scroll to the bottom of the Names list to mark the form images. If 
you want the actual image to be stored, change the data type to binary. If 
the data type is not binary, the path to the images is stored. 

9 [Optional] If desired, click the Save… button to save the settings to a configuration 

file (.ini file). You can then open this configuration file for future save operations with 

this same form template. This feature can save time when saving future data sets. 

10 Click the OK button to save the changes. 

11 In the Save Data window, click the OK button to save the data. 

7.6.2 Custom Format 

The Custom format allows you to create a customized text file. This format is useful for 

exporting data into a database that has very specific requirements. The format can also 

be used to break apart rows of data into multiple rows. For example, if you are 

processing an attendance sheet containing records for multiple students in a single row, 

you can use the Custom format to separate the data into one record for each student. 
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Note: When saving to an existing custom data file, regions are not matched 
by region name; instead they are matched by position in the data file. 
Ensure that the data you are saving matches the existing custom wizard 
data file before appending new records. 

The following table summarizes the screens and options that are found in the Custom 

Wizard and the corresponding descriptions of each option: 

 

Custom 

Wizard 

Screen 

Option Description 

Step 1: 

Configuration 

File 

Configuration File Use the Browse… button to locate a 

previously saved configuration file that you 

created when using the Custom Wizard 

(optional). 

Step 2: File 

Type and 

Start Row 

File Type Delimited: Regions are separated by a 

delimiter, such as a comma or tab. 

Fixed Width: Regions are aligned at fixed 

character spaces. 

 Automatically format 

questions that allow 

multiple responses 

Mark the Automatically format 

questions that allow multiple 

responses checkbox to automatically set 

formatting for questions that allow more 

than one answer choice (e.g., (1,5,12) 

becomes 1 5 12). 

 Start export at row Enter the row number that you want to 

use as the first record in the exported data 

file. All rows from this point forward are 

included in the data file. Enter 0 to include 

region names as the first record. 

Note: Step 3 changes based on whether you select Fixed Width or Delimited for the 

File Type in Step 2. Items that correspond with each type are noted. 

Step 3: 

Column 

Delimiter and 

Text Qualifier 

(Delimited 

Regions Only) 

Column Delimiter Select the character to use to separate the 

columns in the data file: Comma, Tab, 

Semi-colon, Space, Other.  

 Text Qualifier Select the character to use to qualify text. 

Textual responses are encapsulated within 

these characters. Options include: None, 

double quote (“), single quote (‘). 

Step 3: 

Region Width 

and Padding 

(Fixed Width 

Regions Only) 

Region Size The maximum number of characters 

allowed in the region.  
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Custom 

Wizard 

Screen 

Option Description 

 Start Position The position, in characters, where the 

region begins. For example, if your region 

sizes are 25, the first region starts at 

position 1 and the second region starts at 

position 26 (25 characters later). 

 Pad With Enter the character to use to pad the 

region (typically a space character). 

 Pad On Select whether to pad the region on the 

left or right of the text that resides in the 

region.  

Step 4: 

Record 

Delimiter 

Record Delimiter Sets the delimiter to be used to separate 

records: Carriage Return/Line Feed, 

Carriage Return, Line Feed, Other. 

Step 5: 

Region 

Exclusion and 

Record Breaks 

Exclude Mark the Exclude checkbox to exclude the 

region listed from the data file. 

 Break After Mark the Break After checkbox to start a 

new record in the data file after this 

region.  

 Every Record Mark the Every Record checkbox to 

include the region in every record of the 

data file (e.g., repeat the region for each 

record). 

 

To use the Custom format 

1 Select the File menu and then click Save Data As.  

The Save Data window opens, allowing you to choose a file name, a file type, the 

directory in which you would like the file saved and advanced saving options. 

2 Select the desired directory location using the Look 

in drop down box. 

3 Enter a name in the box titled File name. 

4 Select the Custom (*.ASC, *.TXT) format in the 

box titled Save as type. 

5 Click the OK button. 

6 If you have used the Custom Wizard format 

previously and have a saved configuration file that 

applies to this data set, click the Browse… button 

to locate the configuration file. Otherwise, click the 

Next>> button to begin creating a new 

configuration file. 

7 Select the options you wish to use to customize 



Working with Your Data 

 131 

your data set. Each option is described in the previous table. Use the Next>> button 

to navigate from screen to screen. 

8 When finished, click the Finish button. 

9 When the Save Text Export Configuration window appears, click the Yes button 

to save your settings to a file that you can use later when saving data. If you do not 

wish to save this configuration file, click the No button. If you are not saving the 

configuration file, the data file is saved when you click the No button. Continue with 

the next steps if you are saving the configuration file. 

10 [Optional] If saving the configuration file, in the Save Text Export Configuration 

As box, select a location in which to save the configuration file in the Save in box. 

 Enter a name for the file in the File name box. 

 Leave the Save as type box set to Text Export Configuration Files (*.tec). 

 Click the Save button to save the file and create the data file. 

7.6.3 Database Update Format 

The database update format allows you to update an existing database based on the 

data in the Remark Classic OMR data grid (Access or Excel). The data are matched to 

the existing database by the region names and a mapping process. When saving to this 

format, you map the regions in the Remark Classic OMR data to the regions in the 

existing database. You also choose a question to be the record identifier. If data 

corresponding to the unique record identifier exists in the database it is updated with 

what is in Remark Classic OMR when the identifiers are matched. For example, if you are 

conducting a survey that collects demographic information, and include for a respondent 

identifier on your form, you could use the identifier as the record ID to update an 

external database using the Database Update format. During the save process, Remark 

Classic OMR attempts to find the Student ID in the database and then updates the data 

regions associated with that student. If the student ID is not found, you have the option 

of adding the record to the external database. 

 

To use the Database Update format 

1 Select the File menu and then click Save Data As.  

The Save Data window opens, allowing you to choose a file name, a file type, the 

directory in which you would like the file saved and advanced saving options. 

2 Select the desired directory location using the Look in drop down box. 

3 Select a file to update, which fills the File name box. 

4 Select the Database Update (*.ACCDB, *.MDB, *. XLSX, *.XLS) format in the 

box titled Save as type. 

5 Click the OK button. A wizard opens to walk you through the next few steps. 

6 If you have used the Database Update format previously and have a saved 

configuration file that applies to this data set, click the Load… button to locate the 

configuration file. Otherwise, go on to step 7. 

Note: You are prompted to save a configuration file with your settings after 
saving the data. 

7 In the Update Options area, select the number of records contained in each row of 

the data set (e.g., if multiple respondents’ answers are on a single form, you would 

have more than one record per data row). If each record in the data set corresponds 

to one respondent’s submission, use 1 for the value. 
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8 In the Update Options area, mark the Add database records for missing record 

identifiers checkbox if you would like to create new records in the database when 

an identifier is not found. 

9 In the Region Mapping area, map the regions from Remark Classic OMR to the 

regions in the external database. The target database regions are listed in the first 

column, called Database Region, and the Remark Classic OMR regions (questions) 

are listed in the second column, called Grid Column. Use the down arrow in the 

Grid Column section to choose the appropriate region to map to the corresponding 

database region. 

Note: Remark Classic OMR attempts to automatically map the regions 
based on the region/region names. Review the 
region mapping first and then make changes if 
necessary.  

10 Choose a region or regions to use as an identifier 

by marking the appropriate checkbox next to the 

region name. The identifier regions are used to 

match data from Remark Classic OMR to the 

external database. If a match is not found, the 

data is not added to the database (unless you 

selected this feature in step 8) and you receive a 

message. You may select more than one region 

to use as the identifier, in which case the data 

from all identifier regions must be a match for 

the record to be updated in the external 

database. 

11 Click the OK button to save the data.  

12 If any problems are encountered when updating the selected file, a message appears 

detailing the problems. If the database is updated successfully you receive a 

message telling you how many records were updated and asking you if you want to 

save the configuration file for later use. If you do wish to save the file, click the Yes 

button. Enter a file name and choose a location for the .ini file in the Save window 

that appears. 

Note: The ODBC Database Update format works just as described 
previously, but you can save to a database using an ODBC connection. 

7.6.4 Save All Data 

The Save All Data feature allows you to save multiple open data sets to one combined 

file. This feature is useful if you need to store and analyze data both on an aggregate 

and individual level. By maintaining separate files you can easily report on an individual 

data set. However, by combining the individual data files into one, you can also report 

on the data as a whole without having to open each data set individually any time you 

want to analyze all the data. 

 

To use Save All Data 

1 Select the File menu and then click Save All Data.  

The Possible Data Sets window opens, allowing you to choose the open files you wish 

to include in the save operation. 

2 Mark the checkboxes of all data sets you wish to include in the save operation. You 

may use Select All to select all data sets in the list. Please note that the data set 
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must correspond to the active form 

template in order for it to be included in 

the save operation.  

3 If needed, use the up and down arrow 

buttons to move data sets. The order in 

which the files appear on the Possible 

Data Sets window is the order in which 

they are saved. 

4 If any of the open data sets had changes made to them prior to the save operation 

and were not saved, you receive a warning. The warning lets you know that during 

the save operation, all of the data sets being combined are closed. Click Yes to 

continue or No to cancel the operation, allowing you to go back and save the 

individual files first. 

 

 

 

 

 

 

Note: If you made changes to your original data files and want those 
changes to be saved, save the individual files before using Save All Data. If 
you choose to ignore the warning, the changes to the individual data sets 
are not saved.

5 Click the OK button. 

6 Select the desired directory location using the Look in drop down box. 

7 Enter a name in the box titled File name.  

8 Select the desired file format in the box titled Save as type. 

9 Click the OK button to save the file. 

All selected data sets are saved to the file specified and closed in the data grid. The 

combined data set is opened. 

7.6.5 Save Data Builder 

The Save Data Builder option allows you to fine tune the data saving process by building 

dynamic file, folder and table names. Using the Data Builder options, you can use 

information directly from your data set to name the data file, storage folder or table 

within the file.  

 

To use Save Data Builder 

1 Select the File menu and then click Save Data Builder.  

The Save Data Builder window opens, allowing you to choose a file name, a file type, 

the folder in which you would like the file saved 

and table name saving options. The first step is to 

choose a file type and location for the data. 

2 Under Base Save File and Type, click the 

Browse… button to select a file name and 

format for your data. 
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3 Select the desired folder location using the Look in drop down box. 

4 Enter a file name in the File name box. If choosing a database format, also enter a 

Table Name. 

5 Choose the file format in the Save as type box. 

6 Click the OK button. 

7 Next, go to the File Name area of the window. The name you set in the previous 

screen is listed as the file name. You may modify it by typing in the box. You may 

also use the drop-down list to add a region from the processed data to the file base 

name. Choose the region from the drop-down list and then click the Add button. For 

example, if processing student test forms, you 

could add a student name region that is being 

collected from the form so that your data file 

name includes the name of each student (each 

time the student name changes, a new data 

file is created). 

8 In the Folder Name area, you may choose to 

add a region from the processed data to the 

folder structure that holds the data file. Choose 

the region from the drop-down list and then 

click the Add button. Continuing with our 

example, if processing student test forms, you 

could add a teacher name or ID region that is 

being collected from the form so that your folder names include teacher identifiers. 

Each student’s data from the data set would be stored in a separate folder based on 

teacher name or ID number. 

9 If using a database format that requires a 

table name, go to the Table Name area of 

the window. The name you chose for Table 

Name when initially setting up the file in Step 

4 is listed as the Table Name. You may modify 

it by typing in the box. You may also use the 

drop-down list to add a region from the 

processed data to the file base name. Choose 

the region from the drop-down list and then 

click the Add button. Continuing with our 

example, if processing student test forms, you 

could add a student name region that is being 

collected from the form so that your data file 

table name includes the name of the students. 

10 Click the OK button to save the data. 

The data file(s) is saved based on your specifications. If you named files or folders based 

on data from your data set, you may see separate folders and files. For folders, there is 

a separate folder for each unique entry in your data set. Within each folder you find the 

appropriate data file. For data files, the data file names begin with the region data you 

chose during the set up process. 
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7.7 Printing Data 

The Remark Classic OMR Data Center allows you to print grid data on any Windows-

supported printer. 

 

To print the grid data 

1 From the Remark Classic OMR Data Center, select the File menu and then click 

Print, or click  to display the Print 

Options window. 

2 Click the Properties… button to choose and 

configure a specific printer. Otherwise, the 

default printer is used. 

3 In the Print Display section, mark the 

checkboxes corresponding to the items you 

wish to print: Column headers, Row 

headers, Grid lines, Border. 

4 In the Margins section, choose the print 

margins in inches. The default settings are 1 

inch margins on the top and bottom, and ½ 

inch margins on the left and right.  

5 In the Header and Footer area, optionally enter text to be displayed in the header 

and footer of the page. 

6 In the Print Range area, select a page range to print: Active sheet (currently 

selected form template) or All sheets (all open form templates). 

7 In the Print Color area, select whether to print the page in Color or Black & white 

(the color setting only applies if the selected printer is color-enabled).  

8 Click the Print button to print the grid. 

7.8 Emailing Data 

7.8.1 Email Overview and Set Up 

You can email data files in their native formats or in ZIP format from the Remark Classic 

OMR Data Center. You have a choice of using Microsoft Outlook 2007 or 2010 or your 

own SMTP server to send the emails. We cover both methods here.  

Note: When emailing data, a local copy of the data is not saved. If you need 
to save a data file, make sure you take that step in addition to using the 
email function. Saving data is covered in Section 7.6. 

 

Your SMTP Server:  

If you use your own SMTP server, you must have a valid SMTP server set up 

independently of Remark Classic OMR. SMTP stands for Simple Mail Transfer Protocol 

and is the Internet standard for transmitting email across networks. It is likely your 

organization has a running SMTP server already set up. You just need to find out general 

information about the server. You will likely need to consult with your network/email 

administrator to obtain information about your SMTP server. Please use the following 

table as a guide to have your administrator provide the proper settings: 
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Option Description 

SMTP Server This is the name, address or IP address of the mail server. 

SMTP port The SMTP port is usually 25 but may vary with your email server. 

Enable a 

secured 

(SSL) 

connection 

If desired, use a secure connection by marking the checkbox for 

Enable a secured (SSL) connection. SSL encrypts data as it is 

transmitted. Your SMTP server must be configured to use SSL in order 

for this feature to work. 

Use the 

default 

credentials of 

the currently 

logged in 

user 

If you need to use authentication for your SMTP server, you can enter 

credentials or use those of the user logged in to the computer. Mark 

the Use the default credentials of the currently logged in user 

checkbox to utilize the user’s credentials (e.g., the person logged in 

when sending the emails from Remark Classic OMR). Otherwise, 

continue to the next step to enter specific credentials. 

Username 

and 

Password 

If authentication is required, and you are not using the credentials of 

the currently logged in user, enter the Username and Password, as 

supplied by your network/email administrator. 

Throttle rate The throttle rate adds a delay while sending emails. The default 

setting is 500ms, meaning that one email is sent every 500 ms (in 

other words, two emails are sent per second). Throttling emails keeps 

the SMTP server from being overloaded when sending large numbers 

of emails. Unless you plan on sending hundreds of emails at one time, 

the default setting of 500 is likely fine. 

 

Microsoft Outlook: 

If you plan to use Microsoft Outlook 2007 or 2010, you do not need to set up anything 

outside of telling the software to use Outlook.  

 

To choose Microsoft Outlook or your own SMTP server in Remark Classic OMR: 

1 From the Remark Classic OMR Data Center, 

select the Tools menu and then click 

Preferences. 

2 Click the Email link in the left Task Pane. 

3 Under Email client, choose Default to use your 

own SMTP server. Choose Outlook to use 

Microsoft Outlook 2007 or 2010. If you are using 

Outlook, simply click OK. If you are using the 

Default email client, continue to the next step. 

4 If you have chosen the Default client, click the 

SMTP Server button. 

5 Fill in the settings as described in the previous 

table. You will need your network/email 

administrator to provide this information to you. 

6 Click the OK button. 
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7.8.2 Using Email to Send Data Files 

Once you have set up your email preferences in Tools|Preferences (see previous 

section), you are ready to start emailing data files. 

 

To email data files using Microsoft Outlook 

1 After processing forms, saving data or opening a data file, select the File menu and 

click Email. Note: If you choose the toolbar option or Task Pane option to send 

email, the file is always in zipped format. 

2 Choose Data as Attachment to attach the native file to an outgoing email message. 

Choose Data as ZIP Attachment to first zip the native data file (compress it into a 

.zip file) and then attach it to an outgoing email. 

Note: Your organization, or the recipient’s organization, may have 
restrictions on the types of files that can be sent via email. If the file is 
restricted and you do not zip it, the email may never reach the intended 
recipient. If you are unsure whether the selected file type is restricted, use 
the ZIP option. The recipient must have a Zip program to unzip the file and 
view it. 

The Email Data window appears. 

3 Choose the File name, file format using 

Save as type and if using a database 

format, the Table or Sheet name. You do 

not need to specify a location for the file, 

as it is automatically attached to an email 

message. 

4 Click the OK button. 

Outlook automatically opens a new email 

message with your file attached. You may now 

enter recipients and a message and send your 

file. Note if you chose to zip the file, it appears 

with a .zip extension. 

 

To email data files using your SMTP server 

1 After processing forms, saving data or 

opening a data file, select the File menu and 

click Email. Note: If you choose the toolbar option or Task Pane option to send 

email, the file is always in zipped format. 

2 Choose Data as Attachment to attach the native file to an outgoing email message. 

Choose Data as ZIP Attachment to first zip the native data file (compress it into a 

.zip file) and then attach it to an outgoing email. 

Note: Your organization, or the recipient’s organization, may have 
restrictions on the types of files that can be sent via email. If the file is 
restricted and you do not zip it, the email may never reach the intended 
recipient. If you are unsure whether the selected file type is restricted, use 
the ZIP option. The recipient must have a Zip program to unzip the file and 
view it. 

The Email Data window appears. 
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3 Choose the File name, file format using Save as 

type and if using a database format, the Table 

or Sheet name. You do not need to specify a 

location for the file, as it is automatically 

attached to an email message. 

4 Click the OK button. 

5 The Email Message window appears. 

6 Enter the recipient(s)’ email address in the To 

box. Separate multiple recipients with a semi 

colon (;). 

7 Enter your return email address in the From box.  

8 Accept the default subject, which is the file 

name, or enter a new one in the Subject box. 

9 In the rich text box, type your message to the 

recipient(s). You may use the toolbar to format 

your message as desired.  

10 If you have already configured your SMTP 

settings in Remark Classic OMR, as described in 

section 6.8.1, you do not need to click the SMTP 

Settings tab. However, if you have not entered 

your SMTP settings or need to modify them, click 

the SMTP Settings tab to enter the SMTP server 

information. You will need to obtain this 

information from your network/email 

administrator. 

11 Click Send when you are ready to send your 

message. 

Your email message is automatically sent. If delivery problems occur, they are routed to 

the address listed in the From box of the email message (this may depend on how your 

SMTP server is configured to handle message failures). 

7.9 Send Wizard 

The Remark Classic OMR Send Wizard allows you to send files via FTP (file transfer 

protocol) or email. As opposed to the Email option in Remark Classic OMR, the Send 

Wizard provides more advanced tools for creating profiles so that data and reports can 

be automatically sent to other destinations. Send Wizard configurations can be utilized 

from the Automation Wizard when automating Remark Classic OMR functions. Send 

Wizard configuration files can be set up ahead of time to look for files in directories and 

then either send them to an FTP site or email them. For example, you could set up an 

Automation Wizard file that does the following: Opens a form template, scans forms, 

saves the data to a file, grades the data and then launches a Send Wizard file to move 

the grades to an FTP server or send a report via email. If you wish to use email with the 

Send Wizard you must have an SMTP (simple mail transfer protocol) server set up 

independently of Remark Classic OMR. You will need to obtain the settings from your 

network/email administrator for that SMTP server and enter them into the Remark 

software. When setting up the Send Wizard profile, you can send files via FTP and/or 

email. For the purposes of this documentation, we will break out the steps for each, but 

please note you can do both operations at the same time. 



Working with Your Data 

 139 

Tip: If you are not familiar with the Automation Wizard, which is used to 
automate basic Remark Classic OMR functions, please read the Remark 
Classic OMR 4 Automation Wizard User’s Guide.pdf file, located in your 
Remark Classic OMR installation directory (Start|Programs|Remark Classic 
OMR 4|Documentation). 

 

To use the Send Wizard to send files via FTP 

1 Select the Tools menu and click Send Wizard. 

2 If you have already saved a Send Wizard configuration file, click the Load… button 

to retrieve it. Otherwise, continue to step 3 to begin a new Send Wizard 

configuration.  

3 Under File Name Pattern Matching, using the Browse… button, chose a location 

on your computer or network for the software to search when looking for files to 

send.  

4 Under Custom Filter, choose the extension of the file to send. For example, if you 

are sending Excel 2010 files to an FTP site, you 

would enter “.xlsx.” If you want all files found in 

the specified directory to be included in the 

send operation, enter “*.*”. 

5 Click the first Add button to move your 

selections into the configuration window. 

6 [Optional] If you have additional files not 

generated by Remark Classic OMR or very 

specific files that you want to include, click the 

Add button next to the File list window. 

7 [Optional] In the Open window, select the files 

you wish to include. 

8 Once you have all the files you wish to include 

visible in the File list window, click the Next 

button. 

9 Under Send type, choose FTP to send the files to an FTP site.  

10 [Optional] If you would like to compress the files first, mark the checkbox for 

Compress Files into a Zip Archive. 

11 [Optional] If using compression, choose whether 

you want each file in its own zip file (Create a 

separate zip archive for each file) or to 

combine all files into one zip file (Create a 

single zip archive for all files). 

12 [Optional] If creating a single zip file, enter a 

name for the file in the Zip file name box. 

(Note: when archiving each file individually, the 

zip file is automatically named with the file 

name.) 

13 [Optional] If you would like the contents of the 

zip file to be encrypted and password protected, 

mark the checkbox for Encrypt and Password 

Protect the Zip Archive(s). 

14 [Optional] Enter the password required to open the zip file in the Zip password box. 
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15 [Optional] If you would like to delete the original files stored locally once the files are 

sent via the Send Wizard, mark the checkbox for Delete local files after 

successful send. If a problem is encountered sending the files, the original files are 

not deleted. 

16 Click the Next button to continue. 

17 On the FTP Server settings window, tell Remark Classic OMR about your FTP server. 

If you have run the Send Wizard previously and set up an FTP site, you can select it 

from the FTP sites drop-down list. If you do not have any sites listed, set one up by 

continuing with the following steps. The following options are available when setting 

up an FTP server. 

 

Basic Tab: 

 

Option Description 

Server Address This is the internet address of the FTP server. If you enter a 

DNS name for the server (e.g. ftp://myftpsite.com ), then 

the prefix ftp:// is required. If you enter an IP address 

(e.g., ftp://12.34.56.78), then the prefix ftp:// is optional 

(e.g., just enter 12.34.56.78). 

Target Directory You can, optionally, specify a target directory on the FTP 

server. The target directory holds the file once it is 

transferred to the server. 

Note: No verification is performed to check that the 

directory path you enter is valid on the server. To verify 

connectivity to the server, use Test Connectivity on the 

FTP - Basic screen. 

Username This is the username that is required for FTP login on the 

FTP server. The person responsible for your FTP server 

should be able to provide this information to you. 

Password This is the password that is required for FTP login on the FTP 

server. The person responsible for your FTP server should be 

able to provide this information to you. 

Transfer Type Select either Binary or ASCII. As a guideline, use ASCII 

only for plain-text files and Binary for all other types. The 

default value is Binary. 

File Exists Action Select an action to perform if the uploaded file already exists 

on the FTP server. You can choose to overwrite the existing 

file or choose not to upload the file at all. 

 

Advanced Tab: 
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Option Description 

Restrict upload file 

size 

You can choose to restrict the size of files are uploaded by 

the FTP service. Any files that are placed in the Source 

Directory (defined under the Basic tab) that exceed this 

value in size is not uploaded to the FTP server. 

File Lock Timeout When a file is copied (or moved) to the Source Directory 

(defined under the Basic tab), the actual copy (or move) 

operation takes time to perform on any operating system. 

For very large files, this time period can be several seconds, 

or even minutes. While this takes place, the file cannot be 

uploaded with FTP, since the file is “incomplete” (in this 

folder) until the copy (or move) operation has finished. The 

FTP Service attempts to gain exclusive use (“locked” use) of 

the file before uploading it. In this way, the software can 

determine that a copy (or move) operation has finished, and 

therefore, that the file is complete and ready for upload. 

Use this File Lock Timeout setting to control the time period 

for which the FTP Service attempts to lock the file before 

giving up and recording an upload failure. 

 

18 Enter the details for your FTP server as described 

in the previous table. 

19 Use the Test Connectivity button to ensure you 

can connect to the FTP server using the supplied 

information. 

20 [Optional] If you would like to save your FTP 

server information, click the Save button. The 

FTP Server name is automatically used to name 

your settings. 

21 Click the Finish button to complete the setup. 

Optionally, you may click the arrow on the Finish 

button and choose to Save your configuration 

without executing it, Execute the configuration without saving it (e.g., to test it) or 

Save and Execute to both save and execute the configuration in one step. 

22 When clicking Finish, you are prompted to 

save your Send Wizard Configuration file. It is 

recommended that you save the file so you 

may use it again in the future or call it up 

from the Automation Wizard. The file can be 

saved anywhere on your computer or network 

and has an XML file extension.  

23 To save the Send Wizard Configuration File, 

click the Yes button, choose a location and 

provide a file name. Ensure that you 

remember where the files are stored so that 

you can locate them later. 

24 If you do not wish to save the Send Wizard 

Configuration File, click the No button. The configuration executes. 
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Once the wizard closes, the action is active. Remark Classic OMR looks in the 

directory(ies) specified for files to send to your FTP site. If any problems occur, you are 

notified. Otherwise, the requested action is executed and a notice appears letting you 

know the operation was successful. 

 

To use the Send Wizard to send files via email 

1 Select the Tools menu and click Send Wizard. 

2 Under File Name Pattern Matching, chose a 

location on your computer or network for the 

software to search when looking for files to 

send. 

3 Under Custom Filter, choose the extension of 

the file to send. For example, if you are 

sending Excel 2010 files to an FTP site, you 

would enter “.xlsx.” If you want all files found 

in the specified directory to be included in the 

send operation, enter “*.*.” 

4 Click the first Add button to move your 

selections into the configuration window. 

5 [Optional] If you have additional files not 

generated by Remark Classic OMR or very specific files that you want to include, click 

the Add button next to the File list window. 

6 [Optional] In the Open window, select the files you wish to include. 

7 Once you have all the files you wish to include visible in the File list window, click 

the Next button. 

8 Under Send type, choose Email to send the files via email.  

9 [Optional] If you would like to compress the files first, mark the checkbox for 

Compress Files into a Zip Archive. 

Note: Your organization, or the recipient’s organization, may have 
restrictions on the types of files that can be sent via email. If the file is 
restricted and you do not zip it, the email may never reach the intended 
recipient. If you are unsure whether the selected file type is restricted, use 
the ZIP option. The recipient must have a Zip program to unzip the file and 
view it. 

10 [Optional] If using compression, choose 

whether you want each file in its own zip file 

(Create a separate zip archive for each 

file) or to combine all files into one zip file 

(Create a single zip archive for all files). 

11 [Optional] If creating a single zip file, enter a 

name for the file in the Zip file name box. 

(Note: when archiving each file individually, 

the zip file is automatically named with the file 

name.) 

12 [Optional] If you would like the contents of the 

zip file to be encrypted and password 

protected, mark the checkbox for Encrypt and 

Password Protect the Zip Archive(s). 

13 [Optional] Enter the password required to open the zip file in the Zip password box. 
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14 [Optional] If you would like to delete the original files stored locally once the files are 

sent via the Send Wizard, mark the checkbox for Delete local files after 

successful send. If a problem is encountered sending the files, the original files are 

not deleted. 

In the Email Message window, format your email.  

15 Enter a recipient(s) address in the To box (separate 

multiple recipients with a semi colon (;). 

16 Enter the sender’s email address in the From box.  

17 Enter a subject of your choice in the Subject box. 

18 Compose your message. You may use the toolbar 

buttons to add formatting to your message. 

19 Click the SMTP Settings tab to enter information 

about your SMTP Server. You must have a valid 

SMTP server set up independently of Remark 

Classic OMR. SMTP stands for Simple Mail Transfer 

Protocol and is the Internet standard for 

transmitting email across networks. It is likely your 

organization has a running SMTP server already set 

up. You just need to find out general information 

about the server. You will likely need to consult with 

your network/email administrator to obtain 

information about your SMTP server. Please use the 

following table as a guide to have your 

administrator provide the proper settings: 

 

Option Description 

SMTP Server This is the name, address or IP address of the mail server. 

SMTP port The SMTP port is usually 25 but may vary with your email server. 

Enable a 

secured (SSL) 

connection 

If desired, use a secure connection by marking the checkbox for 

Enable a secured (SSL) connection. SSL encrypts data as it is 

transmitted. Your SMTP server must be configured to use SSL in 

order for this feature to work. 

Use the default 

credentials of 

the currently 

logged in user 

If you need to use authentication for your SMTP server, you can 

enter credentials or use those of the user logged into the 

computer. Mark the Use the default credentials of the 

currently logged in user checkbox to utilize the user’s 

credentials (e.g., the person logged in when sending the emails 

from Remark Classic OMR). Otherwise, continue to the next step 

to enter specific credentials. 

Username and 

Password 

If authentication is required, and you are not using the credentials 

of the currently logged in user, enter the Username and 

Password, as supplied by your network/email administrator. 
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Option Description 

Throttle rate The throttle rate adds a delay while sending emails. The default 

setting is 500ms, meaning that one email is sent every 500 ms 

(in other words, two emails are sent per second). Throttling 

emails keeps the SMTP server from being overloaded when 

sending large numbers of emails. Unless you plan on sending 

hundreds of emails at one time, the default setting of 500 is likely 

fine. 

 

20 Enter the settings as described in the previous table. 

21 Click the Finish button to complete the setup. Optionally, you may click the arrow 

on the Finish button and choose to Save your configuration without executing it, 

Execute the configuration without saving it (e.g., to test it) or Save and Execute to 

both save and execute the configuration in one step. 

22 When clicking Finish, you are prompted to save your Send Wizard Configuration file. 

It is recommended that you save the file so you 

may use it again in the future or call it up from 

the Automation Wizard. The file can be saved 

anywhere on your computer or network and has 

an XML file extension.  

23 To save the Send Wizard Configuration File, 

click the Yes button, choose a location and 

provide a file name. Ensure that you remember 

where the files are stored so that you can 

locate them later. 

24 If you do not wish to save the Send Wizard 

Configuration File, click the No Once the wizard 

closes, the action is active.  

Remark Classic OMR looks in the directory(ies) specified for files and sends them to your 

designated recipients. If any problems occur, you are notified. Otherwise, the requested 

action is executed. 

7.10 Opening Data 

The Remark Classic OMR Data Center can open data saved in dozens of different file 

formats. We specifically designed the Remark file format to optimize the data storage 

process in the Remark Classic OMR software. The software is designed to work with data 

that is collected using a form template in Remark Classic OMR. Therefore, you must first 

open a form template and then open the corresponding data file. Once the data file is 

opened, you can save it to another format or location, or use Remark Quick Stats to 

analyze it. 

Tip: When working with data in Remark Classic OMR, use the Remark file 
format (RMK). This format saves exception case colors and links to scanned 
images* (*OMR/Image scanners only). Only save data to other formats 
when exporting. 

The following table lists the different file formats the Data Center can open, their 

extensions and a brief description: 
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File Format Extension Description 

Remark RMK Remark Classic OMR format; includes grid 

exception colors and scanned image links* 

(*OMR/Image scanners only) 

Web Survey RWD Remark Web Survey format 

SQL Server 2000-

2005 

MDF Microsoft SQL Server format 

Oracle 7.4 & later *.* Oracle format 

Access 2007-2010 ACCDB Microsoft Access 2007/2010 format (only available 

if the Access 2007 or 2010 database engine is 

installed) 

Access 2000-2003 MDB Microsoft Access 2000-2003 format 

Access 95-97 MDB Microsoft Access 95-97 format  

Access 2.0 MDB Microsoft Access 2.0 format 

Access 1.0 MDB Microsoft Access 1.0 format  

Excel 2007-2010 XLSX Microsoft Excel 2007/2010 format (only available if 

the Access 2007 or 2010 database engine is 

installed) 

Excel 97-2003 XLS Microsoft Excel 97-2003 format 

Excel 95 XLS Microsoft Excel 95 format  

Excel 4.0 XLS Microsoft Excel 4.0 format 

Excel 3.0 XLS Microsoft Excel 3.0 format  

SPSS SAV SPSS 16 format 

SPSS Legacy SAV SPSS 6 format 

Survey Pro SRV Survey Pro standard format (Apian Software) 

ASCII [commas] ASC Comma delimited ASCII 

ASCII [tabs] ASC Tab delimited ASCII 

Spreadsheet 

[commas] 

TXT Comma delimited ASCII with quotes around non-

numeric data 

Spreadsheet 

[tabs] 

TXT Tab delimited ASCII with quotes around non-

numeric data 

dBase 5.0 DBF dBase 5.0 format 

dBase IV DBF dBase IV format 

dBase III DBF dBase III format 

Paradox 5.X DB Paradox 5.X format  

Paradox 4.X DB Paradox 4.X format 

Paradox 3.X DB Paradox 3.X format 

Lotus WK4 WK4 Lotus Works 4 format (open only) 



Remark Classic OMR User’s Guide 

146 

File Format Extension Description 

Lotus WK3 WK3 Lotus Works 3 format 

Lotus WK1 WK1 Lotus Works 1 format 

Lotus 1-2-3 WKS Lotus 1-2-3 format 

LXR Test MRG LXR Test format 

Report RPT Fixed format ASCII, cell text padded or truncated 

to specified record length 

Data Interchange 

Format 

DIF Standard format using file header and data section 

CCI Assessment DAT CCI Assessment format 

XML XML Extensible Markup Language format 

HTML HTM Hypertext Markup Language  

ODBC *.* Open Database Connectivity  

Custom  ASC, TXT Custom Text format 

 

To open grid data 

1 Open the correct form template.  

2 Select the File menu and then click Open Data, or click , to display the 

Open Data window. Alternatively, use the Open data file link from the Task Pane. 

3 Select a file from the list. Use the Look in box 

to locate saved data files. You may need to 

adjust the Files of type list to find the desired 

file. 

Note: The data contained in the file must 
correspond to the currently active form 
template or an error may occur. 

4 If opening a database file, select the 

appropriate table from the Table name drop-

down list. 

5 Click the OK button to open the data file. 

Caution: When opening a database file 
type, the Data Center attempts to match grid column headers (region 
names) to the database's field names. If any column headers cannot be 
matched, an error occurs. Grid column headers do not need to appear in the 
same order as the database fields. 
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7.11 Opening Scantron Score Data Files 

Remark Classic OMR imports data files generated from the Scantron Score Test Scoring 

Machine. This scanner scans tests and produces results on a USB drive. You may pull the 

data off of the USB drive so that it can be analyzed in Remark Quick Stats. 

Note: Using the Scantron Score Test Scoring Machine is not covered in this 
user's guide, as it is not part of the Remark Classic OMR software. Please 
see your Scantron Score user's guide for information about using the test 
scoring machine. 

 

To import Scantron Score data 

1 Place the USB drive containing the test data from the Scantron Score Test Scoring 

Machine in the computer's USB drive. 

2 In Remark Classic OMR, select the File menu and then click Import Scantron 

Score Data. Alternatively, select the Import Scantron Score data option from the 

Task Pane. The Scantron Score Data 

File Import window appears. 

3 If a USB drive containing data from the 

Scantron Score is in the drive and 

recognized, Remark Classic OMR 

automatically lists any files it finds. 

Alternatively, you may click the 

Browse... button to locate your Scantron 

Score data files if they are not on a USB 

drive. Scantron Score data files have a 

.ITD extension. 

4 If multiple files are found/selected, you 

can choose which ones to include in the 

operation by checking their boxes or using the Select All and Deselect All buttons 

(by default, all files are selected). 

5 Optionally, mark the checkbox for Remove data files from the USB drive after 

import if you wish to delete the data files from the USB drive once they are 

imported. The original .ITD file(s) will no longer exist and are not recoverable. The 

data will reside in the Remark Classic OMR grid, where you can save it to any 

supported format. Note that this option applies only to files located on a USB drive, 

not files from the computer's file system. 

6 Optionally, mark the checkbox for Automatically load tests results (last data file 

only) if you wish to have Remark Classic OMR perform an Easy Grade operation on 

the open data. This operation only includes the last data file in the list. If you wish to 

include all data files, do not use this option. Instead once the data is loaded into the 

grid, use the Grade Wizard option in Remark Quick Stats. 

7 Click the Import button to import the data. 

If you selected to automatically load rest results, the data loads and Remark Quick Stats 

launches, performing an Easy Grade operation. If you did not select to automatically 

load test results, the data is loaded and you may now save the data (File|Save Data As) 

or perform grading operations. 
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7.12 Data Center Logging 

As changes are made in the Remark Classic OMR Data Center, they can optionally be 

logged, allowing you to see what changes were made and who made them. Logging is 

turned on and off in the Remark Classic OMR Preferences. It can only be turned off if 

you know the password used when turning on the feature. Changes made to the data 

grid (edits, review exceptions, review duplicates, clipboard, open, save, etc.) are logged 

in a password protected Access database in the following location: 

Windows XP: C:\Documents and Settings\All Users\Application Data\Gravic\Remark 

Classic OMR\4\Change Logs (where C is the drive on which Remark Classic OMR is 

installed). 

Windows Vista/Windows 7: C:\ProgramData\Gravic\Remark Classic OMR\4\change log 

(Note you must have the option to show hidden folders and files on to see this location). 

When the database is initially created, it uses the date of creation as the filename. From 

that point forward, all changes to all templates/data files are stored in that Access file as 

long as the feature is turned on. Data file types, exception flags and actions are all listed 

with a numeric equivalent in the database. The additional tables in the database explain 

each of the numeric values. When a database reaches 10MB in size, a new database is 

created the next time Remark Classic OMR is opened. 

Four tables are created in the Access file: 

 

History Table: 

 ID: Numeric index for each action. 

 Template File: The name of the form template that corresponds to the data file 

that was changed. 

 Log Action: The action taken such as opening data, reviewing exceptions, etc. 

 Data File: The name of the data file that was changed. 

 Table Name: The name of the table, if applicable, that was changed 

 File Type: The file type of the file that was changed. Note that this is a numeric 

value that corresponds to the items in the Save as type drop-down list in the 

Save Data window. For example, the Remark (RMK) format is the second item in 

the list, so it is listed as 2. (See File Types Table below for a complete listing.) 

 Column Number: The column in the data that was changed. 

 Row Number: The row in the data that was changed. 

 Respondent ID: The respondent ID, if applicable, that was changed. 

 Question Name: The question name (region name) of the applicable question that 

was changed. 

 Question Text: The question text, if applicable, of the corresponding question 

that was changed. 

 Original Value: The original value stored prior to making any changes. 

 Original Flag: If an exception flag existed originally (e.g., BLANK) it is listed. Note 

that this is a numeric value that corresponds to the items in the Exceptions 

Legend in the Data Center. For example, a MULT is the first item in the list, so it 

is listed as 1. (See Flag Types Table below for a complete listing.) 

 New Value: The text that was entered during the change process. 

 New Flag: If a new exception flag was applied, it is listed. (See Flag Types Table 

below for a complete listing.) 
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 System Name: The name of the system where Remark Classic OMR was running 

during the change process. 

 Windows User: The Windows name of the logged in user who made the changes. 

 Change Date: The date and time the changes were made. 

 

Actions Table: The Actions Table displays the list of possible actions that are 

logged. 

 

0- Modify 4- Sort 

1- Insert 5- Open 

2- Delete 6- Save 

3- Clear 7- Read 

  

File Types Table: The File Types Table displays the list of data file types that are 

displayed in the Actions table when data is saved or opened. 

 

2- Remark (*.RMK) 34- ODBC (*.*) 

3- ASCII [Commas] (*.ASC) 35- Custom (*.ASC,*.TXT) 

4- ASCII [Tabs] (*.ASC) 36- Survey Pro STL 

(*.STL,*.ST3) 

5- CCI Assessment (*.DAT) 37- HTML (*.HTM, *.HTML) 

6- DIF Files (*.DIF) 38- Lotus WK4 (*.WK4, *.WKS) 

8- LXR Test (*.MRG) 36- Survey Pro STL 

(*.STL,*.ST3) 

9- Report (*.RPT) 39- Lotus WK3 (*.WK3) 

10- Spreadsheet [Commas] 

(*.TXT) 

40- Lotus WK1 (*.WK1) 

11- Spreadsheet [Tabs] (*.TXT) 41- XML (*.XML) 

12- SPSS Legacy (*.SAV) 44- Questionmark (*.QSF) 

13- Survey Pro SRV (*.SRV) 45- Database Update 

(*.ACCDB,*.MDB, 

*.XLSX,*.XLS) 

14- Survey System (*.DAT) 46- ODBC Database Update (*.*) 

15- Access 2000 - 2003 

(*.MDB) 

47- Access 2007 - 2010 

(*.ACCDB) 

16- Access 95, 97 (*.MDB) 48- Excel 2007 - 2010 (*.XLSX) 

20- dBase V (*.DBF) 49- Paradox 7 - 8 (*.DB) 

21- dBase IV (*.DBF) 52- SQL Server 

23- Excel 97 - 2003 (*.XLS) 53- Oracle 
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24- Excel 95 (*.XLS) 54- SPSS (*.SAV) 

31- Paradox 5 (*.DB)   

 

Flags Table: The Actions Table displays the list of possible exception flags that are 

logged. 

 

0- None 16- Data Entry 

1- Blank Response 64- Database Verification  

2- Multiple Response 256- Required 

8- Barcode Error   

 

To turn on logging 

1 From the Remark Classic OMR Data Center, 

select the Tools menu, then click Preferences, 

then Change Log. 

2 Mark the checkbox for Enable Change Logging. 

3 Enter a password in the Password box. 

Passwords have a maximum of 255 characters. 

4 Click the Enable button. 

5 Click the OK button to close the Preferences.  

From this point forward, all changes to the data grid are logged. 

 

To turn off logging 

1 From the Remark Classic OMR Data Center, 

select the Tools menu, then click Preferences, 

then Change Log. 

2 Enter the password that was set when turning on 

logging in the Password box. 

3 Click the Disable button. 

4 Click the OK button to close the Preferences.  

From this point forward, all changes to the data grid 

are not logged. If changes have been logged 

previously, the Access database still exists. 

 

To access the change log database 

1 Using Windows Explorer or My Computer, go to  

Windows XP: C:\Documents and Settings\All Users\Application Data\Gravic\Remark 

Classic OMR\4\Change Logs (where C is the drive on which Remark Classic OMR is 

installed). 

Windows Vista/Windows 7: C:\ProgramData\Gravic\Remark Classic OMR\4\change 

log (Note you must have the option to show hidden folders and files on to see this 

location). 
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2 Double click the Access file (when the database was initially created, it used the date 

of creation as the filename). 

3 Enter the password that was used when logging was enabled in the Remark Classic 

OMR Preferences.  

The database opens in Access for your review. It is a fully functioning Access database 

that you may modify. For example, you could write an Access report to provide change 

information by user, by form template, etc.  

Note: If you change the structure of the Access tables from what was 
originally designed, the database may stop functioning with Remark Classic 
OMR. Ensure you do not leave the database open in Access while working in 
Remark Classic OMR or else a database corruption may occur. You are 
responsible for backing up your own databases. Gravic is unable to recover 
corrupt databases. Remark Support cannot troubleshoot Access features or 
issues. 
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Remark Quick Stats – Data Analysis 

Chapter 8 

8.1 Overview 

Remark Quick Stats is an analysis package that ships with the Remark Classic OMR 

software. Remark Quick Stats allows you to tabulate surveys and grade tests right in the 

software. An overview of Remark Quick Stats is provided here; a complete user’s guide 

is installed in PDF format with the software and can be found by clicking 

Start|Programs|Remark Classic OMR 4|Documentation|Remark Quick Stats 

User’s Guide.  

Note: The legacy Remark Quick Stats package that was included in previous 
versions of Remark Classic OMR is no longer available. Most reports should 
have an equivalent report in the new version of Remark Quick Stats. 

Depending on the report selected, Remark Quick Stats can include the following 

statistics: 

Survey statistics and reports include: 

 For each item Remark Quick Stats calculates: Mean, Variance, Standard 

Deviation, Standard Error, Min, Max, Range, Median, Skewness, Kurtosis, T-

Value, Percentiles, Confidence Intervals  

 For each answer choice Remark Quick Stats calculates: Frequencies, Percentages, 

Valid Percent  

 A Response Report displays the responses for any particular question on one 

easy-to-read report (primarily used for open-ended questions) 

 Crosstabs  

 A Group Report displaying means for question groupings  

Test statistics and reports include: 

 A Grade Wizard steps you through the process of setting up an answer key, 

grade scale, questions points, learning objectives, benchmark scores and other 

grading information for your test  

 For each item Remark Quick Stats calculates: Mean, Variance, Standard 

Deviation, Standard Error, Min, Max, Range, Median, Skewness, Kurtosis, T-

Value, Percentiles, Confidence Intervals, P-values, Point Biserial Correlation  

 For each answer choice Remark Quick Stats calculates: Frequencies, Percentages, 

Point Biserial  

 For each student Remark Quick Stats calculates: Total score, Raw score, Grade, 

Dev. IQ, Number correct/incorrect/unanswered  

 For the test Remark Quick Stats calculates: Number of graded tests and items, 

Max, Min, Median, Range, Percentile scores, Mean, Variance, Standard Deviation, 

Confidence Intervals (1,5,95,99%), KR 20, KR21, Coefficient (Cronbach) Alpha  

 A Grade Report displays each student’s results on the test  

 A Group Report displays grades for specific subsets of your data  
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A variety of graph types are also included (all of which can be copied and printed):  

 Pie   

 Bar   

 Horizontal Bar  

 Line  

 Area  

 Point  

 Polar  

 Fast Line  

8.2 Tabulating Surveys with Remark Quick Stats 

Surveys can be tabulated in two ways: Easy Survey and the Survey Wizard. Easy Survey 

uses the parameters specified in the form template’s region properties, such as which 

questions to tabulate, and then launches Remark Quick Stats. The Survey Wizard allows 

you to customize the tabulation process by choosing which regions to include, assigning 

numeric values to answer items, assigning benchmarks, adding question text, specifying 

question groups and more.  

 

To access survey tabulation features 

1 From the Remark Classic OMR Data Center, open a form template and either 

open an existing data file or scan forms.  

2 Select the Tools menu, then select Analysis and then click Easy Survey or Survey 

Wizard. Alternatively, select the Analysis tab in the Task Pane and then choose an 

analysis option. In addition, the analysis options are available on the toolbar: 

 . 

Remark Quick Stats opens, allowing you to configure and display reports. Please consult 

the Remark Quick Stats user’s guide PDF for further details about using Remark Quick 

Stats. 

Tip: The Survey Wizard and Easy Survey screens and functions are 
described in complete detail in the Remark Quick Stats User’s Guide PDF file. 
Access the file by clicking Start|Programs|Remark Classic OMR 
4|Documentation.  

8.3 Grading Tests with Remark Quick Stats 

Tests can be graded in two ways: Easy Grade and the Grade Wizard. Easy Grade uses 

the parameters specified in the form template, such as which questions to grade and 

their point values. In addition, Easy Grade uses the first row of data in the data grid as 

the answer key; therefore, you should insert your answer key before your test data if 

you plan to use Easy Grade (e.g., scan the answer key first). The Grade Wizard allows 

you to customize the grading process by choosing which questions to include, assigning 

point values, setting benchmarks, adding question text, specifying learning objectives. 

adding scaled scores and more.  
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To access test grading features 

1 From the Remark Classic OMR Data Center, open a form template and either 

open an existing data file or scan forms.  

2 Select the Tools menu, then select Analysis and then click Easy Grade or Grade 

Wizard. Alternatively, select the Analysis tab in the Task Pane and then choose an 

analysis option. In addition, the analysis options are available on the toolbar: 

. 

Remark Quick Stats opens, allowing you to configure and display reports. Please consult 

the Remark Quick Stats user’s guide PDF for further details about using Remark Quick 

Stats. 

Tip: The Grade Wizard and Easy Grade screens and functions are described 
in complete detail in the Remark Quick Stats User’s Guide PDF file. Access 
the file by clicking Start|Programs|Remark Classic OMR 
4|Documentation.  
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Remark Classic OMR Data Center 

Preferences  

Chapter 9 

9.1 Overview 

This chapter details how to customize the Remark Classic OMR software by setting up 

preferences. Preferences allow you to set the way the software functions by default, 

which can facilitate your use of the software. 

Important Note: The Preferences are global software settings. When you 
make a change to the Preferences, it affects all actions from that point 
forward. It does not affect anything you have already completed. 

 

To access the Preferences 

1 In the Remark Classic OMR Data Center, select the Tools menu and then click 

Preferences. 

Use the links in the left Task Pane to access all of the available preferences. 

Note: Each component of the software has its own set of preferences. The 
Remark Quick Stats preferences are covered in the Remark Quick Stats 
User’s Guide PDF file, which can be accessed by clicking 
Start|Programs|Remark Classic OMR 4|Documentation.  

The available Data Center preferences are described in the sections that follow.  

9.2 General Preferences 

General preferences allow you to setup defaults for basic software functions. The 

following options are available:  
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Preference Option Description 

Shade alternate rows to look like Mark this checkbox to shade every other template 

grid row. Click the paint bucket to choose a 

shading color.  

Update the Image Viewer During 

Read Operations 

Mark this checkbox to have the Image Viewer 

update with a new form image each time a form 

is processed. The Image Viewer is located 

beneath the data grid window. Using this option 

could alert you to issues such as skewed forms. 

This option only applies when your default 

scanner is an OMR/Image scanner. 

Update the Graph Viewer During 

Read Operations 

Mark this checkbox to have the Graph Viewer 

update with a new graph per question each time a 

form is processed. The Graph Viewer is located 

beneath the data grid window. It provides a quick 

glimpse into your data by graphing the active 

question. 

Review Exceptions: Auto search 

the response combo box when 

typing 

Mark this checkbox so that you can type the first 

letter(s) of a response into the Response box of 

Review Exceptions and the software automatically 

selects the response that begins with those 

characters. This option applies to questions that 

employ list box style cells only (Multiple, List and 

Boolean OMR regions, and Input regions that 

utilize Database Lookup).  

Review Exceptions: Play sound on 

review exceptions startup 

Mark this checkbox to play a sound when Review 

Exceptions first starts. This feature is useful as an 

alert if you are processing forms in an unattended 

manner.  

Review Exceptions: Play sound 

when an exception case is located 

Mark this checkbox to play a sound every time an 

exception case is located in Review Exceptions. 

Click the … button to select a .wav sound file. You 

may also click the button  to preview the 

sound. 

Review Exceptions: Clear 

exceptions after they have been 

reviewed 

Mark this checkbox to remove the color coding for 

an exception after it has been reviewed. This 

setting applies when you review grid cells but do 

not make changes that would automatically 

remove the exception color (e.g., if a question is 

legitimately blank, you might leave it as BLANK 

with the yellow colored cell). By clearing the 

exceptions, Review Exceptions does not stop on 

them the next time it is run. 
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Preference Option Description 

Maximum length for a value in a 

data grid cell 

Enter the maximum number of characters allowed 

in a data grid cell. You are not able to enter more 

characters than allowed (e.g., when entering text 

using an Input region). Note that performance 

may be affected by data grid cells that contain 

very large amounts of text. 

Replace missing data values with Enter the value to be used when missing data are 

encountered during a data file export. Missing 

data means that the piece of data captured does 

not match what was defined as Labels in the form 

template. A MULT, BLANK and ERROR left in the 

data set would all be considered missing. If you 

typed a response in a list cell in the grid but it did 

not match the labels defined, this data would also 

be considered missing (e.g., “A” is defined in the 

form template, but you type “a”). The Missing 

Value is also used when running reports in 

Remark Quick Stats. The default value is -1. 

9.3 File Storage Location Preferences 

File Storage Location preferences allow you to setup the default directories that are used 

to store various file types. If you prefer to store files on a network drive, you can enter 

that location here (ensure that you have permission to fully access that drive).  

Special Note for Image-Enabled Scanners: If you are using an image-
enabled scanner, you are not able to create and edit form templates. You 
must use the templates found in C:\Program Files\Gravic\Remark Classic 
OMR 4\Templates\Scantron\OMR-Image. There are required files that match 
these templates; therefore changing the templates causes them to stop 
working with the software. If you need to move these templates to a 
different folder, move the entire folder structure without altering it or 
renaming any files. 

The following options are available: 
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Preference Option Description 

Form templates Sets the default location in which to store form template 

files. Highlight this selection and then click the Modify 

Directory… button to set a directory. The default 

directory is C:\Program Files\Gravic\Remark Classic 

OMR 4\Templates\Scantron. 

IMPORTANT NOTE: If you are using an OMR/Image 

scanner and need to move the form templates to 

another location, you must copy over the entire 

C:\Program Files\Gravic\Remark Classic OMR 

4\Templates\Scantron\OMR-Image folder and all of its 

contents without changing the structure to that location. 

Data Sets the default location in which to store data files. 

Highlight this selection and then click the Modify 

Directory… button to set a directory. The default 

directory is C:\Program Files\Gravic\Remark Classic 

OMR 4\Data. 

Dictionaries Sets the default location in which to store spell check 

dictionary files. Highlight this selection and then click 

the Modify Directory… button to set a directory. The 

default directory is C:\Windows\System32. 

Image Directory Search List Sets the locations(s) in which images are stored for 

processed forms. This option only applies when your 

default scanner is an OMR/Image scanner. When a cell 

in the data grid is clicked, the stored image file is 

displayed in the Image Viewer. The Image Viewer can 

be used for image-assisted data entry, Review 

Exceptions and in-cell editing. Use the Add Directory… 

button to add any directories in which you plan to store 

image files for processed forms. Remark Classic OMR 

searches for these images in the order in which the 

directories are specified. Use the Move Up or Move 

Down buttons to change the order, and the Remove 

Directory button to remove a directory from the search 

list. Note that you can store images in any directory 

using the Read Wizard. However, providing frequently 

used directories in the Image Directory Search List aids 

the Remark software in finding images to display 

whenever a data file is opened. 

Active Dictionary Sets the active dictionary to be used for Spell Checker. 

Click the down arrow to view any dictionaries that are 

currently installed in your default Dictionaries 

directory. 

 

 



 Remark Classic OMR Data Center Preferences  

 161 

9.4 Custom Font Preferences  

Custom Font preferences allow you to setup the default fonts to use throughout the 

application. Mark the Use Custom Font Settings checkbox to choose a font to use 

throughout the application, allowing you to customize the software’s look. You may 

choose a character set, font and font size. You should choose a font that is supported by 

your operating system. Please note that not all fonts look optimal in the software. You 

should restart the application after making any font changes. 

 

 

 

 

 

 

 

 

 

 

 

 

9.5 Email Preferences 

Email preferences allow you to set your internal SMTP server or Outlook as your default 

email client. This setting directly applies to the email option available from the File menu 

(Section 7.8), which can use either your SMTP server or Microsoft Outlook. When using 

Outlook, Outlook opens with your file(s) as an attachment. When using Default (SMTP), 

an internal email client opens that utilizes your SMTP server.  

The Send Wizard (Section 7.9) uses the SMTP server only. If you set up your SMTP 

server settings in the Preferences, they are available by default when using email with 

the Send Wizard. 

SMTP stands for Simple Mail Transfer Protocol and is the Internet standard for 

transmitting email across networks. It is likely your organization has a running SMTP 

server already set up. You just need to find out general information about the server. 

You will likely need to consult with your network/email administrator to obtain 

information about your SMTP server. Please use the following table as a guide to have 

your administrator provide the proper settings: 
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Option Description 

SMTP Server This is the name, address or IP address of the mail server. 

SMTP port The SMTP port is usually 25 but may vary with your email server. 

Enable a 

secured (SSL) 

connection 

If desired, use a secure connection by marking the checkbox for 

Enable a secured (SSL) connection. SSL encrypts data as it is 

transmitted. Your SMTP server must be configured to use SSL in 

order for this feature to work. 

Use the 

default 

credentials of 

the currently 

logged in user 

If you need to use authentication for your SMTP server, you can 

enter credentials or use those of the user logged in to the computer. 

Mark the Use the default credentials of the currently logged in 

user checkbox to utilize the user’s credentials (e.g., the person 

logged in when sending the emails from Remark Classic OMR). 

Otherwise, continue to the next step to enter specific credentials. 

Username and 

Password 

If authentication is required, and you are not using the credentials of 

the currently logged in user, enter the Username and Password, 

as supplied by your network/email administrator. 

Throttle rate The throttle rate adds a delay while sending emails. The default 

setting is 500ms, meaning that one email is sent every 500 ms (in 

other words, two emails are sent per second). Throttling emails 

keeps the SMTP server from being overloaded when sending large 

numbers of emails. Unless you plan on sending hundreds of emails 

at one time, the default setting of 500 is likely fine. 

 

To choose your default email client, in the Email client drop-down list, choose Default 

to use your SMTP server or Outlook to use Microsoft Outlook 2007/2010. If using your 

SMTP server, click the SMTP Server button and put in the settings as described in the 

previous table for your SMTP server. These settings apply to both the email option from 

the File menu and the Send Wizard. 
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9.6 Change Log 

As changes are made in the Remark Classic OMR Data Center, they can optionally be 

logged, allowing you to see what changes were made and who made them. Logging is 

turned on and off in the Remark Classic OMR Preferences. It can only be turned off if 

you know the password used when turning on the feature. Changes made to the data 

grid (edits, review exceptions, review duplicates, clipboard, open, save, etc.) are logged 

in a password protected Access database in the following location: 

Windows XP: C:\Documents and Settings\All Users\Application Data\Gravic\Remark 

Classic OMR\4\Change Logs (where C is the drive on which Remark Classic OMR is 

installed). 

Windows Vista/Windows 7: C:\ProgramData\Gravic\Remark Classic OMR\4\change log 

(note you must have the option to show hidden folders and files on to see this location). 

When the database is initially created, it uses the date of creation as the filename. From 

that point forward, all changes to all templates/data files are stored in that Access file as 

long as the feature is turned on. Data file types, exception flags and actions are all listed 

with a numeric equivalent in the database. The additional tables in the database explain 

each of the numeric values. Once a database reaches 10MB in size, a new database is 

created the next time Remark Classic OMR is opened. 

Logging changes is covered in greater detail in Section 7.11. 

 

To turn on logging 

1 From the Remark Classic OMR Data 

Center, select the Tools menu, then click 

Preferences, then Change Log. 

2 Mark the checkbox for Enable Change 

Logging. 

3 Enter a password in the Password box.  

4 Click the Enable button. 

5 Click the OK button to close the 

Preferences.  

From this point forward, all changes to the data grid are logged. 

 

To turn off logging 

1 From the Remark Classic OMR Data 

Center, select the Tools menu, then click 

Preferences, then Change Log. 

2 Enter the password that was set when turning 

on logging in the Password box. 

3 Click the Disable button. 

4 Click the OK button to close the 

Preferences.  

From this point forward, all changes to the data grid are not logged. If changes have 

been logged previously, the Access database still exists. 
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9.7 Check for Updates 

Remark Classic OMR has the ability to check automatically for software updates. You can 

check at any time by clicking the Help menu and then choosing Check for Updates. You 

can also have the software check for an update every time it starts up. When this option 

is turned on, every time you start the software, it sends information about your current 

version to the update website and lets you know if there is a newer version of the 

software available. If an update is available, you are prompted to install it. The Check 

for Updates window also has the ability to do an immediate check for updates. 

 

To automatically check for updates 

1 Select the Tools menu, then click 

Preferences, then Check for Updates. 

2 Mark the checkbox for Check for 

updates when starting to turn on the 

automatic check for updates. 

3 [Optional] If you would like to see if an 

update is available immediately, click the 

Check for Updates Now link. 

4 Click the OK button to close the 

Preferences.  

The next time the software is started, it automatically checks for an update. If an update 

is found, and you would like to install it, follow the on-screen prompts. You must have 

an Internet connection to download the update. If no updates are available, you receive 

a message indicating that your software is up to date. 

The Remark Classic OMR Automatic Update collects some system configuration data in 

order to provide you with updates that apply to your installation. This information 

includes: 

 Product Name  System Finger Print 

 Remark Serial Number  Software Version and Build Number 

 Remark Authentication Code  

Gravic, Inc., author of the software, is committed to helping protect your privacy. Using 

the automatic update feature does not collect your name, address, email address, or any 

other form of personally identifiable information. Your Internet Protocol (IP) address is 

logged when you connect to the Gravic website, but this address is only used to 

generate aggregate statistics.  
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Understanding Error Messages 

Appendix A 

A.1 Error Message Details 

This appendix details the different error messages in Remark Classic OMR. Use this 

appendix to gain a better understanding of any problems that may arise while using the 

software. The following table lists error class, error category, error number and the error 

text along with some enhanced instructions where applicable. 

 

Class # Category Error # Error Text 

0100 Memory 

Errors 

100-106 Not enough memory to perform specified operation. 

Close other applications to free up more memory or 

restart Windows. Ensure that your computer meets 

the minimum system requirements. 

0200 Windows 

Errors 

200-206 Windows function errors (internal to Remark Classic 

OMR). Could signify that the Windows environment 

is functioning improperly. Close other software 

applications and restart Windows. 

1000 File Open 

Errors 

1001-

1012 

Remark Classic OMR could not open the specified 

file. The file no longer exists or could not be opened 

for an unknown reason. Possible causes could be: a 

full hard drive, an inaccessible network drive, or the 

file is being used by another application. 

1100 File Read 

Errors 

1101-

1103 

Error reading the specified file. Possibly indicates a 

corrupt file. Possible causes could be: a full hard 

drive, an inaccessible network drive, or the file is 

being used by another application. 

1200 File Write 

Errors 

1201-

1214 

Error occurred while writing file to disk. Possible 

causes could be: a full hard drive, an inaccessible 

network drive, or the file is being used by another 

application. 

1300 File Access 

Errors 

1301-

1310 

Error occurred while attempting to access a file. 

The file may be damaged. Possible causes could be: 

a full hard drive, an inaccessible network drive, or 

the file is being used by another application. 

1400 File Close 

Errors 

1401-

1403 

An error occurred while trying to close a file. Check 

the amount of free disk space. Possible causes 

could be: a full hard drive, an inaccessible network 

drive, or the file is being used by another 

application. 
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Class # Category Error # Error Text 

1500 File 

Creation 

Errors 

1501-

1502 

An error occurred while trying to create a file. 

Check the amount of free disk space. Possible 

causes could be: a full hard drive, an inaccessible 

network drive, or the file is being used by another 

application. 

1700 Miscellan-

eous File 

Errors 

1700-

1703 

A file cannot be accessed due to a bad name or 

path. Check that the file name is valid and that the 

target directory can be accessed from your system. 

  1704 A file has already been opened by Remark Classic 

OMR or by some other application and cannot be 

opened again. Close other applications using this 

file. 

  1705 The disk is full. Delete some files or try saving to 

another location. 

  1706 Too many files are currently open on your system. 

Close some applications and try the operation 

again. 

  1707-

1708 

Permission was denied or the disk was not ready 

when trying to write the file. Also, check the region 

names you are using in the form template for 

invalid characters, such as commas, parentheses, 

etc. 

  3102 

MULT 

Multiple answers were entered for a region in which 

multiple responses were not permitted. 

  3103 

BLANK 

No response was given. 

3200 Barcode 

Errors 

3200 Unable to recognize barcode. Check to ensure it is a 

supported barcode type for your OMR scanner. 

4000 Scanner 

Errors 

4000 The scanner is not ready. Check to make sure it is 

connected correctly and that the power is turned 

on. 

  4001 No scanner is selected. A scanner cannot be used 

until it is selected in the Scanner Properties 

window. 

6000 Output File 

Errors 

6000 Error saving because the template grid contains no 

data. You cannot save an empty grid. 

  6001 Error saving the data because the specified data do 

not correspond to the selected form template file. 

The data may contain misplaced characters, such 

as: commas, periods, semicolons and parentheses. 

Use Find and Replace to remove any invalid 

characters for your database type. 
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Class # Category Error # Error Text 

  6002-

6005 

Error saving the data in the selected file format 

because a cell exceeds the maximum size for 

storage. Edit the text in the grid or save to another 

file format. Some file formats maintain a maximum 

cell size, question number, etc. (See Section 7.6 

Saving Data.) 

  6006 Too many questions to save in dBase (.DBF) 

format. Maximum of 128 questions permitted. Try 

saving the data to another file format. 

  6007 Too much data to save in dBase (.DBF) format. 

Maximum of 4,000 bytes per record. Try saving the 

data to another file format. 

  6008-

6009 

Unable to save to Fixed (.SDF) file format because 

responses are not of a fixed size. Data in each 

column must contain the same number of bytes. 

For example, if the possible answers for a question 

are 

1 - 10, you should set the region up using the 

labels: 01, 02, 03... ...09, 10 so that each answer 

item will contain two bytes. 

6100 File Import 

Errors 

6100-

6104 

Error importing specified file format. Incompatible 

data encountered during the conversion. 

  6105 The data contained in the data file do not 

correspond to your form template file. The data 

were truncated. The data file contains more grid 

columns than the current template grid. Make sure 

you have selected the correct form template and 

data file. 

  6106-

6108 

Error importing SPSS legacy (.SAV) file format. 

Note that SPSS reformats data when saving; 

consequently, data saved as compressed in SPSS 

may not import back into Remark Classic OMR. You 

must uncompress the data within SPSS before 

opening it in Remark Classic OMR. 

  6109-

6110 

Error importing the Fixed (.SDF) format file. 

7000 Database 

Memory 

Errors 

7000 The application doesn't have enough memory or 

resources to complete the selected database 

operation. Close other applications, files and 

windows to free up more memory or restart 

Windows. Ensure that your computer meets the 

minimum system requirements. 

  7001 You have reached the limit on the number of files 

that can be opened at one time. Close one or more 

files, and then try the operation again. 
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  7002 You have reached the limit on the number of tables 

and/or databases that can be opened at one time. 

Close one or more tables and then try the operation 

again. 

  7003 The database has reached its maximum size. To 

add data to this database, you must first reduce its 

size by deleting data. 

    7004 You tried to add new records to a Microsoft Excel 

version 3 or version 4 file, but the file is full. Files of 

these types can hold a maximum of 16,384 

records. 

  7005 You tried to perform a Btrieve operation that 

involves too many Memo or OLE object regions. 

Reduce the number of Memo and OLE object 

regions, and then try the operation again. 

  7006 You tried to perform an operation that involves 

more than 255 regions. Reduce the number of 

regions, and then try the operation again. 

7100 Database 

Syntax 

Errors 

7100 A syntax error occurred. Check the data to make 

sure it was entered correctly. This error can occur if 

an incorrect value type is provided as part of an 

expression. For example, textual data entered into 

a numeric region. 

  7101 Unable to locate specified table, region or index. 

Check the name to make sure it was entered 

correctly and then retry the operation. 

  7102 The specified file, table or region name doesn't 

follow standard naming conventions. Enter a new 

name, and then try the operation again. Consult 

your database's documentation for information on 

valid names and naming limitations. 

7200 Database 

Read 

Errors 

7200 You tried to access a database that is currently in 

use by another user or application. Wait for the 

other user or application to finish working with the 

database, and then try the operation again. 

  7201 An error occurred updating the database. The 

database, file, table or region is defined as read-

only. 

  7202 An error occurred accessing the specified path or 

filename. The path or filename is not valid. Check 

the name and path to make sure they were entered 

correctly then retry the operation. 
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  7203 A permissions error occurred accessing the 

specified database, table or object. You don't have 

the necessary permissions. Contact the database 

administrator regarding access rights. 

  7204 A file, disk or network access error occurred. 

Resolve the error condition and then retry the 

operation. 

  7205 An error occurred attempting to create the 

database, table or object because it already exists. 

This error can also occur if an ODBC database 

contains several tables with the same name. 

  7206 An error occurred attempting to open or access the 

database file. The file is either invalid or corrupt. 

  7207 An error occurred trying to access a necessary 

database file or table. Resolve the error condition 

and then retry the operation. 

  7208 An attempt was made to import or attach to an 

empty text file. To import or attach a text file, the 

file must contain data. 

  7209 You tried to perform an operation that would have 

violated referential integrity rules for related tables. 

  7210 The installable ISAM you are using does not allow 

updates and/or deletes to records in external 

tables. You can add new records, though. 

  7211 You cannot use ODBC to access an external 

Microsoft Access or ISAM database table. Use 

Remark Classic OMR’s direct support of the 

database instead. 

7300 ODBC 

Errors 

7300 Using ODBC, you tried to perform an operation on 

data in a SQL database. This error may occur when 

the SQL database is on a network drive and the 

network is not connected or when the path 

specified is invalid. 

  7301 An error occurred attempting to update the ODBC 

table. Possible causes could be the database is 

read-only, the database is on a network drive and 

the network is not connected or the update would 

have caused a rule violation. 

  7302 The ODBC remote query timeout expired. The 

ODBC server may not be properly installed, or a 

required network connection isn't active. Check the 

network connection or contact your system 

administrator, and then try the operation again. 
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  7303 The ODBC table definition has changed since you 

created the link. End the current operation and then 

retry. 

  7304 An error occurred attempting to lock records in the 

ODBC database. All records in the database cannot 

be locked. 

7400 Database 

Index 

Errors 

7400 An error occurred attempting to create an index for 

the database because the index already exists. 

  7401 An error occurred trying to create an index because 

the index definition is invalid. 

  7402 An error occurred adding a record to the table or 

updating the table because the current record 

contains an invalid value in the region(s) defined as 

the primary key. 

  7403 An error occurred making changes to the table 

because of a duplicate value in a region that is the 

underlying table's primary key or an index that 

doesn't allow duplicates. The changes were 

unsuccessful. 

  7404 The operation you attempted requires a (primary) 

database index. An index was not found. The 

operation was unsuccessful. Create a primary index 

for this database and then retry the operation. 

  7405 An error occurred creating the index. Possible 

causes: the key regions are named improperly, 

there are duplicate records based on this index or 

there were too many indexes already defined. 

  7406 An error occurred deleting the index. The current 

index cannot be deleted. 

7500 Database 

Registry 

Errors 

7500 An error occurred initializing the database engine 

due to invalid initialization or registry settings or an 

engine conflict. 

  7501 Unable to locate current record. Move to or select 

another record, and try the operation again. 

  7502 You tried to use a Paradox table, but the table's 

associated lock (.LCK) file is outdated. Delete the 

.LCK file and then try the operation again. 

  7503 An unexpected error occurred when you tried to 

access data in an attached Btrieve table. Try the 

operation again, or contact your system 

administrator or network administrator. 
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  7504 You tried to perform an operation that requires the 

Btrieve engine. To access Btrieve files, you must 

have purchased and installed a copy of the stand-

alone Btrieve for Windows engine. This file must be 

in your Windows System directory. 

  7505 Cannot perform this operation with an unsupported 

database version. Convert the file you want to use 

to a supported version and/or data type and then 

retry the operation. 

  7506 The operation stopped before its normal 

completion. Some data changes may not have been 

saved. 

  7507 The external database driver returned an error. This 

error can be caused by performing an operation not 

supported on this type of external database. 

  7508 The database you are attempting to use has an 

unspecified problem and, as a result, it is marked 

as corrupt. Check your database’s documentation 

for this error code. 

7600 Database 

Record 

Errors 

7600 The database you are attempting to use has an 

unspecified problem and, as a result, it is marked 

as corrupt. Check your database’s documentation 

for this error code. 

  7601 You defined a table with records larger than can be 

supported. Redefine the table by making some 

regions shorter or by removing unneeded regions. 

  7602 A region error occurred due to a data type conflict 
or an invalid data type. 

  7603 An error occurred saving a region value. The value 

specified is invalid. 

  7604 The specified table doesn't contain the specified 

region(s). Check the spelling of the region name(s) 

in the form template and ensure that they do not 

contain invalid characters (commas, parentheses, 

etc.). 

  7605 None of the import region names matches regions 

in the associated table. At least one region name in 

the import table and one region name in the 

appended table must match. 

  7606 An error occurred creating the table or appending 

the region because more than one region was 

defined with the same name. Each region name in a 

table must be unique. Check the region name(s) 

specified in the form template. 
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  7607 You referred to a record that you deleted or that 

another user in a multi-user environment deleted. 

Move to another record, and then try the operation 

again. 

  7608 You attempted to import an invalid range of 

spreadsheet cells. 

  7609 The first row of data contains invalid region (region) 

names, such as quoted and unquoted strings in the 

same region name. Check the import table for 

properly matched quotation marks, and then try the 

import operation again. 

  7610 An error occurred creating the table or index 

definition because it does not contain any regions. 

  7611 An error occurred attempting to change a table or 

region definition because the object has already 

been appended to the corresponding object. 

  7612 An error occurred attempting to delete a region. 

You can’t delete a region included in an index. To 

delete a region that is part of an index, you must 

first delete the index. 

  7613 Text file specification region separator matches 

decimal separator or text delimiter. Two or more 

delimiters settings used by the Text ISAM are the 

same. 

9000 Miscellan- 

eous 

Program 

Errors 

9000 These miscellaneous errors signify an internal 

problem or undocumented error type. Please report 

any reproducible occurrences of these errors to 

Gravic Technical Support. Send a screenshot of the 

error and the steps you took leading up to the 

error. 

9100 DLL Errors 9100 The DLL file is in use by other applications and 

could not be opened. Close other applications and 

restart Windows. 

  9101 The DLL could not be loaded because it could not be 

located on your system. Make sure all required DLL 

files are in directories where they can be found. 

Uninstall and reinstall the software. 

9200 Clipboard 

Errors 

9200 This error indicates that a problem was encountered 

trying to copy or paste data to or from the 

Clipboard. This error could occur it too much data is 

requested or if an invalid object is being copied to 

the clipboard. 

 


	Remark Classic OMR Overview
	1.1 Overview
	1.2 Optical Mark Reading Basic Concepts
	1.3 What is Included with your Software
	1.4 New Features in this Version
	1.5 Technical Support
	Installing Remark Classic OMR
	2.1 Overview
	2.2 System Requirements
	2.3 Installing the Software
	2.4 Uninstalling the Software
	2.5 Running Remark Classic OMR
	2.6 Registering the Software
	2.7 Updating the Software
	Navigating Remark Classic OMR
	3.1 Overview
	3.2 Remark Classic OMR Components
	3.3 Navigation Tools
	3.4 Using the Mouse and Keyboard
	3.4.1 Using the Mouse
	3.4.2 Using the Keyboard
	3.4.3 Using Keyboard Shortcuts
	3.4.4 Scrolling

	3.5 Menu Items
	3.5.1 File Menu
	3.5.2 Edit Menu
	3.5.3 View Menu
	3.5.4 Tools Menu
	3.5.5 Sheet and Region Menus
	3.5.6 Help Menu

	3.6 Accessing the Software Help File
	Setting Up Your Scanner
	4.1 Overview
	4.2 OMR Scanners- General Information
	4.3 OMR Forms
	4.3.1 Timing Marks
	4.3.2 Columns

	4.4 Selecting Your OMR Scanner
	4.4.1 Selecting an OMR Only Scanner
	4.4.2 Selecting an Image Enabled Scanner

	Using the Template Editor
	5.1 Overview
	5.2 Creating Form Templates
	5.2.1 Using the Template Editor
	5.2.2 Region Types
	5.2.3 Beginning the Form Template
	5.2.4 Creating Regions
	5.2.5 OMR (Optical Mark Recognition) Regions
	5.2.5.a OMR Region Types
	5.2.5.b Region Orientation

	5.2.6 Defining the OMR Region
	5.2.7 Linking OMR Regions
	5.2.8 Creating an Input Region
	5.2.9 Barcode Regions

	5.3 Advanced Region Properties and Features
	5.3.1 Advanced Properties: General: Include Region in Read Operation
	5.3.2 Advanced Properties: General: Required Region
	5.3.3 Advanced Properties: General: Question Text and Region Names
	5.3.3.a Question Text
	5.3.2.b Question Names

	5.3.4 Advanced Properties: Analysis: Test Settings
	5.3.5 Advanced Properties: Analysis: Survey Settings
	5.3.6 Advanced Properties: Analysis: Analysis Respondent ID
	5.3.7 Advanced Properties: Blank Responses
	5.3.8 Advanced Properties: Multiple Responses
	5.3.9 Advanced Properties: Respondent Trackers
	5.3.10 Advanced Properties: Database Lookup

	5.4 Additional Template Editor Features
	5.4.1 Copy/Paste
	5.4.2 Drag/Drop
	5.4.3 Deleting Regions
	5.4.4 Undo/Redo
	5.4.5 File Properties

	5.5 Saving a Form Template
	5.6 Editing an Existing Form Template
	Scanning Forms
	6.1 Overview
	6.2 Scanning Forms with an OMR Scanner
	6.2.1 Opening a Form Template
	6.2.2 The Remark Classic OMR Read Wizard for OMR Scanners
	6.2.3 Scanning Using Default Settings with an OMR Scanner (Easy Scan)
	6.2.4 Scanning Multiple Sheet Forms Without Page ID Marks Using an OMR Scanner
	6.2.5 Scanning Multiple Sheet Forms with Page ID Marks Using an OMR Scanner
	6.2.6 Reading Multiple Sheet Forms with Respondent Trackers Using an OMR Scanner
	6.2.7 Using an OMR Scanner’s Select Stacker
	6.2.8 Using an OMR Scanner’s Printer
	6.2.9 Using Grade and Print with an OMR Scanner

	6.3 Scanning Forms with an OMR/Image Scanner
	6.3.1 Opening a Form Template
	6.3.2 The Remark Classic OMR Read Wizard for OMR/Image Scanners
	6.3.3 Scanning Using Default Settings with an OMR/Image Scanner (Easy Scan)
	6.3.4 Scanning Multiple Sheet Forms Without Page ID Marks Using an OMR/Image Scanner
	6.3.5 Scanning Multiple Sheet Forms with Page ID Marks Using an OMR/Image Scanner
	6.3.6 Scanning Multiple Sheet Forms with Respondent Trackers Using an OMR/Image Scanner
	6.3.7 Using an OMR/Image Scanner’s Select Stacker
	6.3.8 Using an OMR/Image Scanner’s Printer
	6.3.9 Using Grade and Print with an OMR/Image Scanner

	6.4 Batch Processing
	6.5 Overwriting Data Records
	6.6 Image Viewer
	6.7 Reviewing Exceptions
	6.7.1 Reviewing Exceptions by Modifying Individual Cells
	6.7.2 Using Review Exceptions
	6.7.2.a Using the Review Exceptions Window


	6.8 Respondent Detection
	6.9 Reviewing Duplicate Responses
	6.10 Graph Viewer
	6.11 Test Import Wizard
	6.11.1 Creating Tests in ExamView
	6.11.2 Exporting Tests from ExamView
	6.11.3 Importing ExamView Files in Remark Classic OMR
	6.11.4 Scanning Completed Tests
	6.11.5 Grading Tests

	Working with Your Data
	7.1 Overview
	7.2 Understanding the Data Grid
	7.3 Editing the Data Grid
	7.3.1 Making Grid Selections
	7.3.2 Changing Cell Contents
	7.3.3 Cutting, Copying, Pasting and Deleting
	7.3.4 Resizing, Inserting and Deleting Rows
	7.3.5 Freezing Columns and Rows
	7.3.6 Using Find and Replace

	7.4 Sorting Grid Columns
	7.5 Spell Checker
	7.6 Saving Data
	7.6.1 Advanced Saving Options
	7.6.2 Custom Format
	7.6.3 Database Update Format
	7.6.4 Save All Data
	7.6.5 Save Data Builder

	7.7 Printing Data
	7.8 Emailing Data
	7.8.1 Email Overview and Set Up
	7.8.2 Using Email to Send Data Files

	7.9 Send Wizard
	7.10 Opening Data
	7.11 Opening Scantron Score Data Files
	7.12 Data Center Logging
	Remark Quick Stats – Data Analysis
	8.1 Overview
	8.2 Tabulating Surveys with Remark Quick Stats
	8.3 Grading Tests with Remark Quick Stats
	Remark Classic OMR Data Center Preferences
	9.1 Overview
	9.2 General Preferences
	9.3 File Storage Location Preferences
	9.4 Custom Font Preferences
	9.5 Email Preferences
	9.6 Change Log
	9.7 Check for Updates
	Understanding Error Messages
	Appendix A
	A.1 Error Message Details

